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Cisco UCS Integrated Infrastructure for Big
Data with Hortonworks Data Platform

This document describes the architecture and deployment procedures for Hortonworks Data Platform
(HDP 2.2) on a 64 Cisco UCS C240 M4 node cluster along with 4 archival node (Cisco UCS C3160)
based on Cisco UCS Integrated Infrastructure for Big Data. The intended audience of this document
includes, but is not limited to, sales engineers, field consultants, professional services, IT managers,
partner engineering and customers who want to deploy HDP 2.2 on Cisco UCS Integrated Infrastructure
for Big Data.

Introduction

Hadoop has become a strategic data platform embraced by mainstream enterprises as it offers the fastest
path for businesses to unlock value in big data while maximizing existing investments. The Hortonworks
Data Platform (HDP) is a 100% open source distribution of Apache Hadoop that is truly enterprise grade
having been built, tested and hardened with enterprise rigor. The combination of HDP and Cisco UCS
provides industry-leading platform for Hadoop based applications.

Cisco UCS Integrated Infrastructure for Big Data with
Tiered Storage

T
CISCO.

The Cisco UCS solution for Hortonworks is based on Cisco UCS Integrated Infrastructure for Big Data,
a highly scalable architecture designed to meet a variety of scale-out application demands with seamless
data integration and management integration capabilities built using the following components:
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Copyright © 2015 Cisco Systems, Inc. All rights reserved.


http://blogs.cisco.com/datacenter/cpav3

Cisco UCS Integrated Infrastructure for Big Data with Tiered Storage W

Cisco UCS 6200 Series Fabric Interconnects

Cisco UCS 6200 Series Fabric Interconnects provide high-bandwidth, low-latency connectivity for
servers, with integrated, unified management provided for all connected devices by Cisco UCS Manager.
Deployed in redundant pairs, Cisco fabric interconnects offer the full active-active redundancy,
performance, and exceptional scalability needed to support the large number of nodes that are typical in
clusters serving big data applications. Cisco UCS Manager enables rapid and consistent server
configuration using service profiles, automating ongoing system maintenance activities such as
firmware updates across the entire cluster as a single operation. Cisco UCS Manager also offers
advanced monitoring with options to raise alarms and send notifications about the health of the entire
cluster.

Figure 1 Cisco UCS 6296UP 96-Port Fabric Interconnect

Cisco UCS C-Series Rack Mount Servers

Cisco UCS C-Series Rack Mount C220 M4 High-Density Rack servers (Small Form Factor Disk Drive
Model) and Cisco UCS C240 M4 High-Density Rack servers (Small Form Factor Disk Drive Model) are
enterprise-class systems that support a wide range of computing, 1/0, and storage-capacity demands in
compact designs. Cisco UCS C-Series Rack-Mount Servers are based on Intel Xeon E5-2600 v3 product
family and 12-Gbps SAS throughput, delivering significant performance and efficiency gains over the
previous generation of servers. The servers use dual Intel Xeon processor E5-2600 v3 series CPUs and
support up to 768 GB of main memory (128 or 256 GB is typical for big data applications) and a range
of disk drive and SSD options. 24 Small Form Factor (SFF) disk drives are supported in
performance-optimized option and 12 Large Form Factor (LFF) disk drives are supported in
capacity-optimized option, along with 4 Gigabit Ethernet LAN-on-motherboard (LOM) ports. Cisco
UCS virtual interface cards 1227 (VICs) designed for the M4 generation of Cisco UCS C-Series Rack
Servers are optimized for high-bandwidth and low-latency cluster connectivity, with support for up to
256 virtual devices that are configured on demand through Cisco UCS Manager.

Cisco UCS Integrated Infrastructure for Big Data with Hortonworks Data Platform g
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Figure 2 Cisco UCS C240 M4 Rack Server

Cisco UCS C3160 Rack Server

Cisco UCS C3160 Rack Server is an advanced, modular rack server with extremely high storage density.
Based on the Intel Xeon processor E5-2600 v2 series, it offers up to 360 TB of local storage in a compact
4-rack-unit (4RU) form factor. Because all its hard-disk drives are individually hot-swappable, and with
its built-in enterprise-class Redundant Array of Independent Disks (RAID) redundancy, the Cisco UCS
C3160 helps you achieve the highest levels of data availability. The Cisco UCS C3160 is ideal for
Snapshots, active archiving, compliance, media storage, and distributed file systems for scenarios in
which high storage capacity is important. Cisco UCS virtual interface cards 1227 (VICs) designed for
the M4 generation of Cisco UCS C-Series Rack Servers and C3160 are optimized for high-bandwidth
and low-latency cluster connectivity, with support for up to 256 virtual devices that are configured on
demand through Cisco UCS Manager.

r Cisco UCS Integrated Infrastructure for Big Data with Hortonworks Data Platform
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Figure 3 Cisco UCS C3160 Server

e

Cisco UCS Virtual Interface Cards (VICs)

Cisco UCS Virtual Interface Cards (VICs), unique to Cisco, Cisco UCS Virtual Interface Cards
incorporate next-generation converged network adapter (CNA) technology from Cisco, and offer dual
10-Gbps ports designed for use with Cisco UCS C-Series Rack-Mount Servers. Optimized for
virtualized networking, these cards deliver high performance and bandwidth utilization and support up
to 256 virtual devices. The Cisco UCS Virtual Interface Card (VIC) 1227 is a dual-port, Enhanced Small
Form-Factor Pluggable (SFP+), 10 GigabitEthernet Ethernet and Fiber Channel over Ethernet
(FCoE)-capable, PCI Express (PCle) modular LAN on motherboard (mLOM) adapter. It is designed
exclusively for the M4 generation of Cisco UCS C-Series Rack Servers and the C3160 dense storage
servers.

Cisco UCS Integrated Infrastructure for Big Data with Hortonworks Data Platform g
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Figure 4 Cisco UCS VIC 1227

Cisco UCS Manager

Cisco UCS Manager resides within the Cisco UCS 6200 Series Fabric Interconnects. It makes the system
self-aware and self-integrating, managing all of the system components as a single logical entity. Cisco
UCS Manager can be accessed through an intuitive graphical user interface (GUI), a command-line
interface (CLI), or an XML application-programming interface (API). Cisco UCS Manager uses service
profiles to define the personality, configuration, and connectivity of all resources within Cisco UCS,
radically simplifying provisioning of resources so that the process takes minutes instead of days. This
simplification allows IT departments to shift their focus from constant maintenance to strategic business
initiatives.

r Cisco UCS Integrated Infrastructure for Big Data with Hortonworks Data Platform
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Cisco UCS Director Express for Big Data

Cisco UCS Director Express for Big Data provides a single-touch solution that automates deployment
of Hadoop Distributions on leading Cisco UCS Integrated Infrastructure for Big Data.

It also provides a single management pane across both physical infrastructure and Hadoop software. All
elements of the infrastructure are handled automatically with little need for user input. Through this
approach, configuration of physical computing, internal storage, and networking infrastructure is
integrated with the deployment of operating systems, Java packages, and Hadoop along with the
provisioning of Hadoop services. Cisco UCS Director Express for Big Data is integrated with major
Hadoop distributions from Hortonworks, Cloudera, and MapR, providing single-pane management
across the entire infrastructure.

It complements and communicates with Hadoop managers, providing a system wide perspective and
enabling administrators to correlate Hadoop activity with network and computing activity on individual
Hadoop nodes.

Cisco UCS Integrated Infrastructure for Big Data with Hortonworks Data Platform
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The appendix section describes on how to go about configuring Cisco UCS Director Express for Big
Data and deploying popular Hadoop distributions such as Cloudera, MapR and Hortonworks on the
Cisco UCS Integrated Infrastructure for Big Data cluster.

Figure 6 Cisco USCD Express for Big Data
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Hortonworks Data Platform (HDP 2.2)

The Hortonworks Data Platform 2.2 (HDP 2.2) is an enterprise-grade, hardened Apache Hadoop
distribution that enables you to store, process, and manage large data sets.

Apache Hadoop is an open-source software framework that allows for the distributed processing of large

data sets across clusters of computers using simple programming models. It is designed for
high-availability and fault-tolerance, and can scale from a single server up to thousands of machines.

The Hortonworks Data Platform combines the most useful and stable versions of Apache Hadoop and

its related projects into a single tested and certified package. Hortonworks offers the latest innovations
from the open source community, along with the testing and quality you expect from enterprise-quality

software.

r Cisco UCS Integrated Infrastructure for Big Data with Hortonworks Data Platform
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The Hortonworks Data Platform is designed to integrate with and extend the capabilities of existing
investments in data applications, tools, and processes. With Hortonworks, one can refine, analyze, and
gain business insights from both structured and unstructured data — quickly, easily, and economically.

Key Features of HDP 2.2

Hortonworks Data Platform enables Enterprise Hadoop: the full suite of essential Hadoop capabilities
that are required by the enterprise and that serve as the functional definition of any data platform
technology. This comprehensive set of capabilities is aligned to the following functional areas: Data
Management, Data Access, Data Governance and Integration, Security, and Operations.

Figure 7 Hortonworks Data Platform
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HDP 2.2 incorporates many new innovations that have happened in Hadoop and its supporting
ecosystem of projects. Some of the key projects are listed below.

Tiered Storage in HDFS

With HDP 2.2, HDFS provides the ability to utilize heterogeneous storage media within the HDFS
cluster to enable the following tiered storage scenarios:

* Hot Data Tier: Provides a storage tier that consists of C240M4 servers to store datasets that require
high speed storage access.

* Archival Data Tier: Provides storage dense tier that consists of C3160 server to store less
frequently accessed datasets.

This is explained in detail in post HDP installation section.

Enterprise SQL at Scale in Hadoop
While YARN has allowed new engines to emerge for Hadoop, one of the popular integration point with
Hadoop continues to be SQL and Apache Hive is still the defacto standard.
New capabilities in HDP 2.2 include:

« Updated SQL Semantics for Hive Transactions for Update and Delete: ACID transactions
provide atomicity, consistency, isolation, and durability. This helps with streaming and baseline
update scenarios for Hive such as modifying dimension tables or other fact tables.

Cisco UCS Integrated Infrastructure for Big Data with Hortonworks Data Platform g
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Apache Tez

Hive with Tez

+ Improved Performance of Hive with a Cost Based Optimizer: The cost based optimizer for Hive,
uses statistics to generate several execution plans and then chooses the most efficient path as it
relates system resources required to complete the operation. This presents a major performance
increase for Hive.

Apache Tez is an extensible framework for building high performance batch and interactive data
processing applications, coordinated by YARN in Apache Hadoop. Tez improves the MapReduce
paradigm by dramatically improving its speed, while maintaining MapReduce’s ability to scale to
petabytes of data. Important Hadoop ecosystem projects like Apache Hive and Apache Pig use Apache
Tez, as do a growing number of third party data access applications developed for the broader Hadoop
ecosystem.

As the defacto standard for SQL-In-Hadoop, Apache Hive is optimal for both batch and interactive
queries at petabyte scale. Hive embeds Tez so that it can translate complex SQL statements into highly
optimized, purpose-built data processing graphs that strike the right balance between performance,
throughput, and scalability. Apache Tez innovations drove many of the Hive performance improvements
delivered by the Stinger Initiative, a broad community effort that included contributions from 145
engineers across 44 different organizations. Tez helps make Hive interactive.

Kafka for Processing the Internet of Things

Apache Flume

Apache Sqoop

Apache Kafka has quickly become the standard for high-scale, fault-tolerant, publish-subscribe
messaging system for Hadoop. It is often used with Storm and Spark so as to stream events in to Hadoop
in real time and its application within the “Internet of things” uses cases is tremendous.

Flume is a distributed, reliable, and available service for efficiently collecting, aggregating, and moving
large amounts of streaming data into the Hadoop Distributed File System (HDFS). It has a simple and
flexible architecture based on streaming data flows, and is robust and fault tolerant with tunable
reliability mechanisms for failover and recovery.

Sqoop is a tool designed for efficiently transferring bulk data between Apache Hadoop and structured
data stores such as relational databases. Sqoop imports data from external structured data stores into
HDFS or related systems like Hive and HBase. Sqoop can also be used to extract data from Hadoop and
export it to external structured data stores such as relational databases and enterprise data warehouses.
Sqoop works with relational databases such as Teradata, Netezza, Oracle, MySQL, Postgres, and
HSQLDB.

r Cisco UCS Integrated Infrastructure for Big Data with Hortonworks Data Platform
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Apache Knox

Solution Overview I

Knox provides perimeter security so that the enterprise can confidently extend Hadoop access to more
of those new users while also maintaining compliance with enterprise security policies. Knox also
simplifies Hadoop security for users who access the cluster data and execute jobs. It integrates with
prevalent identity management and SSO systems and allows identities from those enterprise systems to
be used for seamless, secure access to Hadoop clusters.

The Hortonworks Data Platform is the foundation for the next-generation enterprise data architecture —
one that addresses both the volume and complexity of today’s data.

Solution Overview

This CVD describes architecture and deployment procedures for Hortonworks Data Platform (HDP 2.2)
on a 64 Cisco UCS C240 M4 node cluster along with 4 archival node (Cisco UCS C3160) based on Cisco
UCS Integrated Infrastructure for Big Data. This solution describes in detail the configuration of HDP
2.2 on Cisco UCS Integrated Infrastructure along with Archival nodes (UCS C3160) and defining
storage policies for data placement.

The current version of the Cisco UCS Integrated Infrastructure for Big Data offers the following
configuration depending on the compute and storage requirements:

Table 1 Cisco UCS Integrated Infrastructure for Big Data Configuration Details

Performance Optimized

16 Cisco UCS C240 M4 Rack
Servers (SFF), each with:

Capacity Optimized

16 Cisco UCS C240 M4 Rack
Servers (LFF), each with:

Extreme Capacity

2 Cisco UCS C3160 Rack Servers,
each with:

2 Intel Xeon processors
E5-2680 v3 CPUs

256 GB of memory

Cisco 12-Gbps SAS
Modular Raid Controller
with 2-GB flash-based
write cache (FBWC)

24 1.2-TB 10K SFF SAS
drives (460 TB total)

2 120-GB 6-Gbps
2.5-inch Enterprise Value
SATA SSDs for Boot

Cisco UCS VIC 1227
(with 2 10 GE SFP+
ports)

2 Intel Xeon processors
E5-2620 v3 CPU

128 GB of memory

Cisco 12-Gbps SAS
Modular Raid Controller
with 2-GB FBWC

12 4-TB 7.2K LFF SAS
drives (768 TB total)

2 120-GB 6-Gbps
2.5-inch Enterprise
Value SATA SSDs for
Boot

Cisco UCS VIC 1227
(with 2 10 GE SFP+
ports)

2 Intel Xeon processors E5-2695
v2 CPUs

256 GB of memory

Cisco 12-Gbps SAS Modular
Raid Controller with 4-GB
FBWC

604 TB (or 6TB) 7.2K LFF SAS
drives (480 TB or 720 TB total)

2 120-GB 6-Gbps 2.5-inch
Enterprise Value SATA SSDs for
Boot

2 Cisco UCS VIC 1227 (each
with 2 10 GE SFP+ ports)

2 built-in 10 GE LOM ports

N

Note

This CVD describes the install process of HDP 2.2 for a 64 node (2 Master node + 62 Data node) of

Performance Optimized Cluster configuration along with 4 Archival Nodes using Cisco UCS C3160
Servers.

Cisco UCS Integrated Infrastructure for Big Data with Hortonworks Data Platform g
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The Performance cluster configuration consists of the following:
e Two Cisco UCS 6296UP Fabric Interconnects
e 64 UCS C240 M4 Rack-Mount servers (16 per rack)
e 4 UCS C3160 Rack Server (1 per rack)
e Four Cisco R42610 standard racks
« FEight vertical power distribution units (PDUs) (Country Specific)

Rack and PDU Configuration

Each rack consists of two vertical PDUs. The master rack consists of two Cisco UCS 6296UP Fabric
Interconnects, sixteen Cisco UCS C240 M4 Servers and one Cisco UCS C3160 connected to each of the
vertical PDUs for redundancy; thereby, ensuring availability during power source failure. The expansion
racks consists of sixteen Cisco UCS C240 M4 Servers and one Cisco UCS C3160 connected to each of
the vertical PDUs for redundancy; thereby, ensuring availability during power source failure, similar to
the master rack.

Note  Please contact your Cisco representative for country specific information.

Table 2 and Table 3 describe the rack configurations of rack 1 (master rack) and racks 2-4 (expansion

racks).

Table 2 Rack 1 (Master Rack)

Cisco 42URack Master Rack

42 Cisco UCS FI 6296UP
41

40 Cisco UCS FI 6296UP
39

38 Unused

37 Unused

36 Cisco UCS C240 M4
35

34 Cisco UCS C240 M4
33

32 Cisco UCS C240 M4
31

30 Cisco UCS C240 M4
29

28 Cisco UCS C240 M4
27

r Cisco UCS Integrated Infrastructure for Big Data with Hortonworks Data Platform
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Table 2 Rack 1 (Master Rack)

Cisco 42URack Master Rack

26 Cisco UCS C240 M4
25

24 Cisco UCS C240 M4
23

22 Cisco UCS C240 M4
21

20 Cisco UCS C240 M4
19

18 Cisco UCS C240 M4
17

16 Cisco UCS C240 M4
15

14 Cisco UCS C240 M4
13

12 Cisco UCS C240 M4
11

10 Cisco UCS C240 M4
9

8 Cisco UCS C240 M4
7

6 Cisco UCS C240 M4
5

4 Cisco UCS C3160

3

2

1

Table 3 Rack 2-4 (Expansion Racks)

Cisco 42URack Expansion Rack

42 Unused

41 Unused

40 Unused

39 Unused

38 Unused

37 Unused

Cisco UCS Integrated Infrastructure for Big Data with Hortonworks Data Platform g
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Table 3 Rack 2-4 (Expansion Racks)

Cisco 42URack Expansion Rack

36 Cisco UCS C240 M4
35

34 Cisco UCS C240 M4
33

32 Cisco UCS C240 M4
31

30 Cisco UCS C240 M4
29

28 Cisco UCS C240 M4
27

26 Cisco UCS C240 M4
25

24 Cisco UCS C240 M4
23

22 Cisco UCS C240 M4
21

20 Cisco UCS C240 M4
19

18 Cisco UCS C240 M4
17

16 Cisco UCS C240 M4
15

14 Cisco UCS C240 M4
13

12 Cisco UCS C240 M4
11

10 Cisco UCS C240 M4
9

8 Cisco UCS C240 M4
7

6 Cisco UCS C240 M4
5

4 Cisco UCS C3160

3

2

1

r Cisco UCS Integrated Infrastructure for Big Data with Hortonworks Data Platform
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Port Configuration on Fabric Interconnects

Table 4 Port Types and Port Numbers
IPort Type IPort Number
Network 1
IAppliance 2 to 5
Server 6 to 69

Server Configuration and Cabling for C240M4

The C240 M4 rack server is equipped with Intel Xeon E5-2680 v3 processors, 256 GB of memory, Cisco
UCS Virtual Interface Card 1227, Cisco 12-Gbps SAS Modular Raid Controller with 2-GB FBWC, 24
1.2-TB 10K SFF SAS drives, 2 120-GB SATA SSD for Boot.

Figure 8, illustrates the port connectivity between the Fabric Interconnect and Cisco UCS C240 M4
server. Sixteen Cisco UCS C240 M4 servers are used in Master rack configurations.

Cisco UCS Integrated Infrastructure for Big Data with Hortonworks Data Platform g
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Figure 8 Fabric Topology for C240 M4
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Server Configuration and Cabling for C3160

The C3160 rack server is equipped with Intel Xeon E5-2695 v2 processors, 256 GB of memory, 2 Cisco
UCS Virtual Interface Card 1227, Cisco 12-Gbps SAS Modular Raid Controller with 4-GB FBWC, 60
4-TB 7.2K LFF SAS drives, 2 120-GB SATA SSD for Boot.

Figure 9, illustrates the port connectivity between the Fabric Interconnect and Cisco UCS C3160 server
as an Appliance port. One Cisco UCS C3160 server is used in master rack configurations.

r Cisco UCS Integrated Infrastructure for Big Data with Hortonworks Data Platform



Server Configuration and Cabling for C3160 ||

Figure 9 Fabric Topology for C3160
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For more information on physical connectivity and single-wire management, see:
http://www.cisco.com/en/US/docs/unified_computing/ucs/c-series_integration/ucsm2.1/b_UCSM2
-1_C-Integration_chapter_010.html

For more information on physical connectivity illustrations and cluster setup, see:

http://www.cisco.com/en/US/docs/unified_computing/ucs/c-series_integration/ucsm2.1/b_UCSM2
-1_C-Integration_chapter 010.html#reference  FE5B914256CB4C47B30287D2F9CE3597

Figure 10 depicts a 64-node cluster along with 4 archival nodes. Every rack has 16 Cisco UCS C240 M4
servers along with 1 Cisco UCS C3160 as an archival server. Each link in the figure represents 16 x 10
Gigabit Ethernet link from each of the 16 servers connecting to a Cisco UCS Fabric Interconnect as a
Direct Connect along with the Cisco UCS C3160 connected as an Appliance port to the Fabric
Interconnect. Every server is connected to both the Cisco UCS Fabric Interconnects shown with dual
link.
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Figure 10 68 Nodes Cluster Configuration

2 x Cisco UC5 6296
Fabric Interconnect

16 x Cisco UCS
C240 M4 Server

17 x 10 Gigabit Links

Cisco UCS
C3160 Server

Software Distributions and Versions

The software distributions required versions are listed below.

Hortonworks Data Platform (HDP 2.2)

The Hortonworks Data Platform supported is HDP 2.0. For more information visit
http://www.hortonworks.com

Red Hat Enterprise Linux (RHEL)

The operating system supported is Red Hat Enterprise Linux 6.5. For more information visit
http://www.redhat.com

Software Versions

The software versions tested and validated in this document are shown in table 5.
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Table 5 Software Versions
Layer Component Version or Release
Compute Cisco UCS C240-M4 C240M4.2.0.3d
Cisco UCS C3160 C3160M3.2.0.2.*
Network Cisco UCS 6296UP UCS 2.2(3d)A
Cisco UCS VIC1227 Firmware |4.0(1d)
Cisco UCS VIC1227 Driver 2.1.1.66
Storage LSI SAS 3108 24.5.0-0020
Software Red Hat Enterprise Linux 6.5 (x86_64)
Server
Cisco UCS Manager 2.2(3d)
HDP 2.2
~
Note e The latest drivers can be downloaded from the link below:

https://software.cisco.com/download/release.html?mdfid=283862063 &flowid=25886 &softwareid=283
853 158&release=1.5.7d&relind=AVAILABLE&rellifecycle=&reltype=latest

The latest supported RAID controller driver is already included with the RHEL 6.5 operating

system.

Fabric Configuration

This section provides details for configuring a fully redundant, highly available Cisco UCS 6296 fabric
configuration.

1.

® N A AW

Initial setup of the Fabric Interconnect A and B.

Connect to UCS Manager using virtual IP address of using the web browser.

Launch UCS Manager.

Enable server, uplink and appliance ports.

Start discovery process.

Create pools and polices for Service profile template.

Create Service Profile template and 64 Service profiles.

Associate Service Profiles to servers.

Performing Initial Setup of Cisco UCS 6296 Fabric Interconnects

This section describes the steps to perform initial setup of the Cisco UCS 6296 Fabric Interconnects A and B.

Configure Fabric Interconnect A

1.

Connect to the console port on the first Cisco UCS 6296 Fabric Interconnect.
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20.

At the prompt to enter the configuration method, enter console to continue.

If asked to either perform a new setup or restore from backup, enter setup to continue.
Enter y to continue to set up a new Fabric Interconnect.

Enter y to enforce strong passwords.

Enter the password for the admin user.

Enter the same password again to confirm the password for the admin user.

When asked if this fabric interconnect is part of a cluster, answer y to continue.

Enter A for the switch fabric.

Enter the cluster name for the system name.

. Enter the Mgmt0 IPv4 address.

Enter the Mgmt0 IPv4 netmask.

. Enter the IPv4 address of the default gateway.
. Enter the cluster IPv4 address.

To configure DNS, answer y.

Enter the DNS IPv4 address.

. Answer y to set up the default domain name.

Enter the default domain name.

. Review the settings that were printed to the console, and if they are correct, answer yes to save the

configuration.

Wait for the login prompt to make sure the configuration has been saved.

Configure Fabric Interconnect B

1.
2.

w

N e

Connect to the console port on the second Cisco UCS 6296 Fabric Interconnect.
When prompted to enter the configuration method, enter console to continue.

The installer detects the presence of the partner Fabric Interconnect and adds this fabric interconnect
to the cluster. Enter y to continue the installation.

Enter the admin password that was configured for the first Fabric Interconnect.
Enter the Mgmt0 IPv4 address.
Answer yes to save the configuration.

Wait for the login prompt to confirm that the configuration has been saved.

For more information on configuring Cisco UCS 6200 Series Fabric Interconnect, see:

http://www.cisco.com/en/US/docs/unified computing/ucs/sw/gui/config/guide/2.0/b UCSM_GUI_Configu
ration_Guide 2 0 chapter 0100.html

Logging Into Cisco UCS Manager

Follow these steps to login to Cisco UCS Manager.

1.

Eal o

Open a web browser and navigate to the Cisco UCS 6296 Fabric Interconnect cluster address.
Click the Launch link to download the Cisco UCS Manager software.
If prompted to accept security certificates, accept as necessary.

When prompted, enter admin for the user-name and enter the administrative password.
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5. Click Login to log in to the Cisco UCS Manager.

Upgrading Cisco UCS Manager Software to Version 2.2(3d)

This document assumes the use of UCS 2.2(3d). Refer to Upgrading between Cisco UCS 2.0 Releases
to upgrade the Cisco UCS Manager software and UCS 6296 Fabric Interconnect software to version
2.2(3d). Also, make sure the UCS C-Series version 2.2(3d) software bundles is installed on the Fabric
Interconnects.

Adding Block of IP Addresses for KVM Access

These steps provide details for creating a block of KVM IP addresses for server access in the Cisco UCS
environment.

1. Select the LAN tab at the top of the left window.
2. Select Pools > IP Pools > IP Pool ext-mgmt.

3. Right-click IP Pool ext-mgmt

4. Select Create Block of IPv4 Addresses.

Figure 11 Adding Block of IPv4 Addresses for KVM Access Part 1
_Equipmenbl:seman AN | S f |Admm| E5855, |§Pm@?§3|5§‘ﬂ?|
W = |
== [V

[+ LN Cloud
- Appliances
=l Internal Lan
- S Policies

Show Navigator
Create Block of IPv4 Addresses

; g 1F Foo
(158 MAC Pools

g T;;ﬁ:'ﬁ;ﬁ;g;?ﬁg?;g?;; I Create Block of [Pvb Addresses I <:'
[ Metflow Monitaring Copy Ctrl+C
Copy XML Ctrl+L
Delete Ctri+D

5. Enter the starting IP address of the block and number of IPs needed, as well as the subnet and
gateway information.
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Figure 12 Adding Block of IPv4 Addresses for KVM Access Part 2

Create a Block of IPv4 Addresses

6. Click OK to create the IP block.
7. Click OK in the message box.

Figure 13 Adding Block of IPv4 Addresses for KVM Access Part 3

A Create Block of IPv4 Addresses

Create a Block of IPv4 Addresses

(1]

255.255.255.0 10.29.160.1
L]

0.0.0.0 0.0.0.0

Enabling Uplink Port

These steps provide details for enabling uplinks ports.

1. Select the Equipment tab on the top left of the window.

2. Seclect Equipment > Fabric Interconnects > Fabric Interconnect A (primary) > Fixed Module.
3. Expand the Unconfigured Ethernet Ports section.
4

Select port 1, that is connected to the uplink switch, right-click, then select Reconfigure >
Configure as Uplink Port.

o

Select Show Interface and select 10GB for Uplink Connection.
6. A pop-up window appears to confirm your selection. Click Yes, then click OK to continue.

7. Select Equipment > Fabric Interconnects > Fabric Interconnect B (subordinate) > Fixed
Module.

8. Expand the Unconfigured Ethernet Ports section.
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9. Select port 1, that is connected to the uplink switch, right-click, then select Reconfigure >
Configure as Uplink Port.

10. Select Show Interface and select 10GB for Uplink Connection.

11. A pop-up window appears to confirm your selection. Click Yes, then click OK to continue.

Figure 14 Enabling Uplink Ports
Fabric Interconnects sdmin State: Disabled D1 SlotIn: 1
Fabric Interconnect A {orimary) Lser Label:
Fixed Module Actions MAC: S4:7FEE:1C:03:A8
i Mode: Access
Eoo Port Type: Physical Riole: Unconfigured
wfll :
-ﬂi Transceiver
Reconfinra )
il Configure as Uplink Port gt
=i ) i 20537831
B Conffgure as FCoE Uplink Port e
o - Configure as Server Port DIB1BALLE
= Configure as FCoE Storage Port
.l Port 12 Configure as Appliance Port
Configuring VL ANs
VLANSs are configured as in shown in table 6.
Table 6 VLAN Configurations
VLAN Fabric |NIC Port |Function Failover
default(VLAN1) [A eth0 Management, User connectivity Fabric Failover to B
vlanll DATA1 B ethl Hadoop Fabric Failover to A
vlan12 DATA2 A eth2 Hadoop with multiple NICs support |Fabric Failover to B

Note

All of the VLANS created need to be trunked to the upstream distribution switch connecting the fabric
interconnects. For this deployment default VLANI1 is configured for management access (Installing and
configuring OS, clustershell commands, setup NTP, user connectivity, etc) and vlanl1 DATAT is
configured for Hadoop Data traffic.

With some Hadoop distributions supporting multiple NICs, where Hadoop uses multiple IP subnets for
its data traffic, vlan12_DATAZ2 can be configured to carry Hadoop Data traffic allowing use of both the
Fabrics (10 GigE on each Fabric allowing 20Gbps active-active connectivity).

Further, if there are other distributed applications co-existing in the same Hadoop cluster, then these
applications could use vlan12 DATA?2 providing full 10GigE connectivity to this application on a
different fabric without affecting Hadoop Data traffic (here Hadoop is not enabled for multi-NIC).

« All applications talking to Hadoop should be able to reach Hadoop VLAN. That is, all applications
should be able to access all the Hadoop nodes.

*  We are using default VLAN1 for management traffic.
Follow these steps to configure the VLANSs in the Cisco UCS Manager GUI:
1. Select the LAN tab in the left pane in the UCS Manager GUI.
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2. Select LAN > VLAN:S.
3. Right-click the VLANSs under the root organization.
4. Select Create VLANSs to create the VLAN.

Figure 15 Creating VLAN
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Enter vlanl1 DATAT1 for the VLAN Name.

Click the Common/Global radio button for the vlanl1 DATAI.
Enter 11 on VLAN IDs of the Create VLAN IDs.

Click OK and then, click Finish.

e ® 2 W

Click OK in the success message box.
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Figure 16 Creating VLAN for Data

10. Select the LAN tab in the left pane again

11. Select LAN > VLAN:S.

12. Right-click the VLANs under the root organization.

13. Select Create VLANS to create the VLAN.

14. Enter vlan12 DATA?2 for the VLAN Name.

15. Click the Common/Global radio button for the vlan12_DATA?2.
16. Enter 12 on VLAN IDs of the Create VLAN IDs.

17. Click OK and then, click Finish.
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Creating VLAN for Hadoop Data
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18. The below screenshot shows the created VLANS.
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Create VLAN for Appliance Port

There steps provide details for creating VLAN for Appliance port configuration.
Select the LAN tab in the left pane in the UCS Manager GUI.
Select LAN > Appliances > VLANSs.
Right-click VLANs under the root organization.

Enter vlanl1_Appliance for the VLAN Name.
Click the Common/Global radio button.

1.
2
3
4. Select Create VLANS to create the VLAN.
5
6.
7. Enter 11 for VLAN ID.

Figure 19 Creating VLAN for Appliance Port 1
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Figure 20 Creating VLAN for Appliance Port 2
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Configuring Appliance Port

These steps provide details for configuring Appliance ports.

1.

El o

Figure 21

Select the Equipment tab on the top left of the window.

Select Equipment > Fabric Interconnects > Fabric Interconnect A (primary) > Fixed Module.

Expand the Unconfigured Ethernet Ports section.

Select port 2, right-click the port, and select Reconfigure > Configure as an Appliance Port.

Configure as Appliance Port 1

Fabric Interconnects

Fabric Interconnect & (primary’

Actions
=Tl
il

8

-ﬂ] Recar

=18

= [l
|

m

Admin State; Disabled

I 2
User Label;

MAC: 54:7F:EE:1C:03:A9

Mode: Unknown
Part Type: Physical

Transceiver

Configure as Uplink Port
Configure as FCoE Uplink Port
Configure as Server Port
Configure as FCoE Storage Port
Configure as Appliance Port

B CUIM
33783-1
-TYCO
T35A06Y

Slot 10 1

Role: Unconfigured

A confirmation message box appears. Click Yes, then OK to continue.

Select Platinum for the Priority.

Keep the Pin Group as <not set>.

Keep the Network Control Policy as Default.

Keep the Flow Control Policy as Default.
Click the 10Gbps radio button for the Admin Speed.
Click the Trunk radio button for the Port Mode.

Select Default VLAN, and click the Native VLAN radio button.
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Figure 22 Configure as Appliance Port 2
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13. Select the Equipment tab on the top left of the window.

14. Select Equipment > Fabric Interconnects > Fabric Interconnect B (Subordinate) > Fixed
Module.

15. Expand the Unconfigured Ethernet Ports section.
16. Select port 2, right-click the port, and select Reconfigure > Configure as an Appliance Port.

Figure 23 Configure as Appliance Port 3
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17. A confirmation message box appears. Click Yes, then OK to continue.
18. Select Platinum for the Priority.

19. Keep the Pin Group as <not set>.

20. Keep the Network Control Policy as Default.

21. Keep the Flow Control Policy as Default.

22. Click the 10Gbps radio button for the Admin Speed.

23. Click the Trunk radio button for the Port Mode.

24. Select vlan11_Appliance, and click the Native VLAN radio button.

Figure 24 Configure as Appliance Port 4
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25. Repeat steps 1 through 24 for configuring appliance port on port 3, 4, and 5 for configuring Cisco
UCS C3160 on the expansion racks.

Enabling Server Ports

These steps provide details for enabling server ports.
26. Seclect the Equipment tab on the top left of the window.

27. Select Equipment > Fabric Interconnects > Fabric Interconnect A (primary) > Fixed Module.
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28. Expand the Unconfigured Ethernet Ports section.

29. Select all the ports that are connected to the Servers right-click them, and select Reconfigure >
Configure as a Server Port.

30. A pop-up window appears to confirm your selection. Click Yes then OK to continue.

31. Select Equipment > Fabric Interconnects > Fabric Interconnect B (subordinate) > Fixed
Module.

32. Expand the Unconfigured Ethernet Ports section.

33. Select all the ports that are connected to the Servers right-click them, and select Reconfigure >
Configure as a Server Port.

34. A pop-up window appears to confirm your selection. Click Yes then OK to continue.

Figure 25 Enabling Server Ports
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Figure 26 Showing Servers, Appliance and Uplink Ports
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Creating Pools for Service Profile Templates

Creating an Organization

Organizations are used as a means to arrange and restrict access to various groups within the IT
organization, thereby enabling multi-tenancy of the compute resources. This document does not assume
the use of Organizations; however the necessary steps are provided for future reference.

Follow these steps to configure an organization within the Cisco UCS Manager GUI:
1. Click New on the top left corner in the right pane in the UCS Manager GUI.
Select Create Organization from the options

Enter a name for the organization.

(Optional) Enter a description for the organization.

Click OK.

AU T o

Click OK in the success message box.

Creating MAC Address Pools

Follow these steps to create MAC address pools:

1. Select the LAN tab on the left of the window.

Select Pools > root.

Right-click MAC Pools under the root organization.

Select Create MAC Pool to create the MAC address pool. Enter ucs for the name of the MAC pool.
(Optional) Enter a description of the MAC pool.

Select Assignment Order Sequential.

Click Next.

Click Add.

e ® a0 kWD

Specify a starting MAC address.

—
S

Specify a size of the MAC address pool, which is sufficient to support the available server resources.
. Click OK.

.
.
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Figure 27 Creating MAC Pool Window
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Figure 28 Specifying First MAC Address and Size
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Figure 29 Adding MAC Addresses
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13. When the message box displays, click OK.

Figure 30 Confirming Newly Added MAC Pool
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Creating Server Pools

A server pool contains a set of servers. These servers typically share the same characteristics. Those
characteristics can be their location in the chassis, or an attribute such as server type, amount of memory,
local storage, type of CPU, or local drive configuration. You can manually assign a server to a server
pool, or use server pool policies and server pool policy qualifications to automate the assignment

Follow these steps to configure the server pool within the Cisco UCS Manager GUI:
1. Select the Servers tab in the left pane in the UCS Manager GUI.

Select Pools > root.

Right-click the Server Pools.

Select Create Server Pool.

Enter your required name (ucs) for the Server Pool in the name text box.
(Optional) enter a description for the organization

Click Next to add the servers.

A U S o
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Create Server Pool

Description
2. 1 Add Servers

1. ¥ Set Name and

Creating Pools for Service Profile Templates

Figure 31 Setting Name and Description of Server Pool

+ Create Server Pool [ %]

Set Name and Description

= Prey. | Mexk = I Finiisti | Cancel |

10.

Select all the Cisco UCS C240M4SX servers to be added to the server pool you previously created
(ucs), then Click >> to add them to the pool.

Click Finish.
Click OK, and then click Finish.
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Figure 32 Adding Servers to the Server Pool
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Creating Policies for Service Profile Templates

Creating Host Firmware Package Policy

Firmware management policies allow the administrator to select the corresponding packages for a given
server configuration. These include adapters, BIOS, board controllers, FC adapters, HBA options, ROM
and storage controller properties as applicable.

Follow these steps to create a firmware management policy for a given server configuration using the
Cisco UCS Manager GUI:

1. Select the Servers tab in the left pane in the UCS Manager GUI.

2. Select Policies > root.

3. Right-click Host Firmware Packages.
4. Select Create Host Firmware Package.
5

Enter your required Host Firmware package name (ucs).
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6. Click the Simple radio button to configure the Host Firmware package.
7. Select the appropriate Rack package that you have.

8. Click OK to complete creating the management firmware package.

9. Click OK.

Figure 33 Creating Host Firmware Package

Creating QoS Policies
Follow these steps to create the QoS policy for a given server configuration using the Cisco

UCS Manager GUI:

Best Effort Policy

1. Select the LAN tab in the left pane in the UCS Manager GUI.

2. Select Policies > root.
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3. Right-click QoS Policies.
4. Seclect Create QoS Policy.

Figure 34 Creating QoS Policy

0o5 Policies
&, Filter | = Export | iz Print

Equipment | Servers | LAN ] San IWI Admin|

Filter: &l -
Marme

= |
==l Lan
[ LaN Cloud
) appliances
=] Internal Lan
—- & Policies
D ppliances
I LAM Cloud
~As oot
- B Default wNIC Behavior
- B Dynamic ¥NIC Connection Policies
Flow Control Policies
+- 55 LACF Policies
- B LA Connectivity Policies
- B Link Protacal Palicy
& Multicast Policies
¥ % Metwork Confral Palicies

Thre Show Navigator
RS Create QoS Policy

2 LEMLC o e oon s FunLies
wMNIC Templates

,!:1, Sub-Crganizations

F+| @ Pools

& ,@ Traffic Monitoring Sessions

- 5—1 Metflow Monitoring

Enter BestEffort as the name of the policy.
Select BestEffort from the drop down menu.
Keep the Burst (Bytes) field as default (10240).
Keep the Rate (Kbps) field as default (line-rate).

® ® A & W

Keep Host Control radio button as default (none).

10. Once the pop-up window appears, click OK to complete the creation of the Policy.
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Figure 35 Creating BestEffort QoS Policy

- Create QoS Policy

Create QoS Policy 2

Create Qos Policy
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o

Platinum Policy

Select the LAN tab in the left pane in the UCS Manager GUI.
Select Policies > root.

Right-click QoS Policies.

Select Create QoS Policy.

Enter Platinum as the name of the policy.

Select Platinum from the drop down menu.

Keep the Burst (Bytes) field as default (10240).

Keep the Rate (Kbps) field as default (line-rate).

e ® 2 kW N

Keep Host Control radio button as default (none).

—
S

Once the pop-up window appears, click OK to complete the creation of the Policy.
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Figure 36 Creating Platinum QoS Policy
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Setting Jumbo Frames

Follow these steps for setting up the Jumbo frames and enabling QoS:
Select the LAN tab in the left pane in the UCS Manager GUI.
Select LAN Cloud > QoS System Class.

In the right pane, select the General tab

In the Platinum row, enter 9000 for MTU.

Check the Enabled Check box next to Platinum.

In the Best Effort row, select best-effort for weight.

In the Fiber Channel row, select none for weight.

Click Save Changes.

Click OK.

o A O o L

Figure 37 Setting Jumbo Frames
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Creating Local Disk Configuration Policy

Follow these steps to create local disk configuration in the Cisco UCS Manager GUI:
1. Select the Servers tab on the left pane in the UCS Manager GUI.

Go to Policies > root.

Right-click Local Disk Config Policies.

Select Create Local Disk Configuration Policy.

Enter ucs as the local disk configuration policy name.

Change the Mode to Any Configuration. Check the Protect Configuration box.
Keep the FlexFlash State field as default (Disable).

Keep the FlexFlash RAID Reporting State field as default (Disable).

e ® 2SR WD

Click OK to complete the creation of the Local Disk Configuration Policy.
Click OK.

—
B
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Figure 38 Configuring Local Disk Policy
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Creating Server BIOS Policy

The BIOS policy feature in Cisco UCS automates the BIOS configuration process. The traditional
method of setting the BIOS is done manually and is often error-prone. By creating a BIOS policy and
assigning the policy to a server or group of servers, you can enable transparency within the BIOS settings
configuration.

Note  BIOS settings can have a significant performance impact, depending on the workload and the
applications. The BIOS settings listed in this section is for configurations optimized for best
performance which can be adjusted based on the application, performance and energy efficiency
requirements.

Follow these steps to create a server BIOS policy using the Cisco UCS Manager GUI:
1. Select the Servers tab in the left pane in the UCS Manager GUI.
2. Select Policies > root.

3. Right-click BIOS Policies.
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4. Select Create BIOS Policy.
5. Enter your preferred BIOS policy name (ucs).
6. Change the BIOS settings as per the following figures:

Figure 39 Creating Server BIOS Policy
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Figure 40 Creating Server BIOS Policy for Processor
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Figure 41 Creating Server BIOS Policy for Intel Directed 10

. VMain
. VProcessar
. ¥Intel Directed 10
Uras memary
Serial Port
Uuse
Uegr
Qopt
- ULoM and PCIe Shats
. DEFDDt"'DQﬁg' ns
: D"ServerManagement

1
2
3
4,
5.
£,
7
a
o
10
11,

7. Click Finish to complete creating the BIOS policy.
8. Click OK.
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Figure 42 Creating Server BIOS Policy for Memory
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Creating Boot Policy

Follow these steps to create boot policies within the Cisco UCS Manager GUI:
1. Select the Servers tab in the left pane in the UCS Manager GUI.

2. Select Policies > root.

3. Right-click the Boot Policies.

4. Select Create Boot Policy.
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Creating Boot Policy Part 1

Creating Policies for Service Profile Templates
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Enter ucs as the boot policy name.

(Optional) enter a description for the boot policy.

Keep the Reboot on Boot Order Change check box unchecked.
Keep Enforce vNIC/vHBA/iSCSI Name check box checked.
. Keep Boot Mode Default (Legacy).

10. Expand Local Devices > Add CD/DVD and select Add Local CD/DVD.
11. Expand Local Devices and select Add Local Disk.
12. Expand vNICs and select Add LAN Boot and enter ethO.
13. Click OK to add the Boot Policy.

14. Click OK.

Cisco UCS Integrated Infrastructure for Big Data with Hortonworks Data Platform g



| Creating Policies for Service Profile Templates

Figure 44 Creating Boot Policy Part 2
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Creating Power Control Policy

Follow these steps to create the Power Control policies within the Cisco UCS Manager GUI:
15. Select the Servers tab in the left pane in the UCS Manager GUI.

16. Select Policies > root.

17. Right-click the Power Control Policies.

18. Select Create Power Control Policy.
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Figure 45 Creating Power Control Policy Part 1
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19. Enter ucs as the Power Control policy name.

20. (Optional) enter a description for the boot policy.
21. Select No cap for Power Capping selection.

22. Click OK to the Power Control Policy.

23. Click OK.
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Figure 46 Creating Power Control Policy Part 2
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Creating Service Profile Template

To create a service profile template, follow these steps:
1. Select the Servers tab in the left pane in the UCS Manager GUI.
2. Right-click Service Profile Templates.

3. Select Create Service Profile Template.

Figure 47 Creating Service Profile Template
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4. The Create Service Profile Template window appears.

These steps below provide a detailed configuration procedure to identify the service profile
template:

a. Name the service profile template as ucs. Click the Updating Template radio button.
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b. In the UUID section, select Hardware Default as the UUID pool.

¢. Click Next to continue to the next section.

Figure 48 Identify Service Profile Template
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Configuring Network Settings for the Template

1. Keep the Dynamic vNIC Connection Policy field at the default.
2. Click the Expert radio button for the option, how would you like to configure LAN connectivity?
3. Click Add to add a vNIC to the template.
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Figure 49 Configuring Network Settings for the Template
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4. The Create vNIC window displays. Name the vNIC as eth0.

5. Select UCS in the Mac Address Assignment pool.

6. Click the Fabric A radio button and Check the Enable failover check box for the Fabric ID.
7. Check the default check box for VLANSs and click the Native VLAN radio button.

8. Select MTU size as 1500

9. Select adapter policy as Linux

10. Select QoS Policy as BestEffort.

11. Keep the Network Control Policy as Default.

12. Keep the Connection Policies as Dynamic vNIC.

13. Keep the Dynamic vNIC Connection Policy as <not set>.

14. Click OK.
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Figure 50 Configuring vNIC eth0
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15. Click Add to add a vNIC to the template.
16. The Create vNIC window appears. Name the vNIC ethl.
17. Select ucs in the Mac Address Assignment pool.
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18. Click the Fabric B radio button and Check the Enable failover check box for the Fabric ID.
19. Check the vlan11_DATA1 check box for VLANS, and click the Native VLAN radio button
20. Select MTU size as 9000

21. Select adapter policy as Linux

22. Select QoS Policy as Platinum.

23. Keep the Network Control Policy as Default.

24. Keep the Connection Policies as Dynamic vNIC.

25. Keep the Dynamic vNIC Connection Policy as <not set>.

26. Click OK.
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Figure 51 Configuring vNIC ethl
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27. Click Add to add a vNIC to the template.

28. The Create vNIC window appears. Name the vNIC eth2.

29. Select ucs in the Mac Address Assignment pool.

30. Click the Fabric A radio button, and then Check the Enable failover check box for the Fabric ID.
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31. Check the vlan12_DATA2 check box for VLANS, and then click the Native VLAN radio button.
32. Select MTU size as 9000.

33. Select adapter policy as Linux.

34. Select QoS Policy as Platinum.

35. Keep the Network Control Policy as Default.

36. Keep the Connection Policies as Dynamic vNIC.

37. Keep the Dynamic vNIC Connection Policy as <not set>.

38. Click OK.
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Figure 52 Configuring vNIC eth2
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Configuring Storage Policy for the Template

Follow these steps to configure storage policies:

1.

Select ucs for the local disk configuration policy.
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2. Click the No vHBAs radio button for the option, How would you like to configure SAN
connectivity?

3. Click Next to continue to the next section.

Figure 53 Configuring Storage Settings
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4. Click Next once the zoning window appears to go to the next section.
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Figure 54 Configure Zoning
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Configuring vNIC/vHBA Placement for the Template

Follow these steps to configure vNIC/vHBA placement policy:
1. Select the Default Placement Policy option for the Select Placement field.
2. Select eth0, ethl and eth2 assign the vNICs in the following order:
a. eth0
b. ethl
c. eth2
3. Review to make sure that all of the vNICs were assigned in the appropriate order.

4. Click Next to continue to the next section.
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Figure 55 vNIC/vHBA Placement
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Configuring vMedia Policy for the Template

1. Click Next once the vMedia Policy window appears to go to the next section.
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Figure 56 UCSM vMedia Policy Window
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Configuring Server Boot Order for the Template

Follow these steps to set the boot order for servers:
1. Select ucs in the Boot Policy name field.

2. Review to make sure that all of the boot devices were created and identified.
3. Verify that the boot devices are in the correct boot sequence.

4. Click OK.

5

Click Next to continue to the next section.
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Figure 57 Creating Boot Policy
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In the Maintenance Policy window, follow these steps to apply the maintenance policy:
1. Keep the Maintenance policy at no policy used by default.

2. Click Next to continue to the next section.

Configuring Server Assignment for the Template

In the Server Assignment window, follow these steps to assign the servers to the pool:
3. Select ucs for the Pool Assignment field.
4. Keep the Server Pool Qualification field at default.

5. Select ucs in Host Firmware Package.
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Figure 58 Server Assignment
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Configuring Operational Policies for the Template

In the Operational Policies Window, follow these steps:
6. Select ucs in the BIOS Policy field.

7. Select ucs in the Power Control Policy field.

8. Click Finish to create the Service Profile template.
9. Click OK in the pop-up window to proceed.
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Figure 59 Selecting BIOS and Power Control Policy
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Select the Servers tab in the left pane of the UCS Manager GUI.

1. Go to Service Profile Templates > root.
2. Right-click Service Profile Templates ucs.

3. Select Create Service Profiles From Template.
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Figure 60 Creating Service Profiles from Template
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4. The Create Service Profile from Template window appears.

Figure 61 Selecting Name and Total number of Service Profiles

Association of the Service Profiles will take place automatically.

The Final Cisco UCS Manager window is shown in Figure 46.

Cisco UCS Integrated Infrastructure for Big Data with Hortonworks Data Platform



| Configuring CIMC Access Using the CIMC Configuration Utility on C3160

Figure 62 UCS Manager showing all Nodes
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= Rack-Mounts = Serverd | 1 -, . [Clsco UCS €., [FCHLBS2WOPY 24 262144 L 3 ] 4 Operable | § On # Associatedorgrootils-... [NjA
I lia = cervers | 1 JCisca UCs ... Ferilastvizz 24 2144 1 5 0 1 Operabls | ¢ On T Associatediorg rootjis-... |NiA
i By = Server 6 | £ OF .|Ciseo UCS €.... FCHLBS2U0L4 | 24 egziea 1 19 |3 i Operable |t On ¥ Assodatedorgroatiis-... (A
[ Fabric Interconnects [
S Server 7 | £ . |Ciseo UCS €., FCHLBE2W00] 24 262144 1 3 (] 4 Opsrable | & On + Associasted arg-rootls-... [NjA
| Servers |t 0 240-.,[Clsco UCS C.., FCHIBE2V0QC| 2 et 3 i ¥ Operable | T On T Assoriaked arg-roatils-... WA
= Server 8 |1 |fisco UCS €., FCHLES1Z3 24 262144 1 3 0 ¥ Operable | 1 On 1 Assoclatedorgroatils.. [NA
&% Server 10 | # ... FCHIBS2VONF 24 262144 1 3 0 % Operable | ¥ On ¥ Assorlated arg-roatls-..
& Server 11 | § O [FCHLBS2VOPP 24 262144 I B o + Operable | On 1 Assoclatediorg-rootyls-... [N/
% Server 12 | £ 213 24 267144 i 3 o 4 Operable |t On  Associated arg-rootls-... NjA
= Server 13 | & O VOQF 3 = 13 0 & Operable | On + Assoriated org-rootjls-... |NiA
<% Server 14 | # fl FCHL851v243 24 262144 1 3 ] 4 Operable | On ¥ Assoclatedorgrootils-... [Ni&
|53 Server 15 | # Ok LICSC-C240-. .. [Clsco UCS C... FCHLB51V216 24 262144 1 3 a ¥ Operablz | ¥ On T Associated org-rontfls-... |Nf&
o Server 16 | £ Ok IUCSC-C240-... [Ciseo UCS ... FCHIBSZVONA 24 laez144 L 3 o 1 Opersble | On 1 Associaked arg-roatls-... NiA

Configuring CIMC Access Using the CIMC Configuration
Utility on C3160

Introduction

The following sections provide an overview of how to setup the CIMC network connectivity for UCS
C3160.

1. Cisco C-Series Rack Servers provides a physical local video and two USB connections for a USB
keyboard, video monitor, and USB mouse connection through the front and back panel of the rack
server using the Cisco provided dongle connector.

2. Allrack servers can have up to 4 active KVM over IP sessions in addition to the local connection at
front or rear panels. all active sessions have full control of the console.

3. KVM over IP supports text and graphics modes of the graphics controller and needs no manual
setting to view data.
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Cable Connectivity

Figure 63 Cable connections for C3160 servers:

Cisco UCS 6296UP Fabric Interconnect A
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Appliance Port A
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-

]
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Cisco UCS C3160 Rack Server

Connection for C3160 Server:

1. Connect video monitor, USB keyboard and USB mouse to Cisco C3160 rack servers through the
back panel using the Cisco provided dongle connector.

2. Connect the network port of the C3160 Server to Management port of the Management switch.

Power up the KVM

Complete the steps below in order to power up the server:
1. Plug the power cord into the chassis.

~

Note « CIMC initializes system standby (Power Off mode).
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~

Note « CIMC is active and can be controlled through GUI or CLI, if you know the IP address.
2. Depress Front Panel Power:
— The Fans begin to spin up.
— Then POST sequence begins.
— At this point you can either boot up or begin the installation process.

— Note that for large memory, models can display a blank screen for several minutes.

F8 to Configure and View CIMC IP

While in BIOS you can press F8 for the CIMC IP address configuration and password reset.
1. Set NIC mode to Dedicated.

Set NIC redundancy to None

Choose IPv4 for Static configuration.

Enter the CIMC IP, subnet and gateway information.

Nk woN

After entering IP information, press F5 in order to display the configured IP.

Cisco IMC Configuration Utility Yersion

IC Properties
MIC mode NIC redundancy

6. Press F1 and enter Additional Settings (optional).
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FactoryDefaults

Default Us

Port Profil

7. Press F10 in order to save the configuration.

8. Press ESC to exit.

THE- TR
1 IMC MAC A
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Access CIMC

1. Then point a Web browser to the configured CIMC IP address http://10.29.160.230
e Default username: admin

* Default password: password

Figure 64 Cisco Integrated Management Window
== ﬁ
Cisco Integrated Manageme... % | +

» il @ hitps;//10.29.160230/login htm G| & v |Q serch %8 3 & 480 D & @ @~ » | =

] Cisco Integrated Management Controller

CISCO  C3160-FCH1834J73U Usemame:
Version: 2.0{2c) Password: L1111 u‘

©2008-2014, Cisco ms, Inc. Al rights reserved.

2. Once logged in successfully. The server can be controlled using CIMC
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Figure 65 Cisco Integrated Management Controller

'élu'ééL:' Cisco Integrated Management Controller

3. Click Launch KVM Console.
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4. Restart the server by using KVM Console, Macros > Static Macros > Ctrl-Alt-Del.

IMC IPw

Installing Redhat Enterprise Linux 6.5 software Raid (OS
based Mirroring) on C3160 System using CIMC

The following section provides detailed procedures for installing Red Hat Linux 6.5.

Access CIMC

1. Then point a Web browser to the configured CIMC IP address http://10.29.160.230
* Default username: admin

e Default password: password
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Figure 66 CIMC Log in Page

=

Cisco Integrated Manageme... * | +

il & htips//10.29.160.230/loginhtm C| M| v | Q Ssearch B &$ & 480 D @ B |~

ol Cisco Integrated Management Controller

CISCO  C3160-FCH1834J73U Usermame.
Version: 2.0(2c) Password: EEXTXTER

008-2014, Cisco ems, Inc. All rights reserved.

2. Once logged in successfully. The server can be controlled using CIMC.
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Figure 67 CIMC: Sever Summary Page

il cisco Integrated Management Controller

cisco

3. Click Launch KVM Console.
Restart the server by using KVM Console, Macros > Static Macros > Ctrl-Alt-Del
1. In the KVM window, select the Virtual Media tab.
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2. Click the Activate Virtual Devices found under Virtual Media tab.

A 10.29.160.230 - KVM Console =2 -

IFiIe View Macros Tools Power|\ﬁrma]l&edia Help

Create Image

Activate Virtual Devices

and t ing memory. ..

Cisco IMC IPv4 : 18.29.168.238
MAC ADDR: FC:5B:39:A8:8n:E4

10.29.160.230 || admin | 1.8 1ps | 0.62 KB/s é|
]

3. Inthe KVM window, select the Virtual Media tab and Click the Map CD/DVD.
A 10.29.160.230 - KVM Console = | [

|Fi|e View Macros Tools Powerlv]rma]uedia Help

Create Image

+ Activate Virtual Devices
Map CDIiDVD
Map Removable Disk

7 = 2 : Map Flo
Configuring and t¥e

Cisco IMC IPv4 : 18.29.160.230
MAC ADDR: FC:5B:39:AB:BA:E4

10.29.160.230/| admin || 0.6 fos|| 0.001 KBis || Sy ="

4. Browse to the Red Hat Enterprise Linux Server 6.5 installer ISO image file.
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~

Note  The Red Hat Enterprise Linux 6.5 DVD is assumed to be on the client machine.

5. Click Open to add the image to the list of virtual media.

Figure 68 Browse to Red Hat Enterprise Linux ISO Image

Look in: | ISO = M

(¢ ESXi-5.1.0-799733-custom-Cisco-2.1.0 3050
(+ ESXi-5.5.0-1746018-Custom-Cisco-5.5.13.s0
@ rhel-server-6.5-%86_ 6 50
(< rhel-server-7.0-x86_64-chvd.iso
(¢ ucs-c3160-huu-2.0.145.s50

File name: thel-server-6.5-x86_64-dvd.iso | Cpen
Files af type:  Disk iso file (*.iso) i

6. Inthe KVM window, select the KVM tab to monitor during boot.

7. In the KVM window, select the Macros > Static Macros > Ctrl-Alt-Del button in the upper left
corner.

8. Click OK.
9. Click OK to reboot the system.

10. On reboot, the machine detects the presence of the Red Hat Enterprise Linux Server 6.5 install
media.

11. Select the Install or upgrade an existing system.
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Figure 69 Red Hat Enterprise Linux Server 6.5 Install Media

Welcome to Red Hat Enterprise Linux 6.5t

[lnstall or upgrade an existing systen
Install system with basic video driver
Rescue installed system

Boot from local drive

Memory test

Press [Tabl to edit options

RED HAT
ENTERPRISE LINUX® 6

Copyright © 2003-2010 Red Hat, Inc. and others. All rights reserved.

12. Skip the Media test and start the installation

Figure 70 RHEL: Media Test and Start of Installation

Welcome to Red Hat Enterprise Linux for

Disc Found

To begin testing the media before
installation press OK.

Choose Skip to skip the media test
and start the installation.

between elements |

13. Click Next
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Figure 71 Red Hat Enterprise Linux Server 6.5 Install Media

L3

RED HAT"

ENTERPRISE LINUX" 6

Copy right @ 2003-2010 Wed Hat, I1nc. 3nd otkars, ANl FIFAES resery od.

14. Select language of installation, and then Click Next
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Figure 72 RHEL Installation: Language and Keyboard Selection
3

What language would you like to use during the
installation process?

| Arabic (ax )
Assamese (%r1TraT)

| Bengali (ars=i)

| Bengali(India) (arz=1 (=19 )

| Bulgarian (Bbnrapcku)

| Catalan (Catala)

| Chinese(Simplified) (32 (&) )

| Chinese(Traditional) (43 (E&) )
Croatian (Hrvatski)

| Czech (Cestina)

| Danish (Dansk)

| Dutch (Nederlands)

| Estonian (eesti keel)

| Finnish (suomi)

| French (Frangais)

| German (Deutsch)

| Greek (EAAnuLKa)

| Gujarati (ap2icl)

| Hebrew (n1aw)

| Hindi (&=

| Hungarian (Magyar)

| Icelandic {Icelandic)

| lloko {lloko)

| Indonesian (Indonesia)

(«]

I 4mBack ‘ [ »Next]

Select the appropriate keyboard for
the system.

%Tfi?lﬁn
Italian (IBM)
Italian (it2)
Japanese
Korean

0]

Latin American
Macedonian
Norwegian

Polish

Portuguese
Romanian

Russian

Serbian

Serbian (latin)
Slovak (qwerty)
Slovenian

Spanish

Swedish

swiss French

Swiss French (latinl)
Swiss German
Swiss German (latinl)
Turkish

U.S. International

Ukrainian
United Kingdom

I 4mBack I [ *Nextl

15. Select Basic Storage Devices and Click Next.

Cisco UCS Integrated Infrastructure for Big Data with Hortonworks Data Platform g



| Installing Redhat Enterprise Linux 6.5 software Raid (OS based Mirroring) on C3160 System using CIMC

Figure 73 RHEL Installation: Storage Devices Selection

What%ype of devices will your installation involve?

_ Basic Storage Devices
® |nstalls or upgrades to typical types of storage devices. If you're not sure which option is right for you,
this Is probably it

_ Specialized Storage Devices
) Installs or upgrades to enterprise devices such as Storage Area Networks (SANs). This option will allow
you to add FCoE / ISCS! / zFCP disks and to filter out devices the installer should Ignore.

‘ 4mBack

w next |

Storage Device Warning

A The storage device below may contain data.

ATA INTEL SSDSC2BB12
— 114473.460938 MB pci-0000:00: 1f.2-scsi-4:0:0:0

We could not detect partitions or filesystems on this device.

This could be because the device is blank, unpartitioned, or virtual. If
not, there may be data on the device that can not be recovered if you use it
in this installation. We can remove the device from this installation to
protect the data.

Are you sure this device does not contain valuable data?

i Apply my choice to all devices with undetected partitions or filesystems

Yes, discard any data | No, keep any data

| 4= Back | :“»Next I

16. Provide hostname and configure Network for the host.
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Figure 74 RHEL Installation: Specify Hostname

— Please name this computer. The
|l__.E-I:| hostname identifies the computer on a
— == network.

Hostname: [rhei65

LS ! Configure Network_

| 4mBack | | *Next]

Figure 75 RHEL Installation: IPv4 Settings for eth0

Connection name: |etho |

Connect automatically
1 Awvailable to all users

Wired | 802.1x Security | IPv4 Settings | IPv6 Settings |

Method: | Manual z |

Addresses
[ Address Netmask Gateway ||  Add |

2:255.0 1029160 |

Delete |

DNS servers: [ |

search domains: | |

W Require IPv4 addressing for this connection to complete

| Routes... |

cancel || Apply.. |
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Figure 76 RHEL Installation: IPv4 Settings for ethl

Connection name: |ethl |

] Connect automatically
o

Wired | 802.1x Security | IPv4 Settings | |Pve Settings

Method: iManuaI o] |

Addresses

Address Netmask Gateway | Add |

DNS servers: | |

search domains: | |

1 Require IPv4 addressing for this connection to complete

|_Route5 =

i- Cancei__I

Figure 77 RHEL Installation: Location Selection

Please select the nearest city in your time zone:

|

| #¥

<| i,
Selected city: Los Angeles, America (Pacific Time)

America/Los Angeles e

¥ System clock uses UTC

‘ 4 Back i | B Next |
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Figure 78 RHEL Installation: Enter Root Credentials

k

i

Root Password:

Confirm:

The root account is used for administering
the system. Enter a password for the root
user.

| quBack | | mpiNext

17. Choose Create Custom Layout for Installation type.
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Figure 79

RHEL Installation: Custom Layout Creation

Which type of installation would you like?

Use All Space
Removes all partitions on the selected device(s). This includes partitions created by other operating
systems.

Tip: This aption wlll remove data frem the selected deviceis). Make sure you have backups.

Replace Existing Linux System(s)
Remaoves only Linux partitions (created from a previous Linux installation). This does not remove other
partitions you may have on your storage device(s) (such as VFAT or FAT32)

Tip: This option will remove data from the selected device(s). Make sure you have backups.

Shrink Current System
Shrinks existing partitions to create free space for the default layout

Use Free Space
Retalns your current data and partitions and uses only the unpartitioned space on the selected device
(s), assuming you have enough free space available.

Create Custom Layout
Manually create your own custom layout on the selected device(s) using our partitioning tool.

‘ 4uBack | | QNext‘

18. Following steps can be used to create two software RAID 1 partitions for boot and, or (root)
partitions.
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a. Choose free volume and click on Create and choose RAID Partition.

Figure 80 RHEL Installation: Create RAID Partition

k

Drive /dev/sdd (114473 MB) (Model: ATA INTEL SSDSC2BB12)

Free
114471 M8

Size  Mount Point/

Device (MB) RAID/Volume

Type Format

v Hard Drives

- sdd
Free 114470
v sde
; 114470 Create Storage
ree -
Create Partition
() Standard Partition
Create Software RAID Information
@ [RAID Partition|
Create LVM Information

) LVM Physical Volume

Cancel Create |

Create d Ds | Reset |

| 4 Back | | mp Next ‘

b. Choose “Software RAID” for File system Type and set size for Boot volume
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Figure 81 RHEL Installation: Add RAID Partition
Drive /dev/sdd (114473 MB) (Model: ATA INTEL SSDSC2BB12)
Free
114471 M8
. ¥ Size  Mount Point/
pevice &k {MB) RAIDNVolume, "YPe Fommat
= Hard Drives
v sdd
Free 114470 Add Partition
AL Mount Point: Jot Applicable>
Free 114470
File System Type: | software RAID o
O | Drive Size Model
sdd 114473 MB  ATA INTEL SSDSC28812

Allowable Drives: [ ] sde 114473 MB

ATA INTEL SSDSC2BB12

Size (MB): [2 048
Additional Size Options
@® Fixed size

O Fill all space up to {MB):

O Fill to maximum allowable size
] Force to be a primary partition
[ Encrypt

Cancel | |

0K

Create

elete Reset |

| 4m Back | | ’Next|

19. Similarly, do the RAID configuration for the other free volume.
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Figure 82 RHEL Installation: Create RAID Partition
k
Drive /dev/sde (114473 MB) (Model: ATA INTEL SSDSC2BB12)
Free
114473 MB
e Size  Mount Point/ Type e ;

|
v Hard Drives
= sdd
sddl
Free

- sde

(MB) RAID/Volume

2048 software RAID
112424

Create Storage

Create Partition
" Standard Partition

Create Software RAID Information
@ [RAID Partition
Create LVM Information

"~ LVM Physical Volume

| cancel Create |

Create i ele | Reset |

| 4EBack | | ’Nex‘c|
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Figure 83 RHEL Installation: Add RAID Partition
Drive /dev/sde (114473 MB) (Model: ATA INTEL SSDSC2BB12)
Fres
k 114473 M8
Divics Size  Mount Point/ Type it

(MB) RAID/Nolume
|= Hard Drives

" Add Partition
sdd1 2048 :
Free 112424 Mount Point:

v sde File System Type: Isoftware RAID - |
Free 114473 .

‘ O | Drive | Size Model
1 sdd 114473 MB  ATA INTEL SSDSC2BB12

CULVEL CRelo o 4 sde 114473 MB  ATA INTEL SSDSC2BB12

size (MB): [204&1 2l
Additional Size Options )
@ Fixed size

(O Fill all space up to (MB).
) Fill to maximum allowable size
[] Force to be a primary partition
[ Encrypt
Cancel | OK

Create Edit | elets Reset |

| mBack | ‘ B Next ‘

20. Now similarly create RAID partitions for root (/) partition on both the devices and use rest of the
available space
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Figure 84 RHEL Installation: Create RAID Partition
!*7 Drive /dev/sdd (114473 MB) (Model: ATA INTEL 5SDSC2BB12)
/{Free
2112424 M8
: Size  Mount Point/ |
_ T (MB) RADDNolume WP Format |
| Hard Drives
v sdd
sdd1 2048 software RAID v~
Fi 424
i il Create Storage
v sde o
4 -~ Create Partition
Aol 2048 softWl - standard Partition
Free 112424
Create Software RAID Information
@ |RAID Partition|
) RAID Device
Create LVM Information
) LVM Physical Volume
Cancel Create |
Create Edit e | Reset |
| 4mBack | I W Next |
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Figure 85 RHEL Installation: Add RAID Partition
k

Drive /dev/sdd (114473 MB) (Model: ATA INTEL SSD5SC2BB12)
/(Free
Muzm MB

5 Size  Mount Point/

o (MB) RADDNolume ~ Pe  Format
= Hard Drives
v sdd

Add Partition

sddl 2048

Mount Point:

112424

sdd 114473 MB  ATA INTEL SSDSC2BB12
Allowable Drives: | [] sde 114473 MB  ATA INTEL SSDSC2BB12

v sde File System Type: | software RAID ¢ ‘
sdel 2048 — -
Free 112424 | | Drive  Size Model

O Fill all space up to (MB):
© [Fill to maximum allowable size}

[ Force to be a primary partition
[0 Encrypt

Size (MB): |200 5
-Additional Size Options
() Fixed size

Cancel | OK

Create

|| Delete || Reset |

| $mBack ‘ ‘ ‘Next‘
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Figure 86 RHEL Installation: Create RAID Partition
k Drive /dev/sde (114473 MB) (Model: ATA INTEL SSDSC2BB12)
Lo

Size  Mount Point/

Devie (MB) RAID/Volume Type Farmat i
= Hard Drives

= sdd

sddl 2048 software RAID

sdd2 112424 S0ftv anmbi

Create Storage
v sde
Create Partition
sdel 2048 softwi

) Standard Partition

112424

Create Software RAID Information
@ [RAID Partition|

) RAID Device

Create LVM Information

) LVM Physical Volume

cancel || Create |

Create | Edit ||| D Reset |

| @Bk | | Bptext
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Figure 87

RHEL Installation: Add RAID Partition

&

Device

- Hard Drives
= sdd
sdd1
sdd2
v sde
sdel
Free

Drive /dev/sde (114473 MB) (Model: ATA INTEL SSDSC2BB12)

{Free
2112424 MB

Size | Mount Point/

(MB) RAID/Volume Type Format

2048 -

112424 Mount Point;
File System Type: | software RAID <
2048 — .
112424 | O Drive | Size Model |

I [1 sdd  114473MB  ATAINTEL SSDSC2BB12 |

LULTEL TRV 1 scle  114473MB ATA INTEL SSDSC2BB12

Size (MB): 200

) Fill all space up to (MB):

® [Fill to maximum allowable size|

[ Force to be a primary partition
[ Encrypt

2
Additional Size Options
() Fixed size

Cancel

0K

Create fit || Dele Reset |

| §Back | | ’Next|

21. The above steps created 2 boot and 2 root (/) partitions. Following steps will RAID1 Devices
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Figure 88 RHEL Installation: Selected RAID Devices
L

Please Select A Device

Size  Mount Point/

Device (MB] RADNolume ~ PE  Format
v Hard Drives
< sdd
sddl 2048 software RAID
sdd2 112424 software RAID
= sde
sdel 2048 software RAID
sde2 112424 software RAID

Create } Reset

| aBack ‘ | W Next |

22. Choose one of the boot partitions and click on Create > RAID Device.
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Figure 89 RHEL Installation: Select RAID Device
k Drive /dev/sdd (114473 MB) (Model: ATA INTEL SSDSC2BB12)
lo/dev/sdd2
2112424 MB

Size  Mount Point/

: Device (MB)  RAIDNVolume Type Format |
(v Hard Drives |
‘ < sdd |
sddl 2048 software RAID
sdd2 112424 softw uuibes
Create Storage
v sde .
Create Partition
sdel 2048 soft ctondard Barition
sde2 112424 softw
Create Software RAID Information
® [RAID Device|
Create LVM Information

| cancel || Create |

Create | Edit || Delete I Reset |

[ @ Back ‘ ‘ B Next

23. Choose this as /boot (boot device) and in RAID members, choose all the boot partitions created
above in order to create a software RAID 1 for boot.
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Figure 90 RHEL Installation: Make RAID Device
Drive /dev/sdd (114473 MB) (Model: ATA INTEL SSDSC2BB12)
/0/dev/sdd2
21112424 MB
: Size  Mount Point/
et (MB)  RAID/Volume e S ‘

|

|

v Hard Drives

‘ < sdd
sddl
sdd2

v sde
sdel
sde2

2048
112424

2048
112424

ftware RAID
Mount Point: [,‘boot | v
File System Type: | extd &
RAID Device: | mdo 4
RAIDLevel; | RAIDL &
¥ sddl 2048 MB c
RAID Members: D sddz2 112424 MB

7 sdel
1124724 M8, W

Number of spares:

[ Encrypt

Cancel oKk |

Create Edit || Delete || Reset |

‘ 4uBack ‘ { B Next

24. Similarly repeat for / partitions created above choosing both members with mount point as ““/”.
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Figure 91 RHEL Installation: Select RAID Device
Drive /dev/sdd (114473 MB) (Model: ATA INTEL SSDSC2BB12)
‘f1fdev{sdd2
21112424 MB
: Size | Mount Point/ ;
| 2l (MB) = RAID/Volume e Lot |
= RAID Devices
mdo 2045 /boot ext4 v
i~ Hard Drives
- sdd

Create Storage
=] Create Partition

sddl 2048 mdo

112424
v sde
sdel 2048 mdo soff] Create Software RAID Information
sde2 112424 soft}
 RAID Device|
Create LVM Information
| cancel || Create |
Create Edit || Delete || Reset
| 4Back | ‘ *Nex‘c|
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Figure 92 RHEL Installation: Make RAID Device
k Drive /dev/sdd (114473 MB) (Model: ATA INTEL SSDSC2BB12)
ig/dev/sdd2
‘ Muuza MB
‘ ‘ Size  Mount Point/
‘ Device {MB)  RAID/Volume Type Format ‘
= RAID Devices
mdo 2045 /boot extd v
= Hard Drives
v sdd
sddl 2048 mdo Make RAID Device
sdd2 112424 Mount Point: [/ v |
s File System Type: | ext4 S
sdel 2048 mdo : o) 2
sde2 112424 RAID Device: | mdl 2
RAID Level: [RaiD1 |z]
) sdd2 112424 M8 i
RAID Members:
Number of spares:
[ Encrypt
Cancel oK |
Create Edit || Delete || Reset |
| mBack | ‘ ) Next |
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Figure 93 RHEL Installation: All the Selected Devices

Please Select A Device

Size  Mount Point/

Device (MB) RAID/Volume Type Format
/v RAID Devices
mdo 2045 /boot extd v
mdl 112359 / ext4 L
|= Hard Drives
= sdd
sddl 2048 mdo software RAID
stld2 112424 mdl software RAID
= sde
sdel 2048 mdo software RAID
sde2 112424 mdl software RAID

Create

Reset

| uBack | ‘ ’Next|

25. Click on Next.
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Figure 94 RHEL Installation: Warning before RAID Partitioning
k
Please Select A Device
: Size | Mount Point/
R (MB) = RAID/Volume Type SRk
v RAID Devices
md0 2045 /boot ext4 v
md1 112358 / ext4 v
= Hard Drives — =
< sdd - Partitioning Warnings
sdd1 2048 mdo The pa.mhonlng scheme you requested generated the
following wamings.
sdd2 112424 mdl . . =
% 8 You have not specified a swap partition. Although not
ALE istrictly required in all cases, it will significantly improve
sdel 2048 mdo performance for most installations.
sde2 112424 mdl

Would you like to continue with your requested partitioning
scheme?

No | Yes

Create I 2 Reset |

| 4 Back | | B Next |

Swap partition can be created using the similar steps, however, since these systems are high in memory,
this step is skipped (click Yes).

26. Click Next, and then click Format.
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Figure 95 RHEL Installation: Destroy Old Devices

A
Please Select A Device

Size | Mount Point/

Device (MB) ' RAID/Volume Type Eoeet
7 RAID Devices
md0 2045 /boot extd v
md1 112359 / ext4 v
= Hard Drives
v sdd Format Warnings
sddl 2048 mdo The following pre-existing devices have been selected to be
sdd2 112424 mdl formatted, destroying all data.
v sde \/dev/sdd partition table (MSDOS)
sdel 2048 mdo [/dev/sde partition table (MSDOS)
sde2 112424 mdl

Cancel || Format

27. Select default settings and click Next.
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Figure 96 RHEL Installation: Installing Boot Loader

3
¥ Install boot loader on /dev/sdd. |Change device |

[] Use a boot loader password

Boot loader operating system list

Default Label Device | Add
@ Red Hat Enterprise Linux /dev/mdl | Edit
| Delete

duBack | | mpNext
| Lty

28. Continue with RHEL Installation as shown below.
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Figure 97 RHEL Installation: Keep the Default Installation Option

The default installation of Red Hat Enterprise Linux is a basic server install. You can
optionally select a different set of software now.

® Basic Server

") Database Server
) Web Server

O Identity Management Server
) Virtualization Host

*) Desktop

") Software Development Workstation
) Minimal

Please select any additional repositories that you want to use for software installation.
[ High Availability

[] Load Balancer

¥] Red Hat Enterprise Linux

R TT SR A PR

]

=k Add additional software repositories | ! |5 Modify repository

You can further customize the software selection now, or after install via the software
management application.

® Customize |ater 3 Customize now

| EBack | ‘ mp Next

29. Once the installation is complete reboot the system.

Repeat the steps 1 through 29 to install Red Hat Linux 6.5 on Servers 66 through 68.

Note  The OS installation and configuration of the nodes that is mentioned above can be automated through

PXE boot or third party tools.

Installing Red Hat Enterprise Linux 6.5 using software
RAID on C240 M4 Systems

The following section provides detailed procedures for installing Red Hat Enterprise Linux 6.5 using
Software RAID (OS based Mirroring) on Cisco UCS C240 M4 servers.

There are multiple methods to install Red Hat Linux operating system. The installation procedure
described in this deployment guide uses KVM console and virtual media from Cisco UCS Manager.
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Note  This requires RHEL 6.5 DVD/ISO for the installation.

1. Login to the Cisco UCS 6296 Fabric Interconnect and launch the Cisco UCS Manager application.
2. Select the Equipment tab.

3. In the navigation pane expand Rack-Mounts and then Servers.

4. Right click on the server and select KVM Console.

Figure 98 Selecting KVM Console Option

o
B

Show MNavigator

| Inventory | Yirtual Machines | Hybrid Display | Installed Firmware | SEL Logs | CIMC Sessions | vIF Paths | P

Create Service Profile for Server
Associate Service Profile
Boot Server

Shutdown Server

Reset

Recover Server

Server Maintenance
KVM Console

S5H to CIMC for SoL
View Health LED Alarms
Turn on Locator LED
POST Results

Start Fault Suppression
Stop Fault Suppression

Copy Ctrl +C
Copy XML Ctrl +L
Delete Ctrl+D

N W

Part Details

Connection Details

Boot Order Details

. In the KVM window, select the Virtual Media tab.
. Click the Activate Virtual Devices from the Virtual Media tab.
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Figure 99 KVM Console

A C240M4 / ucsl (Rack -1) KVM Console{Launched B

| File View Macros Tools VlrtuaIMedla Help
i -

-5 Boot Server

le ‘ Froperties

Create Image

Activate Virtual Devices

|| 10.28.160.89 || admin || 1.4 fos || 0.251 ke /s ||

@ Connected to 1P 10.29,160.89

7. In the KVM window, select the Virtual Media tab and Click the Map CD/DVD.

Figure 100 KVM Console

A C240M4 / ucs1 (Rack -1) - KVM Cons

File Vlew Macros Tools Wirtual Media Help
% Shutdown Se Create Image
Ky Cansole MI v~ Activate Virtual Devices
Map CD/DVD
Map Removable Disk
Map Floppy

|| 10.29.160.89 || admin || 0.8 fos || 0.002 ke/s | (S|

(@ Connected to IP: 10.29.160.89 System T

8. Browse to the Red Hat Enterprise Linux Server 6.5 installer ISO image file.
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~

Note  The Red Hat Enterprise Linux 6.5 DVD is assumed to be on the client machine.

9. Click Open to add the image to the list of virtual media.

Figure 101 Browse to Red Hat Enterprise Linux ISO Image

Lock in: | 150 ~ |-

(¢ ES)i-5.1.0-799733-custom-Cisco-2.1.0.30s0
(+ ESXi-5.5.0-1746018-Custom-Cisco-5.5.1.3.i50
@ rhel-s 5,5-%86_64 o
(¢ rhel-server-7.0-x86_6d-dvd.iso
¢ ucs-c3160-huu-2.0.145.0s50

File narme: Ithel-server-6.5-x86_64-dvd.iso [ Open
Files of type:  Disk iso file (*.iso) *

10. In the KVM window, select the KVM tab to monitor during boot.

11. In the KVM window, select the Macros > Static Macros > Ctrl-Alt-Del button in the upper left
corner.

12. Click OK.
13. Click OK to reboot the system.

14. On reboot, the machine detects the presence of the Red Hat Enterprise Linux Server 6.5 install
media.

15. Select the Install or Upgrade an Existing System
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Figure 102 RHEL Installation

Welcome to Red Hat Enterprise Linux 6.5!

[nstall or upgrade an existing systenm
Install system with basic video driver
Rescue installed system

Boot from local drive

Memory test

Press [Tabl to edit options

RED HAT
ENTERPRISE LINUX" 6

Copyright © 2003-2010 Red Hat, Inc. and others. All rights reserved.

16. Skip the Media test and start the installation.
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Figure 103 RHEL Installation: Media Test

Welcome to Red Hat Enterprise Linux for x86_64

{ Disc Found |

To begin testing the media before
installation press OK.

Choose Skip to skip the media test
and start the installation.

Tab> between elements i <Space> selects i <F1lZ)> next screen

17. Click Next
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Figure 104 RHEL Installation: Installation Wizard

RED HAT

ENTERPRISE LINUX' 6

Copyright @ 2003-2010 Red Hal, Inc. and others, ANl Aghts resened,

18. Select language of installation, and then Click Next
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RHEL Installation: Language Selection

What language would you like to use during the
installation process?

| Arabic (au )

| Assamese (w7
| Bengali (Fre=m)

| Bengali(India) (a2=1 (@195 )

| Bulgarian (Bbnrapcku)

| Catalan (Catala)

| Chinese(Simplified) (H% (f&4) )
| Chinese(Traditional) (d37 (ER2) )
| Croatian (Hrvatski)

| Czech (Cestina)

| Danish (Dansk)

| Dutch (Nederlands)

English (English)

| Estonian (eesti keel)
| Finnish (suomi)

| French (Francais)

| German (Deutsch)

| Greek (EAANVLKG)

| Gujarati (p2idl)

| Hebrew (nay)

| Hindi (&=

| Hungarian (Magyar)
| Icelandic (Icelandic)
| lioko (lloko)

| Indonesian (Indonesia)

Lanoiz YO T3 A

3]

(<]

‘ 4 Back ‘ [ »Next]

Cisco UCS Integrated Infrastructure for Big Data with Hortonworks Data Platform g



W Installing Red Hat Enterprise Linux 6.5 using software RAID on C240 M4 Systems

Figure 106 RHEL Installation: Language Selection

Select the appropriate keyboard for
the system.

R

" [Ttalian
Italian (IBM)
italian (it2)
Japanese
Korean
Latin American
Macedonian
Norwegian
Polish
Portuguese
Romanian
Russian
Serbian
Serbian (latin)
Slovak (gqwerty)
Slovenian
Spanish
Swedish
Swiss French
Swiss French (latinl)
Swiss German
Swiss German (latinl)
Turkish

U.S. International
Ukrainian
United Kingdom

12]

U.s. English

I m Back I [ *Next]

19. Select Basic Storage Devices and Click Next
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Figure 107 RHEL Installation: Installation Type

What%vpe of devices will your installation involve?

Basic Storage Devices
® |nstalls or upgrades to typlcal types of storage devices. If you're not sure which option Is right for you,
this Is probably it

_ Specialized Storage Devices
! Installs or upgrades to enterprise devices such as Storage Area Networks (SANs). This option will allow
you to add FCoE J ISCS51 f zFCP disks and to filter out devices the installer should ignore.

| 4mBack ‘ ) Next |

& The storage device below may contain data.

ATA INTEL SSDSC2BB12
— 114473.460938 MB pci-0000:00:1f.2-5csi-4:0:0:0

We could not detect partitions or filesystems on this device.

protect the data.

Are you sure this device does not contain valuable data?

Storage Device Warning

This could be because the device is blank, unpartitioned, or virtual. If
not, there may be data on the device that can not be recovered if you use it
in this installation. We can remove the device from this installation to

| Apply my cheice to all devices with undetected partitions or filesystems

Yes, discard any data ‘ 7

No, keep any data

| 4 Back ‘ | ’Nexti

20. Provide hostname and configure Network for the host.
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Figure 108 RHEL Installation: Provide Host Name

— Please name this computer. The

~|5mm hostname identifies the computer on a
=

— == network.

Hostname: [rhei65

k ! Configure Network_

| 4| Back | | »Next‘

Figure 109 RHEL Installation: IPV4 Setting for eth0

Connection name: |etho |

Connect automatically
1 Available to all users

Wired | 802.1x Security | IPv4 Settings | IPy6 Settings |

Method: | Manual < |

Addresses
[ Address Netmask Gateway || Add |

| 2Da 200 2500 105297160

| Delete |

DNS servers: [ |

Search domains: | |

M Require IPv4 addressing for this connection to complete

| Routes... |

cancel || Apply.. |
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Figure 110 RHEL Installation: IPV4 Setting for ethl

Connection name: |ethl |

| Connect automatically
& Ava * 5

Wired | B02.1x Security | IPv4 Settings | IPv6 Settings

Method: | Manual o} |

Addresses
| Address Netmask Gateway | | Add |

[G92.168.11.165

DNS servers: | |

Search domains: | |

1 Require IPv4 addressing for this connection to complete

| Routes...

Cancel | |
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Figure 111 RHEL Installation: Selecting Location

Please select the nearest city in your time zone:

H

P

€| i,
Selected city: Los Angeles, America (Pacific Time)
America/Los Angeles

-
v

1 System clock uses UTC

i. 4aBack | | Bp Next |
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Figure 112 RHEL Installation: Enter Root Credentials
k The root account is used for administering
ﬁ the system. Enter a password for the root
user.
Root Password; [ssevsess |
Confirm: o |

|
| @uBack | | mpNext |

21. Choose Create custom layout for Installation type.
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Figure 113 RHEL Installation: Create Custom Layout

Which type of installation would you like?

Use All Space
* Removes all partitions on the selected device(s). This includes partitions created by other operating

. systems.

Tip: This option will remave data from the selected device(s). Make sure you have backups,

Replace Existing Linux System(s)
o Removes anly Linux partitions (created from a previous Linux installation). This does not remove other
J . partitions you may have on your storage device(s) (such as VFAT or FAT32)

Tip: This option will remove data from the selected device(s). Make sure you have backups.

] Shrink Current System
u Shrinks existing partitions to create free space for the default layout.

Use Free Space
. Retalns your current data and partitions and uses only the unpartitioned space on the selected device
{s), assuming you have enough free space available.

o Create Custom Layout
n' Manually create your own custom layout on the selected device(s) using our partitioning tool,

| qsack | | QNext‘

Following steps can be used to create two software RAID 1 partitions for boot and / (root) partitions.

22. Choose free volume and click on Create and choose RAID Partition.
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Figure 114 RHEL Installation: Create RAID Partition
Drive /dev/sdd (114473 MB) (Model: ATA INTEL SSD5C2BB12)
Free
114471 M8
: Size  Mount Point/
Devee (MB) RAIDolume YP€ Format
|= Hard Drives
< sdd
Free 114470
v sde
. ki Create Storage
ree
Create Partition
) Standard Partition
Create Software RAID Information
@ [RAID Partition!
Create LVM Information
) LVM Physical Volume
Cancel || Create
Create || Edit || Delete || Resst |

‘ fEBack ‘ ‘ B Next ‘

23. Choose “Software RAID” for File system Type and set size for Boot volume.
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Figure 115

RHEL Installation: Add Partition

Device K

v Hard Drives
- sdd
Free
v sde
Free

Drive /dev/sdd (114473 MB) (Model: ATA INTEL SSDSC2BB12)

Free
114471 MB

Size  Mount Point/

{MB) RAID/Volume "PE Format

114470 Add Partition
Mount Point: Not Applicable

114470

File System Type: | software RAID

O | Drive Size Model
W sdd 114473 MB

Allowable Drives: [ sde 114473 MB

ATA INTEL SSDSC2BB12
ATA INTEL SSDSC2BB12

Size (MB): E2 04g
Additional Size Options
@ Fixed size

C) Fill all space up to (MB):

O Fill to maximum allowable size
[ Force to be a primary partition
[ Encrypt

| cancel ||

OK

Create

el Reset |

| 4 Back | | B Next |

24. Similarly, do the RAID partitioning for the other free volume.

r Cisco UCS Integrated Infrastructure for Big Data with Hortonworks Data Platform




Installing Red Hat Enterprise Linux 6.5 using software RAID on C240 M4 Systems ||

(MB) RAID/Volume

Figure 116 RHEL Installation: Create RAID Partition
k
Drive /dev/sde (114473 MB) (Model: ATA INTEL SSDSC2BB12)
Free
114473 M8
i Bevice Size  Mount Point/ Type o i
{

- Hard Drives
v sdd
sddl
Free
- sde

112424

2048 software RAID

Create Storage

Create Partition
(" Standard Partition

Create Software RAID Information
@ [RAID Partition|
Create LVM Information

) LVM Physical Volume

Cancel || Create |

Create ] JEIElE Reset |

| 4Back | ‘ QNex‘c‘
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Figure 117 RHEL Installation: Add Partition

Drive /dev/sde (114473 MB) (Model: ATA INTEL SSDSC2BB12)

Free
k 114473 M8 ‘
> Size  Mount Point/
i (MB) RAIDVoume P Format

- Hard Drives

sdd1 2048 - ; .
Free 112424 Mhowt Pafnt; i : |

v sde File System Type: Isoftware RAID I |
Fiege 114473

T AT ——— I

[1 sdd  114473MB  ATA INTEL SSDSC2BB12
EULVELLReT-H 4 sde  114473MB  ATA INTEL S5DSC2BB12

Size (MB): (2049 3l
Additional Size Options )

(@ Fixed size ‘
 Fill all space up to (MB):
O Fill to maximun allowable size |

[J Force to be a primary partition
[ Encrypt

Cancel | 0K

Create dit || Delete Reset |

| 4uBack ‘ ‘ B Next ‘

25. Now similarly create RAID partitions for root (/) partition on both the devices and use rest of the
available space.
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Figure 118 RHEL Installation: Create RAID Partition
1*_ Drive /dev/sdd (114473 MB) (Model: ATA INTEL SSDSC2BB12)
l{Free
2112424 MB
: Size  Mount Point/ |
Device (MB) RAIDNolume ~ DPe  Format \
= Hard Drives
v sdd
sdd1 2048 software RAID
Fi 424
o s Create Storage
- sde .
3 ~ Create Partition
Boak 2058 s0ft ( standard Partition
Free 112424
Create Software RAID Information
@ [RAID Partition|
() RAID Device
Create LVM Information
' LVM Physical Volume
Cancel Create |
Create || Edit || Delete || Reset |
‘ € Back ‘ I mp Next |
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Figure 119 RHEL Installation: Add Partition

L3

Drive /dev/sdd (114473 MB) (Model: ATA INTEL SSD5C2BB12)

/{Free
112424 MB

Size  Mount Point/

o (MB) RAID/Volume

Type Format

|
= Hard Drives

v sdd
sddl 2048
112424

Add Partition

Mount Point: |

v sde File System Type: |software RAID ¢ |
sdel 2048 —
Free 112424 | || Drive | Size Model

¥ sdd  114473MB  ATAINTEL SSDSC2BB12
Allowable Drives: | [] sde 114473 MB  ATA INTEL SSDSC2BB12

Size (MB): |200 &l
-Additional Size Options
() Fixed size

C Fill all space up to (MB):

@ [Fill to maximum allowable size|
[ Force to be a primary partition
[l Encrypt

Cancel oK |

Create

|| De | Reset |

| 4@ Back ‘ ‘ ’Next‘
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Figure 120 RHEL Installation: Create RAID Partition
. k Drive /dev/sde (114473 MB) (Model: ATA INTEL SSDSC2BB12)
"‘ Free
2112424 MB
Device Size = Mount Point/ Type gt

= Hard Drives

- sdd
sddl
sdd2

v sde
sdel

(MB) RAID/Volume

2048 software RAID
112424 softw, §

Create Storage

Create Partition

2048 SoftWl  Srandard Partition

112424
Create Software RAID Information
(@ [RAID Partition
() RAID Device
Create LVM Information

) LVM Physical Volume

Cancel Create |

Create

Delet Reset |

| 4= Back | [ = Next ‘
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Figure 121 RHEL Installation: Add Partition
k Drive /dev/sde (114473 MB) (Model: ATA INTEL SSDSC2BB12)
s |
2112424 MB
Device Size  Mount Point/ Type e

(MB) RAID/Volume
{¥ Hard Drives

sdd1 2048 :
sdd2 112424 Mount Point:

v sde File System Type: | software RAID 3
sdel 2048 - .
Free 112424 ) Drive Size Model |

I [ sdd 114473 MB  ATA INTEL SSDSC2BB12 |

LUMUEL LG G sde 114473 MB ATA INTEL 55D5€28812

Size (MB): (200 &

Additional Size Options
O Fixed size ‘

O Fill all space up to (MB); 1 I

@® [Fill to maximum allowable size|

[] Force to be a primary partition
[ Encrypt
Cancel oK

Create

| Reset l

| Back | | W Next ‘

26. The above steps created 2 boot and 2 root (/) partitions. Following steps will RAID1 devices.
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Figure 122 RHEL Installation: Selected RAID Devices
k

Please Select A Device

Size  Mount Point/

e (MB) RAD/NVolume P Format
= Hard Drives
+ sdd
sddl 2048 software RAID
sdd2 112424 software RAID
- sde
sdel 2048 software RAID
sde2 112424 software RAID

Create | Reset

| m Back ‘ | B Next |

27. Choose one of the boot partitions and click on Create > RAID Device
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Figure 123 RHEL Installation: Create RAID Device
3 Drive /dev/sdd (114473 MB) (Model: ATA INTEL SSDSC2BB12)
Id/devisdd2
Hl 12424 MB
. D Size  Mount Point/ Type it i

(MB) RAID/Volume
= Hard Drives

= sdd |
sddl 2048
sdd2 112424 softw,
Create Storage
v sde :
Create Partition
sdel 2048 SOMW] ~ oo e it
sde2 112424 softw]
Create Software RAID Information
@ |RAID Device|
Create LVM Information
Cancel Create |
Create Edit | | Delete I Reset |

[ EBack | | m Next

28. Choose this as /boot (boot device) and in RAID members, choose all the boot partitions created

above in order to create a software RAID 1 for boot
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Figure 124 RHEL Installation: Make RAID Device
b
) Drive /dev/sdd (114473 MB) (Model: ATA INTEL SSDSC2BB12)
‘fildew‘sﬁdl
2112424 MB

Size  Mount Point/

(MB) RAID/Volume Type Format ‘

‘ Device
iv Hard Drives

|+ sdd
sddl 2048
sdd2 112424 3 »
v sde Make RAID Device

sdel 2048 Mount Point: Jboot v |

sde2 112424 f 1
File System Type: | extd <
RAID Device: | mdo 8

RAID Level: | RAIDL &}

¥ sdd1 2048 MB
RAID Members: | [] sdd2 112424 MB
‘ol sdel

1 rdad 112404 MDD

Number of spares:

[} Encrypt

cancel || ok |

Create |  Edit H Delete || Reset |

| mBack | l ’Next]

29. Similarly repeat for / partitions created above choosing both members with mount point as ““/”.
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Figure 125 RHEL Installation: Create RAID Device
Drive /dev/sdd (114473 MB) (Model: ATA INTEL SSDSC2BB12)
a‘1fd:\u’5dd2
2112424 MB
. Size | Mount Point/ ;
| Device (MB) | RAID/Volume dips fora |
| RAID Devices
mdo 2045 /boot extd v
i~ Hard Drives
= sdd
Create Storage
2048 mdo

sddl
sdd2

| Create Partition
112424 Sitleano

- sde
sdel 2048 mdo softj Create Software RAID Information
sde2 112424 soff]
® [RAID Device|
Create LVM Information
| cancel || create |
Create Edit H Delete || Reset |
| 4= Back | | ’Next‘
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Figure 126 RHEL Installation: Make RAID Device
k Drive /dev/sdd (114473 MB) (Model: ATA INTEL SSDSC2BB12)
’ ‘.fT‘dewsduz
2112424 MB
: ” Size | Mount Point/
| Device (MB) | RAID/Volume Type Format
= RAID Devices
mdo 2045 /boot extq v
i~ Hard Drives
- sdd
sdd1 2048 mdo Make RAID Device
sdd2 112424 Mount Point: [/ v |
e File System Type: | extd &
sdel 2048 mdo g et =
sde2 112424 RAID Device: | md1 ¢
RAID Level: | RAID 2|
¥ sdd2  112424M8 |
RAID Members: 112424 MB '
Number of spares: |
[T Encrypt
Cancel oK i
Create Edit || Delete | Reset |
‘ uBack | | B Next ‘
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Figure 127 RHEL Installation: Selected RAID Devices

Device

= RAID Devices

mdo 2045 /boot
mdl 112359
= Hard Drives
= sdd
sddl 2048 mdo
sdd2 112424 mdl
= sde
sdel 2048 mdo
sde2 112424 mdl

Size | Mount Point/
{MB) RAID/Volume

Please Select A Device

Type

extd
ext4

software RAID

software RAID

software RAID
software RAID

Format

SN

X XS

Create

Reset

‘ m Back | | »Next|

30. Click on Next.

r Cisco UCS Integrated Infrastructure for Big Data with Hortonworks Data Platform




Installing Red Hat Enterprise Linux 6.5 using software RAID on C240 M4 Systems ||

Figure 128 RHEL Installation: Partitioning Warning
k

Please Select A Device

Size | Mount Point/

Do (MB) | RAID/Volume

Type Format

= RAID Devices

mdo 2045 /boot ext4 v
mdl 112359 / extd v
= Hard Drives

- sdd Partitioning Warnings
% The partitioning scheme you requested generated the

sddl 2048 mdo i
following wamings.
sdd2 112424 mdl i = =
d \You have not specified a swap partition. Although not
¥ S strictly required in all cases, it will significantly improve
sdel 2048 mdo perfarmance for most installations.
sde2 112424 mdl

Would you like to continue with your requested partitioning
scheme?

No | Yes

Create | elete Reset |

| & Back | i B Next |

~
Note  Swap partition can be created using the similar steps, however, since these systems are high in memory,
this step is skipped (click Yes)

31. Click Next, and Format.
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Figure 129 RHEL Installation: Format Warning

k
Please Select A Device

Size | Mount Point/

Dlaies (MB) = RAID/Volume Type Bormat
= RAID Devices
md0 2045 /boot extd v
mdl 112359 / extd v

= Hard Drives

~ sdd Format Warnings
sddl 2048 mdo The following pre-existing devices have been selected to be
formatted, destroying all data.

sdd2 112424 mdl
= sde /devisdd partition table (M5DOS)
sdel 2048 mdo /dev/sde partition table (MSDQS)
sde2 112424 mdl
Cancel || Format

Create | Reset |

‘ 4m Back | ‘ W Next ‘

32. Select default settings and click Next.
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RHEL Installation: Install Boot Loader

k

1 Install boot loader on /dev/sdd. |Change device |

[J Use a boot loader password

Boot loader operating system list

Default Label Device
®  Red Hat Enterprise Linux /dev/mdl

| Add |
| Edit |

| Delete |

| 4aBack | |’»Nexrj

33. Continue with RHEL Installation as shown below.
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Figure 131 RHEL Installation: Keep the Default Installation

The default installation of Red Hat Enterprise Linux is a basic server install. You can
optionally select a different set of software now.

% Basic Server

) Database Server

O Web Server

7 Identity Management Server

3 Virtualization Host

) Desktop

*) Software Development Workstation
7 Minimal

Please select any additional repositories that you want to use for software installation.
[ High Availability

[] Load Balancer

¥ Red Hat Enterprise Linux

!
1=
N 'I

=k Add additional software repositories ‘ | 57 Modify repository

You can further customize the software selection now, or after install via the software
management application.

@ Customize later ) Customize now

4 Back W Next
| L

34. Once the installation is complete reboot the system.

Repeat the steps 1 through 34, to install Red Hat Enterprise Linux 6.5 on Servers 2 through 64.

Note  The OS installation and configuration of the nodes that is mentioned above can be automated through
PXE boot or third party tools.

The host-names and their corresponding IP addresses are shown in Table 7.

Table 7 Host-names and IP Addresses

Hostname eth0 ethl eth2

rhell 10.29.160.101 192.168.11.101 192.168.12.101
rhel2 10.29.160.102 192.168.11.102 192.168.12.102
rhel3 10.29.160.103 192.168.11.103 192.168.12.103
rhel4 10.29.160.104 192.168.11.104 192.168.12.104
rhel5 10.29.160.105 192.168.11.105 192.168.12.105
rhel6 10.29.160.106 192.168.11.106 192.168.12.106
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Table 7 Host-names and IP Addresses

Hostname eth0 ethl eth2

rhel7 10.29.160.107 192.168.11.107 192.168.12.107
rhel8 10.29.160.108 192.168.11.108 192.168.12.108
rhel9 10.29.160.109 192.168.11.109 192.168.12.109
rhell0 10.29.160.110 192.168.11.110 192.168.12.110
rhelll 10.29.160.111 192.168.11.111 192.168.12.111
rhell2 10.29.160.112 192.168.11.112 192.168.12.112
rhell3 10.29.160.113 192.168.11.113 192.168.12.113
rhell4 10.29.160.114 192.168.11.114 192.168.12.114
rhell5 10.29.160.115 192.168.11.115 192.168.12.115
rhell6 10.29.160.116 192.168.11.116 192.168.12.116
rhel64 10.29.160.164 192.168.11.164 192.168.12.164
rhel65 10.29.160.165 192.168.11.165 NA

rhel66 10.29.160.166 192.168.11.166 NA

rhel67 10.29.160.167 192.168.11.167 NA

rhel68 10.29.160.168 192.168.11.168 NA

Post OS Install Configuration

Choose one of the nodes of the cluster or a separate node as Admin Node for management such as HDP
installation, cluster parallel shell, creating a local Red Hat repo and others. In this document, we use
rhell for this purpose.

Setting Up Password-less Login

To manage all of the clusters nodes from the admin node we need to setup password-less login. It assists
in automating common tasks with cluster-shell (clush, a cluster wide parallel shell), and shell-scripts
without having to use passwords.

Once Red Hat Linux is installed across all the nodes in the cluster, follow these steps in order to enable
password-less login across all the nodes.

1. Login to the Admin Node (rhell)

ssh 10.29.160.101
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2. Run the ssh-keygen command to create both public and private keys on the admin node.

[rootEérhell ~]1# ssh-keygen
Generating public/private rsa key pair.
Enter file in which to save the key (/root/.ssh/id rsa):
Created directory
Enter passphrase {(empty for no passphrase):
Enter same passphrase again:
Your identification has been saved in froot/.ssh/id rsa.
Your public key has been saved in froot/.ssh/id rsa.pub.
he key fingerprint is:
ab:4e:78:10:54:81:4e:04:8d:af:4f:a4:b2:cd4:bb:88 rootérhell
he key's randomart image is:
-—-[ RSA 2048]-——-———+

=000 .

*/root/.ssh".

3. Then run the following command from the admin node to copy the public key id_rsa.pub to all the
nodes of the cluster. ssh-copy-id appends the keys to the remote-host’s .ssh/authorized key.

for IP in {101..168}; do echo -n "$IP -> "; ssh-copy-id -i ~/.ssh/id _rsa.pub
10.29.160.$IP; done
Enter yes for Are you sure you want to continue connecting (yes/no)?

Enter the password of the remote host.

Configuring /etc/hosts

Setup /etc/hosts on the Admin node and other nodes as follows; this is a pre-configuration to setup DNS
as shown in the further section.

Follow these steps to create the host file across all the nodes in the cluster:

1. Populate the host file with IP addresses and corresponding hostnames on the Admin node (rhell)
and other nodes as follows

On Admin Node (rhell)

vi /etc/hosts
127.0.0.1 local host localhost.localdomain localhost4 localhost4.localdomain4
::1 localhost

10.
10.
10.
10.
10.
10.
10.
10.
10.
10.
10.

29.
29.
29.
29.
29.
29.
29.
29.
29.
29.
29.

160.
160.
160.
160.
160.
160.
160.
160.
160.
160.
160.

101
102
103
104
105
106
107
108
109
110
111

localhost.localdomain localhosté localhosté6.localdomainé

rhell.mgmt
rhel2.mgmt
rhel3.mgmt
rhel4 .mgmt
rhel5.mgmt
rhel6.mgmt
rhel7.mgmt
rhel8.mgmt
rhel9.mgmt
rhell0.mgmt
rhelll.mgmt
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10.29.160.112 rhell2.mgmt
10.29.160.113 rhell3.mgmt
10.29.160.114 rhell4.mgmt
10.29.160.115 rhell5.mgmt
10.29.160.116 rhellé6.mgmt

10.29.160.168 rhelé68.mgmt

192.168.11.101 rhell
192.168.11.102 rhel2
192.168.11.103 rhel3
192.168.11.104 rhel4
192.168.11.105 rhel5
192.168.11.106 rhelé6
192.168.11.107 rhel?7
192.168.11.108 rhels
192.168.11.109 rhel9
192.168.11.110 rhello0
192.168.11.111 rhelll
192.168.11.112 rhell2
192.168.11.113 rhell3
192.168.11.114 rhell4
192.168.11.115 rhells
192.168.11.116 rhelle

192.168.11.168 rhel68

Setup ClusterShell

ClusterShell (or clush) is cluster wide shell to run commands on several hosts in parallel.

From the system connected to the Internet download Cluster shell (clush) and install it on rhell. Cluster
shell is available from EPEL (Extra Packages for Enterprise Linux) repository.

wget http://dl.fedoraproject.org/pub/epel//6/x86 64/clustershell-1.6-1.el6.noarch.rpm
scp clustershell-1.6-1.el6.noarch.rpm rhell:/root/
Login to rhell and install cluster shell

yum -y install clustershell-1.6-1.el6.noarch.rpm

Edit /etc/clustershell/groups file to include host-names for all the nodes of the cluster.
These set of hosts are taken when running clush with ‘-a’ option
For 68 node cluster as in our CVD, set groups file as follows,

vi /etc/clustershell/groups
all: rhel[1-68]

[rootérhell ~]# vi /etc/clustershell/groups

[root@rhell ~]# cat /etc/clustershell/groups
all: rhel[1-68]

S

1@ For more information and documentation on ClusterShell, visit
https://github.com/cea-hpc/clustershell/wiki/UserAndProgrammingGuide
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~

Note  Clustershell will not work if not ssh to the machine earlier (as it requires to be in known_hosts file), for

instance, as in the case below.

can't be

1-

[root@rhell ~]# ssh rhelS5.mgmt

The authenticity of host 'rhel5.mgmt (10.29.160.105)' can't be established.
RSA key fingerprint is 7a:98:75:9a:6a:1a:80:a4:97:43:6c:8a:12:57:db:74.

Are you sure you want to continue connecting (yes/no)? I

Creating Red Hat Enterprise Linux (RHEL) 6.5 Local Repo

To create a repository using RHEL DVD or ISO on the admin node (in this deployment rhell is used for
this purpose), create a directory with all the required RPMs, run the createrepo command and then

publish the resulting repository.

1. Log on to rhell. Create a directory that would contain the repository.

mkdir -p /var/www/html/rhelrepo
2. Copy the contents of the Red Hat DVD to /var/www/html/rhelrepo directory.

3. Alternatively, if you have access to a Red Hat ISO Image, Copy the ISO file to rhell.

scp rhel-server-6.5-x86_64-dvd.iso rhell:/root/
Here we assume you have the Red Hat ISO file located in your present working directory.

mkdir -p /mnt/rheliso
mount -t 1s09660 -o loop /root/rhel-server-6.5-x86 64-dvd.iso /mnt/rheliso/
4. Next, copy the contents of the ISO to the /var/www/html/rhelrepo directory

cp -r /mnt/rheliso/* /var/www/html/rhelrepo

[rootirhell ~|# mkdir -p /var/www/html/rhelrepo
[rootirhell ~]# mkdir -p /mnt/rheliso
[rootirhell ~]#

[rootérhell ~|# mount -t 1509660 -0 loop /root/rhel-server-6.5-x86 64-dvd.iso /mnt/rheliso/
[rootirhell ~|# cp -r /mnt/rheliso/* /var/www/html/rhelrepo/

5. Now on rhell create a.repo file to enable the use of the yum command.

vi /var/www/html/rhelrepo/rheliso.repo
[rhel6 .5]

name=Red Hat Enterprise Linux 6.5
baseurl=http://10.29.160.101/rhelrepo
gpgcheck=0

enabled=1

6. Now copy rheliso.repo file from /var/www/html/rhelrepo to /etc/yum.repos.d on rhell

cp /var/www/html/rhelrepo/rheliso.repo /etc/yum.repos.d/
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~

Note  Based on this repo file yum requires httpd to be running on rhell for other nodes to access the repository.

7. Copy the rheliso.repo to all the nodes of the cluster.

clush -a -b -c¢ /etc/yum.repos.d/rheliso.repo --dest=/etc/yum.repos.d/

[rootlrhell ~]# clush -a -b -¢ /etc/yum.repos.d/rheliso.repo --dest=/ete/yum.repos.d/

8. To make use of repository files on rhell without httpd, edit the baseurl of repo file
/etc/yum.repos.d/rheliso.repo to point repository location in the file system.

)
Note  This step is needed to install software on Admin Node (rhell) using the repo (such as httpd, createrepo,
etc).

vi /etc/yum.repos.d/rheliso.repo
[rhel6 .5]

name=Red Hat Enterprise Linux 6.5
baseurl=file:///var/www/html/rhelrepo
gpgcheck=0

enabled=1

9. Creating the Red Hat Repository Database.

Install the createrepo package on admin node (rhell). Use it to regenerate the repository database(s) for
the local copy of the RHEL DVD contents.

yum -y install createrepo

[rootfrhell ~]# yum -y install createrepo

Loaded plugins: product-id, refresh-packagekit, security, subscription-manager

This system is not registered to Red Hat Subscription Management. You can use subscription-manager to register.

rhel6.5 | 3.9 kB 00:00
rhel6.5/primary db | 3.1 MB VHI
Setting up Install Process

Resolving Dependencies

--> Running transaction check

---> Package createrepo.noarch 0:0.9.9-18.e16 will be installed

--> Processing Dependency: python-deltarpm for package: createrepo-0.9.9-18.el6.noarch

--> Running transaction check

---> Package python-deltarpm.x86 64 0:3.5-0.5.20090913git.el6 will be installed

--> Processing Dependency: deltarpm = 3.5-0.5.20090913git.el6 for package: python-deltarpm-3.5-0.5.20090913git.el6.x86 64
--> Running transaction check

10. Run createrepo on the RHEL repository to create the repo database on admin node

cd /var/www/html/rhelrepo
createrepo .
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[rootl@rhell rhelrepo]# createrepo
Spawning worker 0 with 3763 pkgs
Workers Finished

Gathering worker results

Saving Primary metadata
Saving file lists metadata
Saving other metadata
Generating sglite DBs
Sglite DBs complete

11. Finally, purge the yum caches after httpd is installed (steps in section “Install Httpd”).

Configuring DNS

This section details setting up DNS using dnsmasq as an example based on the /etc/hosts configuration
setup in the earlier section.

Follow these steps to create the host file across all the nodes in the cluster:
1. Disable Network manager on all nodes

clush -a -b service NetworkManager stop

clush -a -b chkconfig NetworkManager off
2. Update /etc/resolv.conf file to point to Admin Node

vi /etc/resolv.conf
nameserver 192.168.11.101

~

Note  This step is needed if setting up dnsmasq on Admin node. Else this file should be updated with
the correct nameserver.

3. Install and Start dnsmasq on Admin node

yum -y install dnsmasqg
service dnsmasqg start
chkconfig dnsmasg on

4. Deploy /etc/resolv.conf from the admin node (rhell) to all the nodes via the following clush
command:

clush -a -B -c¢ /etc/resolv.conf

~

Note A clush copy without - —dest copies to the same directory location as the source-file directory.

5. Ensure DNS is working fine by running the following command on Admin node and any datanode

[root@erhel2 ~]# nslookup rhell
Server:192.168.11.101
Address:192.168.11.101#53

Name: rhell
Address: 192.168.11.101 e

[root@rhel2 ~]# nslookup rhell.mgmt
Server: 192.168.11.101
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Address: 192.168.11.101#53

Name: rhell.mgmt
Address: 10.29.160.101 e

[root@rhel2 ~]# nslookup 10.29.160.101
Server: 192.168.11.101
Address: 192.168.11.101#53

101.160.29.10.in-addr.arpa name = rhell.mgmt. e

Installing httpd

Setting up RHEL repo on the admin node requires httpd. This section describes the process of setting up
one

1. Install httpd on the admin node to host repositories.

The Red Hat repository is hosted using HTTP on the admin node, this machine is accessible by all
the hosts in the cluster.
yum -y install httpd

2. Add ServerName and make the necessary changes to the server configuration file.

vi /etc/httpd/conf/httpd.conf
ServerName 10.29.160.101:80

[rootlrhaell ~]§# vi _/etc/httpd/;::onf/httpd.c:onf
[rootlrhell ~]§# cat /etc/httpd/conf/httpd.conf | grep ServerName
# ServerName gives the name and port that the server uses to identify itself.

#ServerName www.example.com:80
ServerName 10.29.160.101:80

# ServerName directive.

# ServerName dummy-host.example.com

3. Start httpd

service httpd start
chkconfig httpd on
4. Purge the yum caches after httpd is installed (step followed from section Setup Red Hat Repo)

clush -a -B yum clean all
clush -a -B yum repolist

[rootérhell ~]# clush -a -B yum clean all

Loaded plugins: product-id, refresh-packagekit, security, subscription-manager

This system is not registered to Red Hat Subscription Management. You can use subscription-manager to register.
Cleaning repos: rhel6.5
Cleaning up Everything

Note  While suggested configuration is to disable SELinux as shown below, if for any reason SELinux needs
to be enabled on the cluster, then ensure to run the following to make sure that the httpd is able to read
the Yum repofiles chcon -R -t httpd sys content t /var/www/html/
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Upgrading Cisco Network driver for VIC1227

The latest Cisco Network driver is required for performance and updates. The latest drivers can be
downloaded from the link below:

https://software.cisco.com/download/release.html?mdfid=283862063 & flowid=25886&softwareid=283
853158&release=1.5.7d&relind=AVAILABLE&rellifecycle=&reltype=latest

In the ISO image, the required driver kmod-enic-2.1.1.66-rhel6us.el6.x86_64.rpm can be located at
\Linux\Network\Cisco\12x5x\RHEL\RHEL6.5

From a node connected to the Internet, download, extract and transfer
kmod-enic-2.1.1.66-rheléu5.el6.x86_64.rpm to rhell (admin node).

Install the rpm on all nodes of the cluster using the following clush commands. For this example the rpm
is assumed to be in present working directory of rhell.

[root@rhell ~]# clush -a -b -c kmod-enic-2.1.1.66-rhel6u5.el6.x86_ 64.rpm

[root@rhell ~]# clush -a -b "rpm -ivh kmod-enic-2.1.1.66-rheléu5.el6.x86_64.rpm "
Ensure that the above installed version of kmod-enic driver is being used on all nodes by running the
command “modinfo enic” on all nodes

[rooterhell ~]# clush -a -B "modinfo enic | head -5"

flib/modules/2.6.32-431.el6. x86_64fextra,o‘enic/enic .ko
2.1.1.66

GPL v2

Scott Feldman <scofeldmfcisco.cont
Cisco VIC Ethernet NIC Driver

Installing xfsprogs

From the admin node rhell run the command below to Install xfsprogs on all the nodes for xfs
filesystem.

clush -a -B yum -y install xfsprogs

[rootlrhell ~]# clush -a -B yum -y install xfsprogsl
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Loaded plugins: product-id, refresh-packagekit, security, subscription-manager
Setting up Install Process

Resclving Dependencies

——> Running transaction check

---> Package xfsprogs.x86 64 0:3.1.1-14.el6 will be installed

—-> Finished Dependency Resclution

Dependencies Resolved

Installing:
xfsprogs 3.1.1-14.el6

Transaction Summary

1 Package(s)

Total downleoad size: 724 k

Installad size: 3.2 M

Downloading Packages:

Running rpm check debug

Running Transaction Test

Transaction Test Succeeded

Running Transaction
Installing : xfsprogs-3.1.1-14.e16.x86_64
Verifying : xfsprogs-3.1.1-14.e16.x86_64

Installed:
xfsprogs.x86 64 0:3.1.1-14.e16

Completea!

Setting up JAVA

HDP 2.2 requires JAVA 7, download jdk-7u75-linux-x64.rpm from oracle.com
(http://www.oracle.com/technetwork/java/javase/downloads/jdk7-downloads-1880260.html) to admin
node (rhell).

Create the following files java-set-alternatives.sh and java-home.sh on admin node (rhell)

vi java-set-alternatives.sh

#!/bin/bash

for item in java javac javaws jar jps javah javap jcontrol jconsole jdb; do
rm -f /var/lib/alternatives/$item

alternatives --install /usr/bin/$item $item /usr/java/jdkl.7.0_75/bin/$item 9
alternatives --set $item /usr/java/jdkl.7.0_75/bin/sitem
done

vi java-home.sh

export JAVA HOME=/usr/java/jdkl.7.0_75
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Run the following commands on admin node (rhell) to install and setup java on all nodes

1.

Copying JDK rpm to all nodes

clush -b -a -c¢ /root/jdk-7u75-1linux-x64.rpm --dest=/root/
Make the two java scripts created above executable

chmod 755 ./java-set-alternatives.sh ./java-home.sh
Copying java-set-alternatives.sh to all nodes

clush -b -a -c¢ ./java-set-alternatives.sh --dest=/root/
Extract and Install JDK on all nodes

clush -a -b rpm -ivh /root/jdk-7u75-linux-x64.rpm
Setup Java Alternatives

clush -b -a ./java-set-alternatives.sh
Ensure correct java is setup on all nodes (should point to newly installed java path)

clush -b -a "alternatives --display java | head -2"

Setup JAVA_ HOME on all nodes

clush -b -a -c¢ ./java-home.sh --dest=/etc/profile.d
Display JAVA_ HOME on all nodes

clush -a -b "echo \$JAVA HOME"
Display current java -version

clush -B -a java -version

NTP Configuration

The Network Time Protocol (NTP) is used to synchronize the time of all the nodes within the cluster.
The Network Time Protocol daemon (ntpd) sets and maintains the system time of day in synchronism
with the timeserver located in the admin node (rhell). Configuring NTP is critical for any Hadoop
Cluster. If server clocks in the cluster drift out of sync, serious problems will occur with HBase and other
services.

© Installing an internal NTP server keeps your cluster synchronized even when an outside NTP
serveris inaccessible.

Configure /etc/ntp.conf on the admin node with the following contents:

vi /etc/ntp.conf

driftfile /var/lib/ntp/drift
restrict 127.0.0.1

restrict -6 ::1

server 127.127.1.0

fudge 127.127.1.0 stratum 10
includefile /etc/ntp/crypto/pw
keys /etc/ntp/keys

Create /root/ntp.conf on the admin node and copy it to all nodes

vi /root/ntp.conf

server 10.29.160.101

driftfile /var/lib/ntp/drift
restrict 127.0.0.1

restrict -6 ::1

includefile /etc/ntp/crypto/pw
keys /etc/ntp/keys

Copy ntp.contf file from the admin node to /etc of all the nodes by executing the following command
in the admin node (rhell)
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for SERVER in {102..168}; do scp /root/ntp.conf
10.29.160.3SERVER: /etc/ntp.conf; done

[rootl@rhell ~]# for SERVER in {102..168}; do scp /root/ntp.conf 10.29.160.5SERVER: /etc/ntp.conf;

ntp
ntp
ntp

ntp
ntp

ntp
ntp

ntp
ntp.

ntp

ntp
ntp
ntp

.conf
.conf
.conf
ntp.
.conf
ntp.
.conf
.conf
.conf
.conf

conf

conf

conf

.conf
ntp.
.conf
.conf
.conf

conf

100% 136
136
136
136
136
136
136
136
136
136
136
136
136
136
136
136

O 0 0O 0000000000000

Instead of the above for loop, this could be run as a clush command with “—w” option.

clush -w rhel[2-68] -b -c /root/ntp.conf --dest=/etc
Do not use clush -a -b -c /root/ntp.conf --dest=/etc command as it overwrites /etc/ntp.conf on
the admin node.

Run thef following to syncronize the time and restart NTP daemon on all nodes

clush -a -B "yum install -y ntpdate"

clush -a -b "service ntpd stop"

clush -a -b "ntpdate rhell™"

clush -a -b "service ntpd start"
Ensure restart of NTP daemon across reboots

clush -a -b "chkconfig ntpd on"

Enabling Syslog

Syslog must be enabled on each node to preserve logs regarding killed processes or failed jobs. Modern
versions such as syslog-ng and rsyslog are possible, making it more difficult to be sure that a syslog
daemon is present. One of the following commands should suffice to confirm that the service is properly
configured:

clush -B -a rsyslogd -v
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[rootlrhell ~]# clush -B -a rsyslogd -v

rsyslogd 5.8.10, compiled with:
FEATURE REGEXP:
FEATURE LARGEFILE:
GSSAPI Kerberos 5 support:
FEATURE DEBUG (debug build, slow code):
32bit Atomic operations supported:
64bit Atomic operations supported:
Runtime Instrumentation (slow code):

See http://www.rsyslog.com for more information.

clush -B -a service rsyslog status

Setting ulimit

On each node, ulimit -n specifies the number of inodes that can be opened simultaneously. With the
default value of 1024, the system appears to be out of disk space and shows no inodes available. This
value should be set to 64000 on every node.

Higher values are unlikely to result in an appreciable performance gain.

For setting ulimit on Redhat, edit /etc/security/limits.conf on admin node rhell and add the
following lines:

root soft nofile 64000
root hard nofile 64000

[rootlrhell ~]# cat /ete/security/limits.conf | grep 64000
root soft nofile 64000
root hard nofile 64000

Copy the /etc/security/limits.conf file from admin node (rhell) to all the nodes using the following
command.

clush -a -b -c /etc/security/limits.conf --dest=/etc/security/

[rootirhell ~]# clush -a -b -¢ /ete/security/limits.conf —--dest=/etc/security/

Verify the ulimit setting with the following steps:

N

Note  Ulimit values are applied on a new shell, running the command on a node on an earlier instance of a shell
will show old values

Run the following command at a command line. The command should report 64000.

clush -B -a ulimit -n
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Disabling SELinux

SELinux must be disabled during the install procedure and cluster setup. SELinux can be enabled after
installation and while the cluster is running.

SELinux can be disabled by editing /etc/selinux/config and changing the SELINUX line to
SELINUX=disabled. The following command will disable SELINUX on all nodes.

clush -a -b "sed -i 's/SELINUX=enforcing/SELINUX=disabled/g' /etc/selinux/config "
clush -a -b "setenforce 0"

[root@rhell ~]# clush -a -b "sed -i 's/SELINUX=enforcing/SELINUX=disabled/q' /etc/selinux/config "

A

Note  The above command may fail if SELinux is already disabled.

Set TCP Retries

Adjusting the tcp_retries parameter for the system network enables faster detection of failed nodes.
Given the advanced networking features of UCS, this is a safe and recommended change (failures
observed at the operating system layer are most likely serious rather than transitory). On each node, set
the number of TCP retries to 5 can help detect unreachable nodes with less latency.

1. Edit the file /etc/sysctl.conf and on admin node rhell and add the following lines:

net.ipvé4.tcp retries2=5
Copy the /etc/sysctl.conf file from admin node (rhell) to all the nodes using the following command.

clush -a -b -c /etc/sysctl.conf --dest=/etc/
2. Load the settings from default sysctl file /ete/sysctl.conf by running the below command.

clush -B -a sysctl -p

Disabling the Linux Firewall

The default Linux firewall settings are far too restrictive for any Hadoop deployment. Since the UCS
Big Data deployment will be in its own isolated network, there’s no need to leave the IP tables service
running.

clush -a -b "service iptables stop"
clush -a -b "chkconfig iptables off"

[root@rhell ~]# clush -a -b "service iptables stop”

[root@rhell ~]# clush -a -b "chkconfig iptables off"

Disable Swapping

In order to reduce Swapping, run the following on all nodes. Variable vm.swappiness defines how often
swap should be used. 0 is No Swapping, 60 is the default value.

clush -a -b " echo \'vm.swappiness=0\' >> /etc/sysctl.conf"

Load the settings from default sysctl file /etc/sysctl.conf

clush -a -b “sysctl -p”
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Disable Transparent Huge Pages

Disabling Transparent Huge Pages (THP) reduces elevated CPU usage caused by THP. From the admin
node, run the following commands

clush -a -b "echo never >

/sys/kernel/mm/redhat transparent hugepage/enabled"

clush -a -b "echo never >

/sys/kernel/mm/redhat_ transparent hugepage/defrag"
The above command needs to be run for every reboot, hence, copy this command to /etc/rc.local so they
are executed automatically for every reboot.

On Admin node, run the following commands

rm -f /root/thp disable
echo "echo never > /sys/kernel/mm/redhat_ transparent hugepage/enabled" >>
/root/thp disable
echo "echo never > /sys/kernel/mm/redhat transparent hugepage/defrag " >>
/root/thp disable

Copy file to each node

clush -a -b -c /root/thp disable
Append the content of file thp disable to /etc/rc.local

clush -a -b “cat /root/thp disable >> /etc/rc.local”

Install Openssl

Install Openssl and Openssl-devel version 1.0.1e-30 and above for RHELG6.5. This is a requirement for
HDP 2.2 on all nodes. If openssl is already installed (generally the case), use the following command to
upgrade openssl

clush -a -b -c¢ /root/openssl-*
clush -a -b rpm -Uvh openssl-1.0.le-*.rpm openssl-devel-1.0.le-*.rpm

[rootérhell ~]# rpm -Uvh openssl-1.0.1e-30.e16 6.5.x86 64.rpm openssl-devel-l.0.1e-30.e13;§.5.x86_§4.rpm
arning: openssl-1.0.1e-30.el6 6.5.x86 64.rpm: Header V3 RSA/SHAL Signature, key ID cl05b9de: WOREY

Preparing... FHEHHHE AR A R A R A A A AR R R R A AR AR R R [1004]
1:openssl SEHHEHHEHEHHR AR R R R [ 50%]
2:openssl-devel FHEHHEAR A AR AR R AR R A AR A AR AR R AR AR RRRR (1004

(RPMs are available at:
http://mirror.centos.org/centos/6/updates/x86_64/Packages/openssl-1.0.1e-30.el6_6.5.x86_64.rpm and

http://mirror.centos.org/centos/6/updates/x86_64/Packages/openssl-devel-1.0.1e-30.el6_6.5.x86_64.rp
m)

Note  This requires krb5-devel and zlib-devel as dependencies. If not installed, install it as follows on the
nodes throwing error “yum —y install krb5-devel zlib-devel”

Disable IPv6 Defaults

Disable IPv6 as the addresses used are IPv4.

clush -a -b “echo \'net.ipvé.conf.all.disable ipvé = 1\' >> /etc/sysctl.conf”
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clush -a -b “echo \'net.ipvé.conf.default.disable ipvé = 1\' >> /etc/sysctl.conf”
clush -a -b “echo \'net.ipvé6.conf.lo.disable ipvé = 1\' >> /etc/sysctl.conf”
Load the settings from default sysctl file /etc/sysctl.conf

clush -a -b “sysctl -p”

Configuring Data Drives on Name Node

This section describes steps to configure non-OS disk drives as RAID1 using StorCli command as
described below. All the drives are going to be part of a single RAID1 volume. This volume can be used
for Staging any client data to be loaded to HDFS. This volume won’t be used for HDFS data.

From the website download storcli:

http://www.Isi.com/downloads/Public/RAID%20Controllers/RAID%20Controllers%20Common%?20Fi
les/1.14.12_StorCLI.zip

Extract the zip file and copy storcli-1.14.12-1.noarch.rpm from the linux directory.

1. Download storcli and its dependencies and transfer to Admin node.

scp storcli-1.14.12-1.noarch.rpm rhell:/root/
2. Copy storcli rpm to all the nodes using the following commands:

clush -a -b -c¢ /root/storcli-1.14.12-1.noarch.rpm --dest=/root/
3. Run the below command to install storcli on all the nodes

clush -a -b rpm -ivh storcli-1.14.12-1.noarch.rpm
4. Run the below command to copy storcli64 to root directory.

cd /opt/MegaRAID/storcli/
cp storclié4 /root/

5. Copy storcli64 to all the nodes using the following commands:

clush -a -b -c¢ /root/storcli64 --dest=/root/
6. Run the following script as root user on NameNode and Secondary NameNode to create the virtual
drives.

vi /root/raidl.sh
./storcli6e4 -cfgldadd
r1[$1:1,%1:2,81:3,%$1:4,%$1:5,%1:6,31:7,%$1:8,%$1:9,%1:10,81:11,81:12,31:13,%1:14,%1:15,%1
:16,$1:17,$1:18,$1:19,%1:20,%1:21,$1:22,$1:23,51:24] wb ra nocachedbadbbu strpsz1024
-ao
The above script requires enclosure ID as a parameter. Run the following command to
get enclousure id.
./storclié4 pdlist -a0 | grep Enc | grep -v 252 | awk '{print $4}' | sort | unig -c |
awk '{print s$2}°
chmod 755 raidl.sh

Run MegaCli script as follows

./raidl.sh <EnclosurelID> obtained by running the command above

WB: Write back
RA: Read Ahead
NoCachedBadBBU: Do not write cache when the BBU is bad.
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Strpsz1024: Strip Size of 1024K

~

Note  The command above will not override any existing configuration. To clear and reconfigure existing
configurations refer to Embedded MegaRAID Software Users Guide available at www.Isi.com

Configuring Data Drives on Data Nodes

This section describes steps to configure non-OS disk drives as individual RAIDO volumes using StorCli
command as described below. These volumes are going to be used for HDFS Data.

Issue the following command from the admin node to create the virtual drives with individual RAID 0
configurations on all the datanodes.

clush -w rhel[3-64] -B ./storcli64 -cfgeachdskraid0 WB RA direct NoCachedBadBBU
strpsz1024 -a0

WB: Write back

RA: Read Ahead

NoCachedBadBBU: Do not write cache when the BBU is bad.
Strpsz1024: Strip Size of 1024K

Note  The command above will not override existing configurations. To clear and reconfigure existing
configurations refer to Embedded MegaRAID Software Users Guide available at www.Isi.com

Configuring Data Drives on Archival Nodes

This section describes steps to configure non-OS disk drives as 4 RAIDS volumes using StorCli
command as described below. These volumes are going to be used for HDFS Archival data.

1. Run the following script as root user on Archival Nodes to create the virtual drives.

vi /root/raid5.sh
./storcli6e4 /c0 add vd type=raid5 drives=$1:1-15 WB ra direct Strip=1024
./storcli64 /c0 add vd type=raid5 drives=$1:16-30 WB ra direct Strip=1024
./storcli6e4 /c0 add vd type=raid5 drives=$1:31-45 WB ra direct Strip=1024
./storcli6e4 /c0 add vd type=raid5 drives=$1:46-60 WB ra direct Strip=1024

— The above script requires enclosure ID as a parameter. Run the following command to get
enclousure id.

./storclie4 pdlist -a0 | grep Enc | grep -v 252 | awk '{print $4}' | sort | unig
-c | awk '{print s$2}'
chmod 755 raid5.sh

— Run MegaCli script as follows

./raid5.sh <EnclosurelID> obtained by running the command above
WB: Write back

RA: Read Ahead
Strpsz1024: Strip Size of 1024K
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Note  The command above will not override any existing configuration. To clear and reconfigure
existing configurations refer to Embedded MegaRAID Software Users Guide available at
www.lsi.com

Configuring the Filesystem for NameNodes, DataNodes and
Archival nodes

Note

The following script will format and mount the available volumes on each node whether it is namenode,
Data node or Archival node. OS boot partition is going to be skipped. All drives are going to be mounted
based on their UUID as /data/disk1, /data/disk2, and so on.

1. On the Admin node, create a file containing the following script.

To create partition tables and file systems on the local disks supplied to each of the nodes, run the
following script as the root user on each node.

The script assumes there are no partitions already existing on the data volumes. If there are partitions,
then they have to be deleted first before running this script. This process is documented in the “Note”
section at the end of the section

vi /root/driveconf.sh
#!/bin/bash
#Commented because the script intermittently fails on some occasions

[[ "-x" == "${1}" 1] && set -x && set -v && shift 1
count=1

for X in $(ls /dev/disk/by-id/scsi-*)

do

echo "$X considered"

D=${X##*/}

Y=${D:5}

if [[ -b ${X} && “/sbin/parted -s ${X} print quit|/bin/grep -c boot> -ne 0 ]]
then

echo "$X bootable - skipping."

continue

elif [[ ${Y} =~ SATA INTEL SSD* ]]

then

echo "$X bootable partition skipping"

else

echo "$X for formating"

/sbin/parted -s ${X} mklabel gpt quit -s

/sbin/parted -s ${X} mkpart 1 6144s 100% quit

#Identify drive mapping in /dev/sd*

drive="1s -1 ${X} | cut -4 " " -f11 | cut -4 "/" -£3°

drive map="/dev/$drive"

/sbin/mkfs.xfs -f -g -1 size=65536b,lazy-count=1,su=256k -d sunit=1024,swidth=6144 -r
extsize=256k -L ${drive}l ${drive map}1l

(( $? )) && continue

#Identify UUID

UUID="blkid ${drive map}l | cut -4 " " -£f3 | cut -d "=" -f2 | sed 's/"//g'"
echo "UUID of ${drive map}l = ${UUID}"

/bin/mkdir -p /data/disks${count}

(( $? )) && continue

/bin/mount -t xfs -o allocsize=128m,noatime,nobarrier,nodiratime -U ${UUID}
/data/disks${count}
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(( $? )) && continue

echo "UUID=${UUID} /data/disk${count} xfs allocsize=128m,noatime,nobarrier,nodiratime
0 0" >> /etc/fstab

((count++))

fi

done

2. Run the following command to copy driveconf.sh to all the nodes

chmod 755 /root/driveconf.sh
clush -a -B -c /root/driveconf.sh
3. Run the following command from the admin node to run the script across all data nodes

clush -a -B /root/driveconf.sh
4. Run the following from the admin node to list the partitions and mount points

clush -a -B df -h
clush -a -B mount
clush -a -B cat /etc/fstab

Note  In-case there is need to delete any partitions, it can be done so using the following. Run command
‘mount’ to identify which drive is mounted to which device /dev/sd<?> umount the drive for which
partition is to be deleted and run fdisk to delete as shown below.

Care to be taken not to delete OS partition as this will wipe out OS

mount
umount /data/diskl # <-- diskl shown as example
(echo d; echo w;) | sudo fdisk /dev/sd<?>

Cluster Verification

The section describes the steps to create the script cluster verification.sh that helps to verify CPU,
memory, NIC, storage adapter settings across the cluster on all nodes. This script also checks additional
prerequisites such as NTP status, SELinux status, ulimit settings, JAVA _HOME settings and JDK
version, IP address and hostname resolution, Linux version and firewall settings.

Create script cluster verification.sh as follows on the Admin node (rhell).

vi cluster_verification.sh
#!/bin/bash

shopt -s expand aliases

# Setting Color codes
green="'\e[0;32m'
red='\e[0;31m’

NC='\e[Om' # No Color

echo -e "${green} === Cisco UCS Integrated Infrastructure for Big Data \ Cluster
Verification === ${NC}"

echo nn

echo nn

echo -e "${green} ==== System Information ==== ${NC}"

echo nn

echo nn

echo -e "${green}System ${NC}"

clush -a -B " “which dmidecode™ |grep -A2 '“System Information'"
echo nn

echo nn

echo -e "${green}BIOS ${NC}"

clush -a -B " “which dmidecode™ | grep -A3 '"BIOS I'"

echo nn
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echo nn
echo -e "${green}Memory ${NC}"
clush -a -B "cat /proc/meminfo | grep -i “memt | unig"

echo ""

echo ""

echo -e "${green}Number of Dimms ${NC}"

clush -a -B "echo -n 'DIMM slots: '; “which dmidecode™ \grep -c \
"*[[:space:]]*Locator:'"

clush -a -B "echo -n 'DIMM count is: '; “which dmidecode™ | grep \ "Size"| grep -c
nMB N

clush -a -B " “which dmidecode™ | awk '/Memory Device$/,/”$/ {print}' |\ grep -e
"“Mem' -e Size: -e Speed: -e Part | sort -u | grep -v -e 'NO \ DIMM' -e 'No Module
Installed' -e Unknown"

echo "

echo ""

# probe for cpu info #

echo -e "${green}CPU ${NC}"

clush -a -B "grep '“model name' /proc/cpuinfo | sort -u"

echo ""

clush -a -B " which lscpu™ | grep -v -e op-mode -e “Vendor -e family -e\ Model: -e
Stepping: -e BogoMIPS -e Virtual -e “Byte -e '“NUMA node(s)'"

echo ""

echo "

# probe for nic info #

echo -e "${green}NIC ${NC}"

clush -a -B "“which ifconfig™ | egrep '("e|”p)' | awk '{print \$1}' | \ xargs -1
“which ethtool™ | grep -e “Settings -e Speed"

echo ""

clush -a -B "“which lspci> | grep -i ether"

echo ""

echo ""

# probe for disk info #

echo -e "${green}Storage ${NC}"

clush -a -B "echo 'Storage Controller: '; “which lspci® | grep -i -e \ raid -e storage
-e lsi"

echo nn

clush -a -B "dmesg | grep -i raid | grep -i scsi®

echo nn

clush -a -B "lsblk -id | awk '{print \$1,\$%4}'|sort | nl"
echo ""

echo ""

echo -e "${green} ================ Software ======================= ${NC}"
echo nn

echo nn

echo -e "${green}Linux Release ${NC}"

clush -a -B "cat /etc/*release | unig"

echo nn

echo nn

echo -e "${green}Linux Version ${NC}"

clush -a -B "uname -srvm | fmt"

echo nn

echo nn

echo -e "${green}Date ${NC}"

clush -a -B date

echo nn

echo nn

echo -e "${green}NTP Status ${NC}"

clush -a -B "ntpstat 2>&1 | head -1"

echo nn

echo nn

echo -e "${green}SELINUX ${NC}"

clush -a -B "echo -n 'SElinux status: '; grep “SELINUX= \ /etc/selinux/config 2>&1"
echo nn

echo nn
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echo -e "${green}IPTables ${NC}"

clush -a -B "“which chkconfig™ --list iptables 2>&1"

echo nn

clush -a -B " “which service® iptables status 2>&l | head -10"
echo ""

echo ""

echo -e "${green}Transparent Huge Pages S${NC}"

clush -a -B " cat /sys/kernel/mm/*transparent hugepage/enabled"

echo ""

echo ""

echo -e "${green}CPU Speeds${NC}"

clush -a -B "echo -n 'CPUspeed Service: '; “which service”~ cpuspeed \ status 2>&1"
clush -a -B "echo -n 'CPUspeed Service: '; “which chkconfig™ --list \ cpuspeed 2>&1"
echo "

echo ""

echo -e "${green}Java Version${NC}"

clush -a -B 'java -version 2>&l; echo JAVA HOME is ${JAVA HOME:-Not \ Defined!}"'
echo ""

echo ""

echo -e "${green}Hostname Lookup${NC}"

clush -a -B " ip addr show"

echo nn

echo nn

echo -e "${green}Open File Limit${NC}"

clush -a -B 'echo -n "Open file limit (should be >32K): "; ulimit -n'

Change permissions to executable

chmod 755 cluster verification.sh

Run the Cluster Verification tool from the admin node. This can be run before starting HDP 2.2 to
identify any discrepancies in Post OS Configuration between the servers or during troubleshooting of
any cluster / Hadoop issues.

./cluster verification.sh

Installing HDP 2.2

HDP is an enterprise grade, hardened Hadoop distribution. HDP combines Apache Hadoop and its
related projects into a single tested and certified package. HDP 2.2 includes more than a hundred new
features and closes thousands of issues across Apache Hadoop and its related projects with the testing
and quality expected from enterprise quality software. HDP 2.2 components are depicted in figure
below. The following sections go in detail on how to install HDP 2.2 on the cluster configured as shown
in the earlier sections.
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Figure 132 HDP Components
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* version numbers are targets and subject to change at time of general avallability in accordance with ASF release process

Pre-Requisites for HDP Installation

This section details the pre-requisites for HDP Installation such as setting up of HDP Repositories.

Hortonworks Repo

From a host connected to the Internet, download the Hortonworks repositories as shown below and
transfer it to the admin node.
mkdir -p /tmp/Hortonworks

cd /tmp/Hortonworks/
1. Download Hortonworks HDP Repo

wget http://public-repo-1.hortonworks.com/HDP/centos6/HDP-2.2.0.0-centos6-rpm.tar.gz

[root@Srv] Hortonworks]# wget http://public-repo-1.hortonworks.com/HDP/centos6/HDP-2.2.0.0-centos6-rpm.tar.gz
--2015-03-06 17:02:05-- http://public-repo-1.hortonworks.com/HDP/centos6/HDP-2.2.0.0-centos6-rpm.tar. gz
Resolving public-repo-1.hortonworks.com... 54.192.118.226, 54.230.118.137, 54.230.116.98, ...

Connecting to public-repo-1.hortonworks.com|54.192.118.226]:80... connscted.

HTTP request sent, awaiting respense... 200 OK

Length: 3260497490 ({3.0G) [application/x-tar]
Saving to: aHDP-2.2.0.0-centos6-rpm.tar.gza

] 252,892,909 11.2M/s

2. Download Hortonworks HDP-Utils Repo
wget
http://public-repo-1.hortonworks.com/HDP-UTILS-1.1.0.20/repos/centos6/HDP-UTILS-1.1.0.

20-centosé6.tar.gz
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[rootl8rvl Hortonworks]# wget http://public-repo-1.heortonworks.com/HDP-UTILS-1.1.0.20/repos/centoss/HDP-UTI
LS-1.1.0.20-centos6.tar.gz

--2015-03-06 17:04:09-- http://public-repo-1.hortonworks.com/HDP-UTILS-1.1.0.20/repos/centos6/HDP-UTILS-1.
1.0.20-centos6.tar.gz

Resolving public-repo-1.hortonworks.com... 54.230.119.106, 54.239.132.164, 54.239.132.162,

Connecting to public-repo-1.horteonworks.com|54.230.119.106]:80... connected.

HTTP request sent, awaiting respeonse... 200 OK
Length: 14076549 (13M) [application/x-tar]
Saving to: AHDP-UTILS-1.1.0.20-centos6.tar.gzé

] 11,981,127 3.05M/s eta ls

3. Download Ambari Repo

wget http://public-repo-1.hortonworks.com/ambari/centos6/ambari-1.7.0-centosé6.tar.gz

[rootiSrvl Hortonworksl# wget http://public-repeo-1.hortonworks.com/ambari/centos6/ambari-1.7.0-centos6.tar.
gz

--2015-03-06 17:05:23-- http://public-repo-1.hortonworks.com/ambari/centos6/ambari-1.7.0-centos6.tar.gz
Resolving pubklic-repo-1.hortonworks.com... 54.192.118.219, 54.192.118.224, 54.230.118.187,

Connecting to public-repo-1.hortonworks.com|54.192.118.219]:80... connected.

HTTP request sent, awaiting respeonse... 200 OK

Length: 103219329 (98M) [application/x-tar]

Saving to: aambari-1.7.0-centos6.tar.gza

[====> ] 9,123,154 2.18M/s eta 58s

4. Copy the repository directory to the admin node

scp -r /tmp/Hortonworks/ rhell:/var/www/html
5. Extract the files

login to rhell

cd /var/www/html/Hortonworks

tar -zxvf HDP-2.2.0.0-centosé6-rpm.tar.gz
tar -zxvf HDP-UTILS-1.1.0.20-centos6.tar.gz
tar -zxvf ambari-1.7.0-centosé6.tar.gz

6. Create the hdp.repo file with following contents

vi /etc/yum.repos.d/hdp.repo

[HDP-2.2.0.0]

name=Hortonworks Data Platform Version - HDP-2.2.0.0
baseurl=http://rhell/Hortonworks/HDP/centos6/2.x/GA/2.2.0.0
gpgcheck=0

enabled=1

priority=1

[HDP-UTILS-1.1.0.20]

name=Hortonworks Data Platform Utils Version - HDP-UTILS-1.1.0.20
baseurl= http://rhell/Hortonworks/HDP-UTILS-1.1.0.20/repos/centosé
gpgcheck=0

enabled=1

priority=1
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[rootirhell ~]# vi /etc/yum.repos.d/hdp.repo

[rootirhell ~]# cat /ete/yum.repos.d/hdp.repo

[HDP-2.2.0.0]

name=Hortonworks Data Platform Version - HDP-2.2.0.0
baseurl=http://rhell/Hortonworks/HDP/centos6/2.%x/GA/2.2.0.0
gpgcheck=0

enabled=1

priority=1

[HDP-UTILS-1.1.0.20]
name=Hortonworks Data Platform Utils Version - HDP-UTILS-1.1.0.20
baseurl= http://rhell/Hortonworks/HDP-UTILS-1.1.0.20/repos/centosé

7. Create the Ambari repo file with following contents

vi /etc/yum.repos.d/ambari.repo

[Updates-ambari-1.7.0]

name=ambari-1.7.0 - Updates
baseurl=http://rhell/Hortonworks/ambari/centos6/1.x/updates/1.7.0

gpgcheck=0
enabled=1
priority=1

[rootlrhell ~]# vi /ete/yum.repos.d/ambari.repo
[rootirhell ~]# cat /etc/yum.repos.d/ambari.repo
[Updates-ambari-1.7.0]

name=ambari-1.7.0 - Updates

baseurl=http://rhell/Hortonworks/ambari/centos6/1.x/updates/1.7.0

1
=1

From the admin node copy the repo files to /etc/yum.repos.d/ of all the nodes of the cluster.

clush -a -b -c¢ /etc/yum.repos.d/hdp.repo --dest=/etc/yum.repos.d/
clush -a -b -c¢ /etc/yum.repos.d/ambari.repo --dest=/etc/yum.repos.d/

HDP Installation
Follow these steps to install HDP.

Install and Setup Ambari Server on rhell

yum -y install ambari-server
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[roctlrhell ~]# yum -y install ambari-server

Loaded plugins: product-id, refresh-packagekit, security, subscription-manager

This system is not registered to Red Hat Subscripticn Management. You can use subscription-manager to register.
Setting up Install Process

Resclving Dependencies

——> Running transacticn check

—-——> Package ambari-server.ncarch 0:1.7.0-169 will be installed

——> Finished Dependency Resclution

Dependencies Resolved

Version Repository

Installing
ambari-server Updates—ambari-1.7.0

Transaction Summary

Install 1 Package(s)

Total downlecad size: 96 M
Installed size: 123 M
Downlcading Packages:
ambari-server-1.7.0-169 .noarch.rpm
Running rpm check_debug
Running Transaction Test
Transaction Test Succeedsd
Running Transaction
Warning: RPMDB altered outside of yum.
Installing : ambari-server-1.7.0-169.nocarch [###d#H#EHEHE

Setup Ambari Server

ambari-server setup -j $JAVA HOME -s

[root@rhell ~1# ambari-server setup —-J $JAVA HOME -—=
Using python fusr/bin/pythonz .6
ambari-server

"disabled"
bari—-server daemon is configured to run under user "root'. Change this setting [y/n] (n) ?

Adjusting ambari-server permissions and ownership. ..

firewall. ..

JDK. . .

JAVA HOME /usr/java/jdkl.?.o_js must be wvalid on ALL hosts

JCE FPolicy files are required for configuring Kerberos security. If you plan to use Kerberos
urisdiction Policy Files are wvalid on all hosts.
Completing setup.. .
Configuring database.. .
[Enter advanced database configuration [¥/nl (n)?

IDefault properties detected. Using built-in database.
Checking PostgreSQL. ..

Running initdb: This may take upto a minute.
Initializing database: [ oK ]

About to start PostgresSglL
configuring local database...
Connecting to local database...done.
configuring PostgresSQL. ..

Restarting PostgresSqQL

Extracting system views...

. .ambari-admin-1.7.0.162.jar

Adjusting ambari-server permissions and ownership...
bari Server 'setup' completed successfully.

Start Ambari Server

ambari-server start
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Confirm Ambari Server Startup

ps -ef | grep ambari-server

[rootirhell ~]# ambari-server start
Using python /usr/bin/python2.6
Starting ambari-server
Ambari Server running with 'root' privileges.
Organizing resource files at /var/libfambari-server/resources...
Server PID at: /var/run/ambari-server/ambari-server.pid
Server out at: /var/log/ambari-server/ambari-server.out
Server log at: /var/log/ambari-server/ambari-server.log
aiting for server start
Ambari Server 'start' completed successfully.
[rootirhell ~]# ps -ef | grep ambari-server
root 6069 1 59 01:31 pts/0 00:00:15 /jusr/java/jdkl.7.0_75/binfjava -server -XX:iNewRatio=3
dLimit -XX:CMSInitiatingOccupancyFraction=60 -Xms512m -Xmx2048m -Djava.security.auth.login.config=/e
java.security.krb5.conf=/etc/krb5.conf -Djavax.security.auth.useSubjectCredsonly=false -cp /etc/amba
r{1ib64/qt-3.3/bin: /usr/local/sbin: fusr/local/bin: /sbin: /bin: {usr/sbin: fusr/bin:{root/bin:/sbin/:/us
ambari.server.controller.aAmbariServer

Log into Ambari Server

Once the Ambari service has been started, access the Ambari Install Wizard through the browser.

1. Point the browser to http://<IP address for rhel1>:8080

2. Login to the Ambari Server using the default username/password: admin/admin. This can be
changed at a later period of time.

Figure 133 Ambari Server Login

PN smbar

Sign in
Username
admin

Password

a

Once logged in the Welcome to Apache Ambari window appears.
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Figure 134 Apache Ambari

& Cjusters
Welcome to Apache Ambari

Mo clusters
Prowisian a cluster, manage who can access the cluster, and customize wiews for Ambar users.
£ Views
Create a Cluster

WiEWS Use the Install Wizard to select services and configure your cluster

Users Launch Insi

L User + Group Management

Groups

Manage Users + Groups Deploy Views

Manage the users and groups that can access Ambari Create view instances and grant permissions

2

Create a Cluster

Use the following steps to create a cluster.

1. Click Launch install wizard button.

2. At the Get started page type “Cisco HDP” as name for the cluster in the text box.
3. Click the Next button.
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Figure 135 Ambari Getting Started

Get Started

Select Stack This wizard will walk you through the cluster installation process. Let's start by naming your new cluster.

Install Options
Matne your cluster Learn more

Confirm Hosts
Giseo_HOP

Choose Services

Assigh Masters

Assign Slaves and Clients
Customize Services
Review

Install, Start and Test

Surmmary

Select Stack

In the following screen
e Select HDP 2.2 stack.
* Expand “Advanced Repository Options”. Under the advanced repository option.
— Select RedHat 6 checkbox.
— Uncheck rest of the checkbox.
— Update the Redhat 6 HDP-2.2 URL to http://rhell/Hortonworks/HDP/centos6/2.x/GA/2.2.0.0

— Update the Redhat 6 HDP-UTILS-1.1.0.20 URL to
http://rhell/Hortonworks/HDP-UTILS-1.1.0.20/repos/centos6
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Figure 136 Ambari Screen

CLUSTER INSTALL WIZARD

Select Stack

Please select the service stack that you want to use to install your Hadoop cluster

Get Started

Install Options

Stacks
Confirm Hosts

@ HDP 2.2
Choose Services © HDP 2.1
Assign Masters  HDP 20

© HOP 1.3
Assign Slaves and Clients
Customize Services -

Advanced Repository Options

Reviewy

Customize the repository Base URLs for downloading the Stack software packages. If your hosts do not
have access (o the internet, you will have to create a local mirror of the Stack repository that is accessible
by all hosts and use those Base URLS here

Install, Start and Test

summary

0s Name Base URL

1 redhatd HOR-2.2 http: #public-repo- 1 hortonworks . com/HDP/Centos 52 wGA2 . | @

HOP-UTILS- http:#public-repo-1 hortorworks comHOP-UTILS-1.1.0.20/re €
11020

[ redhats HOP-2.2 http:#rhel 1 /Hartarworks/HOP/Centass/2 wGEA2 2.0.0 @ Dundo
HOP-UTILS- hittp:#rhel AHoronworks/HDP-UTILS-1.1.0. 20/ epos/centoss (€@ Uncdo
11020

I susell HDP-2.2

Http: #4public-repo- 1 hortonwaorks com/HDP/sUSe 1 15pS/2 %G @

HDP Installation

In order to build up the cluster, the install wizard needs to know general information about how the
cluster has to be set up. This requires providing the Fully Qualified Domain Name (FQDN) of each of
the host. The wizard also needs to access the private key file that was created in Set Up Password-less
SSH. It uses these to locate all the hosts in the system and to access and interact with them securely.

1. Use the Target Hosts text box to enter the list of host names, one per line. One can also use ranges
inside brackets to indicate larger sets of hosts.

2. Select the option Provide your SSH Private Key in the Ambari cluster install wizard

a. Copy the contents of the file /root/.ssh/id_rsa on rhell and paste it in the text area provided by
the Ambari cluster install wizard.

a

Note  Make sure there is no extra white space after the text-----END RSA PRIVATE KEY-----
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[root@rhell ~]# cat froot/.ssh/id rsa
BEGIN RSA PRIVATE KEY
MIIEoQIBAAKCAQEAYDOIRbk4mBZrizcld /goM2i¥T2hdvxkIxa /wOVPEthFreudgT
Zehw/Qtdk7meeqghgqgsHmblCriF0mé SXvPEXW2 cGoAX75hZwTuDIR3IQ1vks o YUMDW
BRKgSTMEUMKED7tknkGkg5N+YHSPCoONILl z/WgecOlhZ ZoticmrxeRNP&S1.JY74 /Db
A0BewlMulNajAoVppPD6cLGFS / NKORPEDUNCuwe SpCRVEtko+gzBeBF5oeCS6¥as17
nS0Hpl IXVOMv23SNUwl3cswbgLdrr3atG6 YRieVrmmr /P1rKMpl 92t zQ1mH ZMBgG
1RJTIL]ygWOgpsg7NQBGeM7 sX4Ve6OmzvdvmzwI BIWKCAQEAGA+UEI+02Pj KVCLUX
2h+XEWMUXCJI3KoNEYBpr2nj 7KxckYas/8oLN6Bl1pYROUB3X2YZVe6 hBwuLI+JDMk
hrNMALgqwD] tHULlOyX/SHDImlDyTo9k8LwPY2qg8 zgqviHnJ+3.Jisi92Dspcell XRRXY
npofjAml COXWXpAMZYXo9HynCoeKkmheFefobLys6gloxd84eHWlysboxUldh7hsg
pcK+XpdFW]l sHYFbwvekTuCHUAezF44+uBTSFOPMiD7PwzrvbXKA65ABuezv9gg2 /Il
PekIkRvbosniFbBUi2Z081ul/gsaZgmSQo9gTarJ1VE zMy6K311LETcOckl 2L2ZHRX2
5 sEx6WKBgQDOCiKcOHFiul rQWWScLTDIJUBWZT iNKAMS1 Qb2 LohfFuZfluiAl 3Ref
iLOMIE3ABMNNOpoRXMMXKPF4t2iuLh34+3tCsrlTzPml4WT+Fipa®sh+3JZ22HKgm
CquAEdoFRK40P3 /yYQg95gie258C9 sB0z6 zVohdyNUvnkiMboviwi3wKBgQDRKiyTi
Yud21lowsYKEZ7Yjom]RKUFaH4CKEnyJylSH3wFPRNZJA4EBVaMgqODaTxr2tW4d si+4
t88MBXSO6FHGHYMSRELOtY ZM1mmw Ut jCLHZ0fgSegl HovekXxXL.0iUZzel8FPL3IZ0H
AeBRj0 /GLO3SF/PGWMokCwHtaJoV/ x1dBdI sgEQKBgEERPBMX8UVF3NZ9 ZYVgEMYQ
09Kt sUSEx52x0adlvpHt5TsSmolkvO6TEE+8cwdl1 £fZ2x5 j+vXwxh+bjozBj30 /Dwc
GEEbrObrkKscsbHLLIZ5+QgtwEPB4 hignUKvnVVHP1 QMJIA6 853 YxCdz7KH1 ypnqqg
KWQFKhW2QEIUivDKUuRlA0GASZr /EKIALUEFb5Gdbjondv3yYsGb7kY3DvNS1BhsSm
rk7ADAATNZzX5HZ3LOSgATOTWSH+PPEX+ZzTENINOMFMN Y1 YOEpy Js0S/1adLEOroiu
sC8J8bu/BRNWKE8 z+z9sb zwUrdbtxT2cY1 I8 L1 KQGEWyUPxoVoe /ccEENABLP872S
XnsCgYAFRE4SbB416p9miiR1+gNCiihMON+FmHMmeP /yv80QL/MoAYoHB1TnS cwvu
1+ =judbWEU ZvNGMWXWPEUS zVBrat+ysShh309IwjP /1 kpCHNW=z7CX+ /uI6FY+s1 ZXTr
t5P/AvhOvUKMhRF JXFQoYSsygNUkasvIu65S801lunl8N2IThEgwlg==

3. Click the Register and Confirm button to continue.

Installing HDP 2.2 W
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Figure 137 HDP Install Options

CLUSTER INSTALL WIZARD -
i g Install Options

Get Started

Select Stack Enter the list of hosts to be included in the cluster and provide your S5H key.

Target Hosts

Enter a list of hosts using the Fully Qualified Domain Mame (FQDM), one per line. Or use Fattern Expressions

rhel[1-68]

Host Registration Information

@ Provide your S5H Private Key to automatically register hosts

Browse | Mo file selected

IticfervoGppS+SKOuT o =1
/TDiheIJOpe3qo3 ZJ9fDS5Ls6cgSoVGIrXEESVHeTT
VAZW4cLGyOSSNNEFS3 GRbRTD1LEeb JwdELNOSS £,/ Im1VOcu E[

SSH user (root or passwordless sudo account) | root

€ Perform manual registration on hosts and do not use SSH

«— Back

Hostname Pattern Expressions

Figure 138 Hostname Pattern Expressions

Host name pattern expressions

rhelt
rhel2
rhels
rheld
rheld

rhelg

rhel?

rhel
rheld

thel1d

a1l
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Confirm Hosts

This screen allows to ensure that Ambari has located the correct hosts for the cluster and to check those
hosts to make sure they have the correct directories, packages, and processes to continue the install.

If any hosts were selected in error, it can be removed by selecting the appropriate checkboxes and
clicking the grey Remove Selected button. To remove a single host, click the small white Remove
button in the Action column.

When the lists of hosts are confirmed, click Next.

& admin ¥

CLUSTER INSTALL WIZARD

Confirm Hosts

Get Started

Select Stack Registering your hosts

Please confirm the host list and remove any hosts that you do not want to Include in the cluster
Install Options

Confirrn He

Show: b | Installing () | Reaglstering (0) | Success (s8) | Eail {0
hoose Servi &
[T Hest Progress Status Action fiml
Assign Wasters
o e [ T oo
r rheli2 _ Success B Remove
Review r rheld _ Success il Remove
o | e [ P —
surnmary
o | eis [ B e
o | rhels [ Pr— ~
o rher [ Pr—
o | ireia e oo
r rhel@ _ Success B Remove
- rheln [ e fIRemave &
Show| 25 =] % 3 H

Choose Services

HDP is made up of a number of components. See Understand the Basics for more information.
1. Select all to preselect all items.

2. When you have made your selections, click Next.
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Figure 139 Ambari Service Selection

& admin

ALL WIZARD =
Choose Services

Get Started

Select Stack Choose which services you want to install on your cluster.

Install Options

. Service all|none Yersion Description
Confirm Hosts

V¥ HDF5 2602200  Apache Hadoop Distributed File System
¥ YARN + MapReduce2 2602200  Apache Hadoop NextGen MapReduce (YARN)

W Tez 0522200  Tezisthe next generation Hadoop Query Processing framewark written
on top of YARK

¥ Nagios 350 Nagios Monitoring ancd Alerting system
¥ Ganglia 350 Ganglia Metrics Collection system (REDTool will be installed tog)
¥ Hive 0.14.0.22.00 Data warehouse system for ad-hoc gueries & analysis of large datasets

and table & storage management service

¥ HEase 09842200 Non-relational distributed database and centralized service for
configuration management & synchronization

W Pig 04402200 Scripting platform for analyzing large datasets

¥ Sgoop 1452200  Toolfor transferring bulk data between Apache Hadoop and structured
data stores such as relational databases

vV Oozie 4102200  Systern far workflow coordination and execution of Apache Hadoop jobs,
This also includes the installation of the optional Oozie Weh Console
which relies on and will install the ExtIS Librany

v ZDDKEEFIEI’ 3462200 Centralized service which pI’DV\UES highly reliable distributed coordination
¥ Falcan 0502200 Data management and processing platform
¥ Stam 0932200 Apache Hadoop Stream processing framewark
¥ Flume 1622200  Adistibuted service for collecting, aggreating, and moving large

amounts of streaming data into HOFS

¥ Kafka 0812200  Ahighthroughnut distriouted messaging system

¥ Ko 0502200  Provides a single paint of authentication and access for Apache Hadoap
semvices in 2 cluster

¥ Slider 06002200 Aframework for deploying, managing and moritoring existing distributed
applications on YARN,

~ Back
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The Ambari install wizard attempts to assign the master nodes for various services that have been
selected to appropriate hosts in the cluster. The right column shows the current service assignments by
host, with the hostname and its number of CPU cores and amount of RAM indicated.

1. Reconfigure the service assignment to match the table shown below:

Table 8 Reconfiguring the Service Assignment

Service Name Host
NameNode rhell
SNameNode rhel2
HistoryServer rhel2
ResouceManager rhel2
Nagios Server rhell
Ganglia Collector rhell
HiveServer2 rhel2
HBase Master rhel2
Oozie Server rhell
Zookeeper rhell, rhel2, rhel3
Kafka Broker rhell
Knox Gateway rhell
App Timeline Server rhel2
Hive Metastore rhel2
WebHCat Server rhel2
Falcon Server rhel2
DRPC Server rhel2
Nimbus rhel2
Storm UI Server rhel2

Cisco UCS Integrated Infrastructure for Big Data with Hortonworks Data Platform g



W Installing HDP 2.2

Figure 140

CLUSTER INSTALL WIZARD

Get Started

Select Stack

Ambari Assign Masters

Assign Masters

Assign master components to hosts you want to run them on

& admin

% HiveServer?, Hive Metastore and WebHCat Server will be hosted on the sarme host

Install Options

Confirm Hosts SMameMode

Choose Services

Mamekode

Assign Slavesand Clie Histary Server
Customize 5
Review App Timeline Server

irstall, Start and Test
ResourceManager

Surnimary Nagios Server:
Ganglia Server.
Hive Metastare

WebHCat Server
HiveSerser?
HEase Master:
Dozie Server
ZooKeeper Server
ZookKeeper server
ZooKeeper Server
Falcon Server
DRPC Server,
Mimbus

Storm Ul Server

Kafka Broker.

Ko Gateway,

+— Back

~

rhel2 (252.2 GB, 48 cores) j

rhell (252 2 GB, 48 cores)

B =

rhel2 (252.2 GB, 48 cores)

rhel2 (252 2 GB, 48 cores)

B |

rhel2 (252.2 GB, 48 cores)

=2

rhell (252 2 GB, 48 cores)

rhell (252.2 GB, 48 cores)

[

rhel2
rhel2 %
rhel? (252 2 BB, 48 cores) j
rhel2 (252.2 GB, 48 cores) j o

rhell (252.2 GB, 48 cores) j

e
e
Joe

rhel2 (252.2 GB, 48 cores)
rhels (252.2 GEB, 48 cores)
rhell (252.2 GEB, 48 cores)
rhel2 (252.2 GB, 48 cores) j
rhei2 (252.2 GB, 48 cores) j

rhel2 (252.2 GEB, 48 cores) j

| thel2 (252 2 GB, 48 tores) j

rhel (252.2 GB, 48 cores)

o

rhel! (262.2 GB, 48 cores) j [+ ]

rhell (252.2 GB, 48 cores)

Note

On a small cluster (<16 nodes), consolidate all master services to run on a single node. For large

clusters (> 64 nodes), deploy master services across 3 nodes.

2. Click the Next button.
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Assign Slaves and Clients

The Ambari install wizard attempts to assign the slave components (DataNodes, NodeManagers,
RegionServers, Supervisor and Flume) to appropriate hosts in the cluster. Reconfigure the service
assignment to match below:

1. Assign DataNode, NodeManager, RegionServer ,Supervisor and Flume on nodes rhel3- rhel68
2. Assign Client to all nodes
3. Click the Next button.

Table 9 Client Service Name

Client Service Name Host

DataNode rhel3 to rhel68
NodeManager rhel3 to rhel68
RegionServer rhel3 to rhel68

Client All nodes, rhell-rhel68
Supervisor rhel3-rhel68

Flume rhel3-rhel68

Archival Nodes rhel65 to rhel68

Figure 141 Ambari Slave and Client Assignment

Assign Slaves and Clients

Get Started

Select Stack Assign slave and client components to hosts you want to run them an.

Huosts that are assigned master components are shown with %

"Client" will install HDF S Client, MapReduce2 Client, YARM Client, Tez Client, HCat Client, Hive Client, HBase
Client, Pig, Sgoop, Oozie Client, ZooKeeper Client, Falcon Client and Slider.

Install Options
Confirm Hosts
Choose Services

Host all | none all | nene all | nene all | nene all | nene  all | nene —
Assign Masters

rheli# [0 Databode [0 Wodemanager [T RegionServer [T Supervisor [T Flume ¥ Client
rhel2% [~ DataNode [T NodeManager [T RegionServer [T Supervisor [T Flume ¥ Client
rhel3x W Datahode W NodeManager W RegionServer W Supervisor W Flume ¥ Client

rheld I DataMode [ NodeManager W RegionServer W Supervisor W Flume ¥ Client

rhelg W DataMode W ModeManager W RegionServer W Supervisor W Flume ™ Client

rhels W DataMode W MNodeManager W RegionServer @ Supervisor M Flume ¥ Client
rhel? ¥ DataNode W ModeManager W RegionServer W Supervisor [ Flume ¥ Client
rheld ¥ DataMode W Modemanager ™ RegionServer W Supervisor W Flume ¥ Client
rheld I DataMode [ ModeManager W RegionServer | Supervisor W Flume ¥ Client

rhelt0 W Databode W MNodeManager @ RegionServer W Supervisor W Flume W Client =l
Stiow: 25 j 1170117 K € 3 M

«— Back
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Customize Services

This section presents with a set of tabs that manage configuration settings for Hadoop components. The
wizard attempts to set reasonable defaults for each of the options here, but this can be modified to meet
specific requirements. Following sections provide configuration guidance that should be refined to meet
specific use case requirements.

Following are the changes made
* Memory and service level setting for each component and service level tuning.

« Create a separate configuration for archival nodes to account for them having different number of
data drives (4 Volumes of RAIDS5 each with 14+1 drives) compared to data nodes (24 volumes). We
will then point Ambari to these archive nodes and override the default configuration for these nodes.

* Customize the log locations of all the components to ensure growing logs do not cause the SSDs to
run out of space.

HDFS

In Ambari, choose HDFS Service from the left tab and go to Configs tab.

Use the “Search” box on top to filter for the properties mentioned in the tab to update the values
HDFS JVM Settings

Update the following HDFS configurations in Ambari:

Table 10 HDFS Configurations

Property Name Value
NameNode Java Heap Size 4096
Hadoop maximum Java heap size 4096
DataNode maximum Java heap size 4096
DataNode Volumes Failure Toleration 3

Manage Config Groups for Archival Nodes

Ambari initially assigns all hosts in your cluster to one default configuration group for each service
installed. Since there are different number of data drives (volumes) on archival nodes (4) as compared
to other data nodes (24), create a new group for archive nodes and override the default data node
directories that were picked up.

1. Under the HDFS tab, click Manage Config Groups

r Cisco UCS Integrated Infrastructure for Big Data with Hortonworks Data Platform
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Get Started
Select Stack
Install COptions
Canfirm Hosts
Choose Services

Assign Masters

Assign Slaves and Clients
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Figure 142 HDFS Manage Config Groups

Customize Services

YWWe have come up with recommended configurations for the services you selected. Custamize them as you see
fit.

HDFS MapReduce? YARN Tez Nagios @ Gangiz Hve @ HBase Fig Sgoop  Oozie @

Zookeeper  Falcon  Storm Flume  Kafka Knuxo Slider  Misc

Group  HOFS Default (68) ~  Manage Config Groups =
¥ NameMode

MameMode hosts rhelt

MameMade directories fdatardisk1/hadoophdfsmamenode

MameMode Java heag 1024 MB

Size

MameMode new 200 B

generation size

2. Create an Archive group by clicking the + button on the left and entering “Archive” for the name.

Figure 143 Manage HDFS Configuration Groups

Manage HDFS Configuration Groups

You can apply different sets of HOFS configurations to groups of hosts by managing HOFS Configuration Groups and their host
membership. Hosts belonging to a HOFS Configuration Group have the same set of configurations for HOFS. Each host belongs to one
HOFS Configuration Group

El | rhen
rhel2
rhel3
rheld
rhels
rhels
rhel?
rhels
rhels
rhel1d
rhellt
rhel12
rhel13 =
rhelld

ERRCIE =

|

Crerrides 0 properties

Description Default cluster level HDF 5 configuration

Cancel
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Figure 144 Create New Configuration Group

Create New Configuration Group

Marne; Archive

Description:| g Disks|

Cancel

Now the Archive group should appear in the Configuration Groups.

Figure 145 Manage HDFS Configuration Groups
Manage HDFS Configuration Groups

¥ou can apply different sets of HDOFES configurations to groups of hosts by managing HDES Configuration Groups and their host

membership. Hosts belonging to a HDFS Configuration Group have the same set of caonfigurations for HOFS, Each hast belongs to one

HOFS Configuration Group.

HOFS Default (64) - =l
A 0

+ = E o R d + ==
Overrides 0 properties
Description G0 disks L
Cancel
3.

Add archive nodes to the archive group, by clicking on the + sign on the right and selecting the
archive nodes, and click OK when done.
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Figure 146 Select Configuration Group Hosts

Select Configuration Group Hosts

Select hosts that should belong to this Archive Configuration Groug. All hosts belonging to this group will have the same set of

configurations.

4 put of B8 hosts selectad Eilter = Components -

i Host IP Address

[ rhel63 10.29.160.163 &
rhelGd 10.29.160.164

¥ rhel6s 10.29.160.165

Ira rhel6h 10.29.160.166

¥ rhel67 10.29.160.167

2 rhel68 10.29.160.168 =

Shnwmj He€>MN

Now you should see the archive nodes appear under the Archive configuration group. Click Save to
commit the new configuration group you created.

Figure 147 Manage HDFS Configuration Groups
Manage HDFS Configuration Groups

You can apply different sets of HDES configurations to groups of hosts by managing HOFS Configuration Groups and their host
membership. Hosts belonging to a HDFS Configuration Group have the same set of configurations for HDOFS. Each host belongs to one
HOF 5 Configuration Sroup
HOF 5 DETault { 64 H rhel65 =

rhel6

rhel6?

rhel6d

LI -
+ - o + -
Overrides 0 properties
Description 60 Disks o

Cancel

Next we will configure the archive nodes to use different data directories than the data nodes by
overriding this value by following the below steps.
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4. Select HDFS Default group, scroll down to “Data Node directories” property and copy first four
lines from the Data Node directories.

5. And then select Archive config group

Figure 148 Manage HDFS: Customize Services Partl

i G Customize Services
Select Stack
YWe have come Up with recommended configurations for the services you selected. CUStOMIZE them as you see
Install Options fit
Canfirm Hosts
Choose Services HDFS  MapReduce2 YARN Ter Magios @ Gangia Hve @ HBase Pig Sqoop  Oozie @

Assign Masters Zookeeper  Falcon  Storm  Flume  Katka Knoxo Slider  Misc

Assign Slaves and Clients

Group | Archive (11 Lw | Manage Config Groups Filter b
HOFS Default (64)

MameNode hosts rhelt

NameMode directories fata/disk1/hadoop/hdrsmamenode

6. Scroll down to the “Data Node directories” property and click override button (to the right of the
textbox) and paste those four lines from Data Node directories here.

/data/diskl/hadoop/hdfs/data
/data/disk2/hadoop/hdfs/data
/data/disk3/hadoop/hdfs/data
/data/disk4 /hadoop/hdfs/data
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Figure 149 Manage HDFS: Customize Services Part2

CLUSTER

Get Started Customize Services

Select Stack

INSTALL WIZARL

We have come up with recommended configurations for the services you selected. Customize them as you see
Install Options fit

confirm Hosts

Choose Services HOFS | MapReduce2 YARN Ter Magios@@) Ganglia Hve @ HBase Pig Sgoop  Oozie @

Assign Masters Zookeeper  Falcon  Storm Flume  Katka  Knos @ Slider  Misc

Assign Slaves and Clients

Group | Archive (4)  ~ | Manage Config Groups

»  Mamehode

¥} Secondary Namehode

> DataMode
DataMode hosts rheld and 65 others
Datanode directories fdatasdisk1/hadoophdrs/data i’

fdata/disk2/hadonphdfs/data
fdata/disk3/hadoop/hds/data
foata/diskd/hadnophdrs/data
fdatadisk&/hadoop/hdrs/data

felatafdisk1/znoophifs/data
/datasdisk2/agdoop/hdrs/data
(dataidisk3anagoophdrs/data
/datasdiska/zgoophdis/data

B | 1
o

7. We are done customizing the Archive Config Group. For all remaining steps, select back the HDFS
default group.
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Figure 150 Manage HDFS: Customize Services Part3

ER INSTALL WIZARD

Get Started Customize Services

Select Stack

We have come up with recommencled configurations for the services you selected. Customize therm as you see
Install Options it
Canfirm Hosts

Chonse Senvices HDFS MapReduce? YARN Tez Nagios @ Gangia Hve @ HBase Pig Sgoop  Coze @B

Assign Masters Zookeeper  Falcon  Storm Flume  Katka  Knox @ Siider  Misc

Assign Slaves and Clients

Group | HDFS Default (s4)  ~  Manage Config Groups Filter =

» Kamehode

b Secondary Namehode

~ Datahode

Datalode hosts theld and €5 others

Datakode directories fdataidisk1/hadoop/hdfs/data ﬂ
juata/isk2hadoop/ndrs/data
fatadciskdhadoop/hdfs/data & e
fdataidiskdhadoop/hdfs/data =l

fdataidiskVhadoop/hdfs/data
fdata/disk2hadoog/hdrs/data
Jdata/diskamadoop/hors/data Switch to Archive’
fdata/diskd/hadoop/hdfs/data =

Update Log Directory

Change the default log location by finding the Log Dir property and modifying the /var prefix to
/data/disk1
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Figure 151 Manage HDFS: Customize Services Partd

Customize Services

We hiave come up with recommended configurations for the services you selected. Custormize them as you see
fit.

HDFS MapReduce? YARN Tez Nagios @ Gangia Hve @ HBase Fig Sgoop  Oozie @9

Zookeeper  Falcon  Stormn Flume  Kafka Kno}:o Slider  Misc

Group | HODFS Default (64) | Manage Config Groups Mear

1}
L)

-

Advanced hadoop-eny

Hadoop Log Dir Prefix /data/disk1A0g/hadoop]

Hadoop PID Dir Prefix Mearirun/hadoop

MapReduce2

In Ambari, choose MapReduce Service from the left tab and go to “Configs” tab.

Use the “Search” box on top to filter for the properties mentioned in the tab to update the values
Update the following MapReduce configurations.

Table 11 MapReduce Property Name and Value

Property Name Value
Default virtual memory for a job's map-task 4096
Default virtual memory for a job's reduce-task 8192
Map-side sort buffer memory 1638
yarn.app.mapreduce.am.resource.mb 4096
mapreduce.map.java.opts -Xmx3276m
mapreduce.reduce.java.opts -Xmx6552m
yarn.app.mapreduce.am.command-opts -Xmx6552m

Similarly under MapReduce? tab, change the default log location by finding the Log Dir property and
modifying the /var prefix to /data/disk1.
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Figure 152 MapReduce: Customize Services

Customize Services

We have come up with recommended configurations for the services you selected. Customize them as you see
fit.

HOFS  MapReduce2 YARN Tez Magios @@ Gangla Hve @ HBase Pig  Sgoop  Oozic @B

ZooKeeper Falcon  Storm Flume  Katka  knox @@ Slider  Misc
Group  MapReduce? Defaulties) ~  Manage Config Groups Avar] [ JE

> Advanced mapred-eny

Mapreduce Log Dir Prefix /data/disk1/og/hadoop-mapreduce

Mapreduce FID Dir Prefix  Aarrun/hadoop-mapreduce

YARN

In Ambari, choose YARN Service from the left tab and go to “Configs” tab.
Use the “Search” box on top to filter for the properties mentioned in the tab to update the values

Update the following YARN configurations

Table 12 Yarn Property Name and Value
Property Name Value
ResourceManager Java heap size 4096
NodeManager Java heap size 2048
yarn.nodemanager.resource.memory-mb 184320
YARN Java heap size 4096
yarn.scheduler.minimum-allocation-mb 4096
yarn.scheduler.maximum-allocation-mb 184320

Similarly under YARN tab, change the default log location by finding the Log Dir property and
modifying the /var prefix to /data/disk1
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Figure 153 Yarn: Customize Services

Customize Services

Wi have come upwith recommended configurations for the senvicesyou selected, Customize them as you see
fit.

HDFS MapReduce? YARN Tez Nagios @ Ganglia Hve @ HBase Pig Sgoop  Oozie @

Zookeeper  Falcon  Storm Flume  Kafka Knu}{o Slider  Misc
Group | YARM Default (68) ~  Manage Config Groups | ivarl Q-

¥ Advanced yarn-eny

YARM Log Dir Prefiy fdatafdisklogfhadoop-yam

YARN PID Dir Prefix Marfrun/hadoop-yarn

Tez
No changes required.
Figure 154 Tez: Customize Services
Customize Services
W have come up with recommended configurations for the services you selected. Customize them as you see
it
HOFS  MapReduce? wARN | Ter Nagios @@ Sanglia  Hive @ HBase Fig  Sgoop Oozie @
Zookeeper Falcon  Storm  Flume  Kafka kno< @ Sider  Misc
Group Tez Default (68) s Manage Config Groups Filter -
I General
L Advanced tez-eny
.
Nagios

On the Nagios tab, it is required to provide:
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* Nagios admin password (as per organizational policy standards)

* Hadoop admin email

Figure 155 Nagios: Customize Services

Customize Services

WWe have come up with recommended configurations for the services you selected. Customize them as you see
Tit.

HDFS MapReduce2 YARNM Texr MNagios Ganglia Hive @) HBase Pig Sgoop  Oozie @

Zookeeper  Falcon  Storm Flume  Kafka  kKnox @ Siider  Misc
Sroup Magios Default (68) - Manage Config Groups Filter

> General

Magios Admin username nagiosadmin
Magios Admin password asasss sesns
Hadoop Admin email admin@admin.com

Ganglia

No changes are required.

Figure 156 Ganglia: Customize Services

Customize Services
Wve hawve come up with recommended configurations for the services you selected. Customize them as you see

Tit.

HDFS MapReduce2 “YARN Ter MNagios Ganglia Hive @ HBase Pig Sgoop  Oozie P

Zookeeper Falcon  Storm Flume  Katka Knox @@ Slder  Misc
Sroup Ganglia Default (68) - Manage Config Groups

= amRmers]

Ganglia rricached base Aearflibigangliairds
directory

Hive

In Ambari, choose HIVE Service from the left tab and go to Configs tab.
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On the Hive tab, enter:

Note Install Hive as is with just the following Log Dir changes, this uses MapReduce as engine. The Section
on “Configuring Hive to use Apache Tez”, goes into details on tuning Hive for Performance by using
Apache Tez as the execution engine and using Cost Based Optimizer to run queries.

Following are the changes for configuring Log Dir on Hive:
« Enter the Hive database password as per organizational policy.

¢ Change hive log directory by finding the Log Dir property and modifying the /var prefix to
/data/disk].

* Change the WebHCat log directory by finding the Log Dir property and modifying the /var prefix
to /data/disk1.
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Figure 157 Hive: Customize Services Partl

Customize Services

we have come up with recommended configurations for the services you selected. Customize them as you see
Tit.

HOFS  MapReduce2 YARNM Tez Nagios Ganglia Hive HBase Pig Sgoop  Oozie @B

Zookeeper Falcon  Storm Flume  katka  kKnox @@ Slider  Misc

Sroup Hive Default (68) - Manage Config Groups

e Hive hMetastore

Hive tetastore host rhelz
Database Type PlyS L
Hive Database @« Mew MySCL Database

0 Existing MySQL Database
© Existing PostgreSCL Database
© Existing Oracle Database

Database Host rhel2

Database Mame hive

Database Username hive

Database Password SSS8S IETTEY
Figure 158 Hive: Customize Services Part2

Customize Services

YWe hawve come up with recommended configurations for the services you selected. Customize them as you see
Tit

HOFS  MapReduce2 YARM  Tez Magios Ganglia Hive HBase Pig Sgoop ODzieo

Zookeeper Falcon  Storm Flume  Kafka  kKnox @ Slider  Misc
Group Hive Default (68) - Manage Config Groups Mar o -

¥  Advanced hive-eny

Hive Log Dir fdatasdisk1Aoghive

Hiwe PID Dir Mearfrundhive

= Advanced webhcat-eny

WyehHCat Log Dir tdatasdisk iflogivebhcat

WyehHCat PID Dir Marirunfwebhoat
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In Ambari, choose HBASE Service from the left tab and go to Configs tab.

Use the “Search” box on top to filter for the properties mentioned in the tab to update the values
Update the following HBASE configurations:

Table 13 HBASE Configuration
Property Name Value
HBase Master Maximum Java Heap Size 4096

HBase RegionServers Maximum Java Heap Size |16384

~

Note

If you are not running HBase, keep the default value of 1024 for Java Heap size for HBase
RegionServers and HBase Master.

Similarly under HBase tab, change the default log location by finding the Log Dir property and
modifying the /var prefix to /data/disk1
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Pig

Figure 159 HBase: Customize Services

Customize Services

Wy have come up with recommended configurations for the services you selected. Customize them as you see
fit.

HOFS  MapReduce? YARW Tez Nagios Ganglia Hiwe HBase Pig  Sgoop Ouzieo

ZooKeeper Falcon  Storm Flume  Katka  knox@@)  Siider  Misc
Group | HBase Default(68) ~  Manage Config Groups fear oo

¥ Advanced hbase-eny

HBase Log Dir | iataldiskifiogibase

HBase FID Dir Marfrun/hbase

No changes are required.

Customize Services

We hawve come up with recommended configurations for the services you selected. Customize them as you see
Tit.

HOFS  MapReduce2 YARM Ter Magios Ganglia Hive HBase Pig  Sgoop  Oozie @

ZonokKeeper Falcon Storm Flume Kafka Knoxo Slider  Misc
Group I Pig Default (68) ~ Manage Config Groups Filter -
L4 Advanced pig-emny
2 Advanced pig-logsj

L4 Advanced pig-properties
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Sqoop
No changes are required.
Figure 160 Sqoop Customize Services
Customize Services
We have come Lp with recommended configurations for the services you selected. Customize them as you see
fit.
HOFS  MapReduce2 YARM Tez Magios Ganglia Hwve HBase Pig Sgoop Ouzieo
Zookeeper Falcon  Storm Flume  Kafka Knuxn Slider  Misc
Group  Sgoop Default (68) = | Manage Config Groups Filtes -
¥ Advanced sgoop-env
Oozie

Similarly under Oozie tab, change the default log location by finding the Log Dir property and
modifying the /var prefix to /data/disk]1.

Also enter the oozie database password as per organizational policy.
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Figure 161 Oozie: Customize Services Partl

Customize Services

WiE hiawve come up with recommended configurations for the services you selected. Customize them as you see
Tit.

HOFS MapReduce2 YARN Tez Nagios Ganglia Hive HBase Pig Sgoop OCozie | Zookeeper

Falcon  Storm Flume  kafka  kno< @ Slider  Misc
Group Ciozie Default (68) e Manage Config Groups Filter -

x Oozie Server

Cozie Server host rhel2
Database Type Derby
Oozie Database & Mew Derby Database

0 Existing MySCL Database
€ Existing PostgresSCQiL Database
© Existing Oracle Database

Database Name oozie a
Database Username oozie =
Database Password sssss FYTYYY

Figure 162 Oozie: Customize Services Part2

Customize Services

Wye have come up with recommended configurations for the services you selected. Customize them as you see
fit.

HDFS MapReduce2 YARMN Tez Magios Ganglia Hive HBase Pig  Sgoop  Oozie  Zookeeper

Falcon Storm  Flume  Kafka  kKnox @ Slider  Misc
Group | Oozie Default (68) | =  Manage Config Groups Aar 0 -

¥ Advanced oozie-eny

Ciozie Log Dir fdataidisk1/onfoozie

Oozie PID Dir Marirun/oozie

Zookeeper
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Similarly under Zookeeper tab, change the default log location by finding the Log Dir property and
modifying the /var prefix to /data/disk1

Figure 163 Zookeeper: Customize Services

Customize Services

WWe have come up with recommended configurations for the senvices you selected. Customize them as you see
fit.

HOFS MapReduce2 YARM Tez Nagios Ganglia Hive HBase Pig Sgoop  Qozie | Zookeeper

Falcon Storm Flume Katka  Knod @@ Slider  Misc
Group | Zookeeper Default (68) = Manage Config Graups Avar Q| -

>  Advanced zookeeper-eny

Zookeeper Lag Dir fatasdisk/ing/zookeeper

Zookeeper PID Dir Mearfrunizookeeper

Falcon

Similarly under Falcon tab, change the default log location by finding the Log Dir property and
modifying the /var prefix to /data/disk]1.
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Figure 164 Falcon: Customize Services

Customize Services

We have come up with recammended configurations for the services you selected. Customize them as you see

Tit.

HDFS MapReduce2  YAREMN Tez Magios Ganglia Hive
Falcon | Storm Flume  Kafka  Knox @@ Slider  Misc

Group | Falcon Default (68) | Manage Config Groups

¥ Advanced falcon-eny

Falcon Log Dir fdatardiskiflogifalcan

Falcon PID Dir Adarirun/falcon

Storm

HBase Pig Sgoop Oozie. Zookeeper

hvar 0 -

Similarly under Storm tab, change the default log location by finding the Log Dir property and

modifying the /var prefix to /data/disk1
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Figure 165 Storm: Customize Services

Customize Services

We have come up with recommended configurations for the services you selected. Customize them as you see
fit.

HOFS MapReduce? YARM Tez Nagios Ganglia Hive HBase Pig Sgoop Oozie  ZooKeeper

Falcon  Storm | Flume Kaftka knox @ Slider  Misc
Group | Storm Default (68)  » | Manage Config Groups Mear 0 -

¥ Advanced storm-gmny

storm_log. dir fdatardiskifiogistarm 4]

starrm_pid_dir fearfrundstarm L+

Flume

Similarly under Flume tab, change the default log location by finding the Log Dir property and
modifying the /var prefix to /data/disk1
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Figure 166 Flume: Customize Services

Customize Services

YWi'e have come up with recommended configurations for the services you selected. Customize them as you see

fit.

HOFS MapReduce2 YARM Tez Magios Ganglia Hive
Falcon  Storm | Flume  Kafka  Knox @ Slider  Misc
Group | Flume Default (68) = | Manage Config Groups

> Advanced flume-eny

Flume Log Dir fataidiskfogiiume

Kafka

HBase Pig Sgoop Oozie Zookeeper

Similarly under Knox tab, change the default log location by finding the Log Dir property and modifying

the /var prefix to /data/disk1
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Figure 167 Kafka: Customize Services Partl

Customize Services
“We have come up with recommended configurations for the services you selected. Customize them as you see

Tit.

HOFS MapReduce2 YARM Tezr MNagios Ganglia Hive HBase Pig Sgoop  Oozie  Zookeeper

Falcon  Storm Flume | katka  Knox @ Stider  Misc
Group Kafka Default (68) bs Manage Config Groups Svar a

. Arhvanced katka-eny

Kafka FPID dir fearfrunikarka
kafka_log_dir fdatasdiskilogdkarkal L+
Figure 168 Kafka: Customize Services Part2

Customize Services

We have come upwith recommended configurations for the services ywou selected, Customize them as you see
Tit.

HDES MapReduce2 vARM Tez Magios Sanglia Hive HEase Fig Sgoop Dozie Zookeeper

Falcon Starm Flume Kafka Knox = Slider  Misc
Group Knox Default (68) - Manage Conflg Groups

Knox Gateway

knox Gatewsay host rhelt

knox Master Secret sesss saeas

Knox

For Knox, change the gateway port to 8444 to ensure no conflicts with local HTTP server.
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Figure 169 Knox: Customize Services

Customize Services

We hawve come up with recommended configurations for the services you selected. Customize them as you see

Tit.

HOFS MapReduce2 WARR Tex Magios Sanglia

Falcon Starm Flume Katka Knox Slider hisc
Group Knox Default (68) - Manage Config Groups

Gt Knox Gateway

Knox Gatewssy host rhelt

k Advanced gatewsy-logdj

> Adwanced gatewsay-site

gatewsy.gatewsy.conr.dir deployments

gatewsy.hadoop. false
kerberos secured

gateway.path gateway

gateway. port B4

Slider

No changes are required.

Hive

HBEase

Pig sSqoop

gateway

Oozie

Zookeeper
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Figure 170 Slider: Customize Services

Customize Services

We have come up with recammended configurations for the services you selected, Customize them as you seg
fit.

HDFS MapReduce? YARM Ter Nagios Ganglia Hiwve HBase Pig Sgoop Oozie  Zookeeper

Falcon Storm  Flume  Kafka  Knox  Slider  Misc
Group | Slider Default (68) = Manage Config Groups

Y Advanced slider-eny

¥ Arvanced slider-logd)

.
Misc
No changes are required.
Figure 171 Misc: Customize Services
CLUSTER INSTALL WIZARD
L Customize Services
Select Stack
We have come up with recommended configurations for the services you selected, Customize them as you see
Install Options fit
Confirm Hosts
Choose Services HDFS MapReduce? YARN Tez Magios Ganglia Hive HBase Pig Sgoop Oozie  Zookeeper
Assign Masters Falcon  Storm Flume  Kafka  Knox  Slider  Misc
Assign Slaves and Clients
¥ Users and Groups
«— Back
.
Review

The assignments that have been made are displayed. Check to ensure everything is correct before
clicking on Deploy button. If any changes are to be made, use the left navigation bar to return to the

appropriate screen.

Cisco UCS Integrated Infrastructure for Big Data with Hortonworks Data Platform g



W Installing HDP 2.2

Deploy

Once review is complete, click the Deploy button.

Figure 172 Review the Assignments

Review

Get Started
Select Stack Flease review the configuration before installation

Install Options

Canfirm Hosts W
Admin Name : admin
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| »
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Assign Masters
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Customize Services
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Services:

HDFS
Datalode | 66hosts
Mamekode © rhel1
SMarmeMode | rhel2
YARN + MfapReduce2
App Timeline Server: rhel2
ModeManager | e6hosts
ResourceManager | rhel2
Tez

=

« Back

The progress of the install is shown on the screen. Each component is installed and started and a simple
test is run on the component. The next screen displays the overall status of the install in the progress bar
at the top of the screen and a host-by-host status in the main section.

To see specific information on what tasks have been completed per host, click the link in the Message
column for the appropriate host. In the Tasks pop-up, click the individual task to see the related log files.
Select filter conditions by using the Show drop-down list. To see a larger version of the log contents,
click the Open icon or to copy the contents to the clipboard, use the Copy icon.

Depending on which components are installing, the entire process may take 10 or more minutes.

When successfully installed and started the services appears, click Next.
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Figure 173 Installation and Test in Progress Page

CLUSTER INSTALL WIZARD

Install, Start and Test

et Started

Select Stack Please wait while the selected services are installed and started

Install Options

Confirm Hosts

Choose Services Show: wl InProgress (09 | Warning (0) | Success (es) | Fail (0)
Assign Masters Host Status Message

#ssign Slaves and Cllents thel S 0 Success
GlstomizE REntes rhel2 B 00% Success
rhel3 _ 100%  Success
rheld _ 100%  Success
rheld _ 100%  3uccess
rhel? _ 100%  Success
rhelg _ 100%  Success
rheld _ 100%  Success
rhel 10 B 00 Guccess
rhel 11 B o cuccess
rhel12 B 0 uccess
rhel13 B oo Guccess
rhel4 B o uccess
rhel15 B 00 Success

Review

SUmmary

Summary of Install Process

The Summary page gives a summary of the accomplished tasks. Click Complete.
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Figure 174 Summary
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Archival Storage in HDFS

Note

HDFS along with Apache Hadoop version 2.6.0 (included in HDP 2.2) provides the ability to utilize
tiered (heterogeneous) storage media within the HDFS cluster to enable Archival storage to store less
frequently accessed datasets and Flash based fast storage to store datasets that require lower latencies
for read/write workloads.

In this section, we will go into details on using Cisco UCS C3160 as the Archival Storage.

Over time, frequency of reads on a dataset decreases (recently written data is more frequently accessed
while aged data is less frequently accessed). This old dataset is deemed as “cold.” As the amount of data
under storage grows, there is a need to optimize storage of such ‘cold’ datasets. An Archival storage tier,
consisting of nodes with slow spinning high density storage drives and low compute power, provides
cost efficiency for storing these “cold” datasets.

HDP 2.2 introduces an ‘ARCHIVE’ Storage Type and related Storage Policies — ‘Hot’, “Warm’, ‘Cold’.

The placement of data blocks is tied to the temperature of the data. The default storage type is DISK,
which is on Data Nodes; by default every data is considered Hot and placed in Hot data-tier storage (UCS
C240 M4).

Figure 175 HDP 2.2 Archive Storage Type

Hot

All replicas on disk

For WARM option, 2 replicas are placed on the drives of Data Nodes and one replica in Archival Storage.
In COLD option, all replicas are placed in Archival storage.

A directory within HDFS is then assigned a storage policy. Depending on the policy, data copied into
that directory is then stored in the appropriately tagged data nodes.

For example — assign directory “/cold-data” to COLD storage policy

hdfs dfsadmin -setStoragePolicy /cold-data COLD
All disk volumes in the Archival storage tier nodes are tagged with the ‘ARCHIVE’ storage type.
Administrators can then apply the ‘Cold’ Storage Policy to datasets that need to be stored on the Archival

storage tier nodes. Since the ‘Cold’ Storage Policy is applied after the dataset has been created, the
policy will be enforced when the HDFS Mover tool is run.

Sections below will go in detail on configuring Archival Storage.

If HDP 2.2 is deployed on only a single Rack with 16 Cisco UCS C240 M4 servers along with only one
Cisco UCS C3160 as the archival node, then as a best practice, use only Hot and Warm policies to ensure
data redundancy. This is because, using COLD won’t provide 3 way replication as only one copy will be
stored in Archival storage (which provides data redundancy through RAIDS but is not equivalent to 3
way replication). If there are two Archival nodes, this would still provide strong data redundancy, as
there are two copies, one on each Archival node, which is further protected through RAIDS protection.

Steps:
1. Shutdown all data nodes.
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Go to Hosts > Actions > Filtered Hosts > DataNodes > Stop

Figure 176

Ambari GUI: Stop the DataNodes

HDF * 1aps

Adrmin

| Actions » Filter: All (16) =

*+ Ade New Hosts IP Address Cores {CPU) RAM Disk Usage Load Avy Components
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Figure 177 DataNodes Successfully Stopped
Stop DataNodes
& Operations Hosts Show Al (14) j
A
o rhel13 I, 100% 3
e R, 100 3
 thelts R, 100% »
 theit N 100% »
 hel1? . 100% 3
el R 100 »
w e e y
shows| 10 7| 1100r1s W€ 3 M
™ Do not show this dizlog again when starting a background operation

2. Assign the Archive Storage Type to the DataNode

Go to HDFS > Config > Select Archive in the Config groups
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Edit all archive directories and add [ARCHIVE] as a prefix in front of each entry

ARCHIVE
ARCHIVE
ARCHIVE
ARCHIVE

/data/diskl/hadoop/hdfs/data
/data/disk2/hadoop/hdfs/data
/data/disk3/hadoop/hdfs/data

[
[
[
[ /data/disk4/hadoop/hdfs/data

Figure 178 HDEFS Configuration
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& Storm

DataNode directories Hataisk Madoopdfsitata /dataidiska/adoop/ndfs/data dataidiskamacong j
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Ihatoopdfs/ata /ataiiskinadoonincs/iata /ata/diskBmadoopiifsiata,

& Kafka
/datafdisk3hadoophdfsidata /dataidisk 1 Othadoophdfs/idata fatardisk 1 1/hadoop =
& Knox Jhdfsidata /datasdisk1 2hadoop/hdfs/data /datafdisk 1 Ihadoophdfs/data,
O Slider [ARCHIVEdataldisk1/ladoonhdfs/data
[ARCHIVEdata/disk2adoonhdfs/data
Actions = [ARCHIVE)data/disk¥hadoonhifs/data Q

[ARCHIVE]tataiickahzinnyefs/iaty

Save the configuration
3. Create cold and warm archive HDFS Directories.

sudo -u hdfs hadoop dfs -mkdir /archive-cold
sudo -u hdfs hadoop dfs -mkdir /archive-warm

[rootirhell sudo -u hdfs hadoop dfs -mkdir /archive-cold
JEPRECATED : of this script to execute hdfs command is deprecated.
[nstead use hdfs command for it.

[rootirhell sudo -u hdfs hadoop dfs -mkdir /archive-warm
JEPRECATED : of this script to execute hdfs command is deprecated.
Instead use hdfs command for it.

4. Set Storage Policies on HDFS Directory and then confirm these

sudo -u hdfs hdfs dfsadmin -setStoragePolicy /archive-cold COLD
sudo -u hdfs hdfs dfsadmin -setStoragePolicy /archive-warm WARM
sudo -u hdfs hdfs dfsadmin -getStoragePolicy /archive-cold
sudo -u hdfs hdfs dfsadmin -getStoragePolicy /archive-warm
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[rootfrhell ~]# sudo -u hdfs hdfs dfsadmin -setStoragePolicy /archive-cold COLD
Jet storage policy COLD on /archive-cold

[rootfrhell ~]# sudo -u hdfs hdfs dfsadmin -setStoragePolicy /archive-warm WARM
Jet storage policy WARM on /archive-warm

[rootfrhell ~]# sudo -u hdfs hdfs dfsadmin -getStoragePolicy /archive-cold

rhe storage policy of /archive-cold:

BlocksStoragePolicy{COLD:2, storageTypes=[ARCHIVE], creationFallbacks=[], replicationFallbacks=[]}

[rootfrhell ~]# sudo -u hdfs hdfs dfsadmin -getStoragePolicy /archive-warm

rhe storage policy of /farchive-warm:

BlockStoragePolicy{WARM:5, storageTypes=[DISK, ARCHIVE], creationFallbacks=[DISK, ARCHIVE], replicationFallbacks=[DISK, ARCHIVE]}

5. Start all the DataNodes.
Click HDFS > Restart all > Confirm restart all

Figure 179 Ambari GUI: Restart HDFS DataNodes

Services Admin - E3E
HOFS 3 2 Summary  Configs Quick Links» Service Actions v

% MapReduce?

. 2 Components o 1 Host

o Tez
& Nagios Summary Alerts and Health Checks Restart Datatodes G

Figure 180 Ambari: Restart DataNodes
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6. Copy test files into Warm and Cold Storage HDFS Directories.

Create your test file and copy into warm and cold HDFS directories.

echo "This is a tiered storage test file" > /tmp/storagetest.txt
sudo -u hdfs hadoop fs -put /tmp/storagetest.txt /archive-cold
sudo -u hdfs hadoop fs -put /tmp/storagetest.txt /archive-warm
sudo -u hdfs hadoop fs -cat /archive-cold/storagetest.txt

sudo -u hdfs hadoop fs -cat /archive-warm/storagetest.txt
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[rootfrhell tmp]# echo "This is a tiered storage test file" > /tmp/storagetest.txt
[rootérhell tmpl# sudo -u hdfs hadoop fs -put /tmp/storagetest.txt /archive-cold
[rootfrhell tmpl# sudo -u hdfs hadoop f£s -put /tmp/storagetest.txt /archive-warm

[rootérhell tmpl# sudo -u hdfs hadoop fs -cat farchive-cold/storagetest.txt
lhis is a tiered storage test file
[rootérhell tmpl# sudo -u hdfs hadoop fs -cat /archive-warm/storagetest.txt
lhis is a tiered storage test file

7. Use mover script to apply Storage Policies

sudo -u hdfs hdfs mover -p /archive-warm
sudo -u hdfs hdfs mover -p /archive-cold

[rootdrhell ~]# sudo -u hdfs hdfs mover -p farchive-warm
15/03/18 03:25:06 INF0O mover.Mover: namenodes = {hdfs://rhell:8020=[/archive-warm]}
15/03/18 AEER INFO balancer.KeyManager: Block token params received from NN: update interval=10hrs, Osec, token lifetime=10hrs,
15/03/18 REDA INFO block.BlockTokenSecretManager: Setting block keys
INFO balancer.KeyManager: Update block keys every 2hrs, 30mins, Osec
INFO block.BlockTokenSecretManager: Setting block keys
INFO net.HNetworkTopology: Adding a new node: /default-rack/192.168.
INFO net.NetworkTopology: Adding a new node: /default-rack/192.168.
INFO net.NetworkTopology: Adding a new node: /default-rack/192.168.
INFO net.NetworkTopology: Adding a new node: /default-rack/192.168.
INFO net.HetworkTopology: Adding a new node: /default-rack/192.168.

-u hdfs hdfs mover -p /archive-cold
03 INFO mover.Mover: namenodes = {hdfs://rhell:8020=[/archive-cold]}
03 INFO balancer.KeyManager: Block token params received from NN: update interval=10hrs, Osec, token lifetime=10hrs
03:25: INFO block.BlockTokenSecretManager: Setting block keys
03 INFO bhalancer.KeyManager: Update block keys every 2hrs, 30mins, 0sec
03:25: INFO block.BlockTokenSecretManager: Setting block keys
03 INFO net.NetworkTopology: Adding a new node: /default-rack/192.168.11.109:50010
03 INFO net.NetworkTopology: Adding a new node: /default-rack/192.168.11.112:50010
03 INFO net.NetworkTopology: Adding a new node: /default-rack/192.168.11.116:50010
03:25:45 INFO net.NetworkTopology: Adding a new node: /default-rack/192.168.11.105:50010

8. Run fsck to check the number of replicas and locations of the blocks

sudo -u hdfs hadoop fsck -racks -locations -blocks -files \
/archive-cold/storagetest.txt
sudo -u hdfs hadoop fsck -racks -locations -blocks -files \
/archive-warm/storagetest.txt
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[rootErhell ~]# sudo -u hdfs hadoop fsck -racks -locations -blocks -files Iarchive—warm/storagetest.txt
DEPRECATED: Use of this script to execute hdfs command is deprecated.
Instead use the hdfs command for it.

Connecting to namencde wvia http://rhell:50070

FSCK started by hdfs (auth:SIMPLE) from /192.168.11.101 for path /archive-warm/storagetest.txt at Wed Mar 18 03:29:47 EDT 2015
/archive-warm/storagetest.txt 35 bytes, 1 block(s): 0K

0. BP-857809477-192.168.11.101-1426658417364:blk 1073742388 1637 len=35 repl=3 [/default-rack/192.168.11.107:50010, /default-rack/192.168.11.1
7:50010, /default-rack/192.168.11.109:50010]

Status: HEALTHY

Total size: 35 B

Total dirs: 0

Total files: 1

Total symlinks:

Total blocks (wvalidated):
Minimally replicated blocks:
Over-replicated blocks:
Under-replicated blocks:
Mis-replicated blocks:
Default replication factor:
Average block replication:
Corrupt blocks:

Missing replicas:

Number of data-nodes:

Number of racks: i

FSCK ended at Wed Mar 18 03:292:47 EDT 2015 in 1 milliseconds

(avg. block size 35 B)
(100.0 %)

0
i
i
0
0
0
3
2
0
0
il

rhe filesystem under path '/archive-warm/storagetest.txt' is HEALTHY

Under the WARM storage policy, two replicas are placed on data nodes while 1 replica is placed in
Archival node. As shown in the screenshot, two replicas are stored in data nodes and one in Archival
node.

Configuring Hive to use Apache Tez

Apache Hive was originally built for large-scale operational batch processing and it is very effective
with reporting, data mining and data preparation use cases. These usage patterns remain very important
but with widespread adoption of Hadoop, the enterprise requirement for Hadoop to become more real
time or interactive has increased in importance as well.

With the Stinger initiative, Hive query time has improved dramatically, enabling Hive to support both
batch and interactive workloads at speed and at scale.

Stinger Initiative was designed to enable Hive to answer human-time use cases (i.e. queries in the 5-30
second range) such as big data exploration, visualization, and parameterized reports through faster
performance improvement to hive. One of the main change with Stinger Initiative was to run Hive
queries with Apache Tez execution engine instead of the Map-reduce engine. Apache Tez innovations
drove many of the Hive performance improvements delivered by the Stinger Initiative

Following are the configurations to enable Hive for faster query (for more details such as using ORCFile,
refer http://hortonworks.com/blog/5-ways-make-hive-queries-run-faster/)

Set Hive to use Apache Tez

In Ambari, first select Hive and navigate to Configs tab. Then, in the filter text box type “execution” to
find the “hive.execution.engine” property. Change its value from mr to tez as shown below:

hive.execution.engine=tez
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Figure 181 Ambari: Configuring Hive to use Apache Tez

& Ambari Ci

Dashboard Services Hosts

@ HOFS

@ MapReduce?
@ YARN

0 Ter

@ Nagios

@ Ganglia

@ HBase

I Fig

O sqoop

% Oozie

& ZooKeeper
& Falcon

& Storm

@ Flume

Admin B EUREITIRG

Summary  Configs Service Actions v
Group  Hive Default (16) |~ | Manage Config Groups Execution 0 -
adrmin
2 hours ago

¥l Current admin authored on Tue, Mar 17, 2015 22:53

¥ General

hive BXEC.re fooks org . apache hadoop hive.ol hooks ATSHIok :]

hive. exec.post.hooks org.apache.hadoop.hive.gl.hooks ATSHOOK hive execution.enging

hive execution engine tez * Expects one of [1mr, tez). Chiooses execition
- engine. Options are; mr (Map reduce, default) or

ter (hadoop 2 only)

Enable Vectorization

Vectorized query in execution improves performance of operations like scans, aggregations, filters and
joins, by performing them in batches of 1024 rows at once instead of single row each time.

Instructions to enable vectorization: In Ambari, first select Hive and navigate to Configs tab. Then, in
the filter text box type “execution” to find the “hive.vectorized.execution.enabled” and
“hive.vectorized.execution.reduce.enabled” properties. Ensure both their values are set to “true”

hive.vectorized.execution.enabled = true

hive.vectorized.execution.reduce.enabled = true
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hive vectorized
Execution.reduce.

true

Figure 182 Ambari: Set Preferences - Vectorization for Hive
® HOFS Summary | Configs Service Actions v
@ MapReduce2
& VARN Group | Hive Default (16)  »  Manage Config Groups EXECULion Q| -
O Tez
admin
@ hagios 2 hours ago
@ Ganglia
= ¥1 Current admin aLthored on Tue, Mar 17, 2015 22:53

& HBase
o Fig > General
O Sgoop

) hive.exec.pre.hooks org.apache hadoop hive gl hooks ATSHook Q
@ Oozie
& Zookeeper hive.exec.post.hooks org.apache hadoop hive gl hooks ATSHook Q
&) (el hive.execution.engine tez L]
& Storm
@ Flume
@ Katka ~  Performance
@ Knox

hive vectorized. true alle

O Slider execution.enabled hive vectorized.execution.reduce enabled

Actions « This flag should be set ta true to enable vectorized
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Enable cost based query optimization

Background: Hive optimizes each query’s logical and physical execution plan before submitting for final
execution. A recent addition to Hive, Cost-based optimization, performs further optimizations based on
query cost, resulting in potentially different decisions: how to order joins, which type of join to perform,
degree of parallelism and others.

Enable cost-based optimization (also known as CBO): In Ambari, first select Hive and navigate to
Configs tab. Then, in the filter text box type “stats” to find the “hive.compute.query.using.stats”,
“hive.stats.fetch.column.stats” and “hive.stats.fetch.partition.stats” properties. Ensure all their values
are set to “true”. Then, in the filter text box type “cbo” and ensure that “hive.compute.query.using.stats”
property is also set to true

cbo.enable=true

compute.query.using.stats=true

stats.fetch.column.stats=true
stats.fetch.partition.stats=true

hive.
hive.
hive.
hive.
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Figure 183 Ambari: Set Preferences - Query Optimization for Hive
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Conclusion

Hadoop has evolved into a leading data management platform across all verticals. The Cisco UCS
Integrated Infrastructure for Big Data with Hortonworks (HDP 2.2) with Tiered Storage offers a
dependable deployment model for enterprise Hadoop that offers a fast and predictable path for
businesses to unlock value in Big Data while providing customer with storage archival to ensure faster
drives are used for Hot and Warm data.

The configuration detailed in the document can be extended to clusters of various sizes depending on
what application demands. Up to 80 servers (5 racks) can be supported with no additional switching in
a single UCS domain with no network over-subscription. Scaling beyond 5 racks (80 servers) can be
implemented by interconnecting multiple UCS domains using Nexus 6000/7000 Series switches,
scalable to thousands of servers and to hundreds of petabytes storage, and managed from a single pane
using UCS Central.

Bill of Materials

This section provides the BOM for 64 nodes Performance Optimized Cluster with 4 nodes Cisco UCS
C3160 for Archival nodes. See Table 14 and Table 15 for BOM for the master rack, Table 16 and Table
17 for BOM for expansion racks (rack 2 to 4), Table 18 and 19 for software components.

Cisco UCS Integrated Infrastructure for Big Data with Hortonworks Data Platform g


http://blogs.cisco.com/tag/ucs-central/
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Table 14 Bill of Materials for C240M4SX Base rack

Part Number Description Quantity

UCS-SL-CPA3-P Performance Optimized Cluster 1

UCSC-C240-M4SX UCS C240 M4 SFF 24 HD w/o CPU, mem, HD, |16
PCle, PS, railkt w/expndr

UCSC-MRAID12G Cisco 12G SAS Modular Raid Controller 16

UCSC-MRAID12G-2GB Cisco 12Gbps SAS 2GB FBWC Cache module 16
(Raid 0/1/5/6)

UCSC-MLOM-CSC-02 Cisco UCS VIC1227 VIC MLOM - Dual Port 16
10Gb SFP+

CAB-9K12A-NA Power Cord 125VAC 13A NEMA 5-15 Plug 32
North America

UCSC-PSU2V2-1200W 1200W V2 AC Power Supply for 2U C-Series 32
Servers

UCSC-RAILB-M4 Ball Bearing Rail Kit for C220 M4 and C240 M4 |16
rack servers

UCSC-HS-C240M4 Heat Sink for UCS C240 M4 Rack Server 32

UCSC-SCCBL240 Supercap cable 250mm 16

UCS-CPU-E52680D 2.50 GHz E5-2680 v3/120W 12C/30MB 32
Cache/DDR4 2133MHz

UCS-MR-1X162RU-A 16GB DDR4-2133-MHz 256
RDIMM/PC4-17000/dual rank/x4/1.2v

UCS-HDI2T10KS2-E 1.2 TB 6G SAS 10K rpm SFF HDD 384

UCS-SD120GOKSB-EV 120 GB 2.5 inch Enterprise Value 6G SATA SSD (32
(BOOT)

UCSC-PCI-1C-240M4 Right PCI Riser Bd (Riser 1) 2onbd SATA 16
bootdrvs+ 2PCI slts

UCS-FI-6296UP-UPG UCS 6296UP 2RU Fabric Int/No PSU/48 UP/ 18p |2
LIC

CON-SNTP-C240M4SX SMARTNET 24X7X4 UCS C240 M4 SFF 24 HD |16
w/o CPU, mem

CON-SNTP-FI16296UP SMARTNET 24X7X4 UCS 6296UP 2RU Fabric |2
Int/2 PSU/4 Fans

SFP-H10GB-CU3M 10GBASE-CU SFP+ Cable 3 Meter 32

UCS-ACC-6296UP UCS 6296UP Chassis Accessory Kit

UCS-PSU-6296UP-AC UCS 6296UP Power Supply/100-240VAC

N10-MGTO012 UCS Manager v2.2

UCS-L-6200-10G-C 2rd Gen FI License to connect C-direct only 70

UCS-BLKE-6200 UCS 6200 Series Expansion Module Blank 6

UCS 6296UP Fan Module UCS 6296UP Fan Module 8

r Cisco UCS Integrated Infrastructure for Big Data with Hortonworks Data Platform



Table 14

Bill of Materials for C240M4SX Base rack

Bill of Materials

Part Number Description Quantity

CAB-9K12A-NA Power Cord 125VAC 13A NEMA 5-15 Plug 4
North America

UCS-FI-E16UP UCS 6200 16-port Expansion module/16 UP/ 8p |4
LIC

RACK-UCS2 Cisco R42610 standard rack w/side panels 1

CON-0S-R42610 ONSITE 8X5XNBD Cisco R42610 expansion 1
rack no side panel

RP208-30-1P-U-2= Cisco RP208-30-U-2 Single Phase PDU 20x C13 |2
4x C19 (Country Specific)

CON-OS-RPDUX ONSITE 8X5XNBD Cisco RP208-30-U-X Single |2
Phase PDU 2x

Table 15 Bill of Materials for C3160 Base Rack

Part Number Description Quantity

UCS-SA-C3160-D Extreme Capacity 1

UCSC-C3160 Cisco UCS C3160 Base Chassis w/ 4x PSU, 1
2x120GB SSD RailKit

CAB-9K12A-NA Replace with Power Cord 125VAC 13A NEMA |4
5-15 Plug North America

UCSC-C3X60-SBLKP UCS C3x60 SIOC blanking plate 1

UCSC-PSU1-1050W UCS C3X60 1050W Power Supply Unit

UCSC-C3X60-12SSD Cisco UCS C3X60 2x120GB SATA Enterprise
Value SSD

UCSC-C3X60-RAIL UCS C3X60 Rack Rails Kit 1

UCSC-C3X60-SVRN4 Cisco C3X60 Server Node E5-2695 v2 CPU 1
256GB 4GB RAID cache

UCSC-HS-C3X60 Cisco UCS C3X60 Server Node CPU Heatsink

UCS-CPU-E52695B 2.40 GHz E5-2695 v2/115W 12C/30MB 2
Cache/DDR3 1866MHz

UCS-MR-1X162RZ-A 16GB DDR3-1866-MHz 16
RDIMM/PC3-14900/dual rank/x4/1.5v

UCSC-C3X60-R4GB UCS C3X60 12G SAS RAID Controller with4GB |1
cache

UCSC-C3160-SI0C Cisco UCS C3160 System IO Controller with 1
mLOM mez adapter

UCSC-C3X60-56HD4 Cisco UCS C3X60 Four rows 56x 4TB Drives 1

UCSC-C3X60-HD4TB UCS C3X60 4TB NL-SAS 7.2K HDD including |56

C3X60 HDD carrier Top-load

UCSC-C3X60-EX16T

Cisco UCS C3X60 Disk Exp Tray w/ 4x 4TB
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Part Number Description Quantity

UCS-HD4T7KS3-E 4TB SAS 7.2K RPM 3.5 inch HDD/hot plug/drive |4
sled mounted

UCSC-MLOM-CSC-02 Cisco UCS VIC1227 VIC MLOM - Dual Port 1
10Gb SFP+

CON-SNTP-C3160VD1 UCS C3160 BD D Server 1

SFP-H10GB-CU3M 10GBASE-CU SFP+ Cable 3 Meter 2

>

Note Ifusing 6 TB drives for C3160, use the following PID instead of 4TB drives.

UCSC-C3X60-56HD6 Cisco UCS C3X60 Four row of drives containing |1
56 x 6TB (Total)

UCSC-C3X60-HD6TB UCS C3X60 6TB 12Gbps NL-SAS 7200RPM 56
HDD w carrier- Top-load

UCSC-C3X60-EX24T Cisco UCS C3160 Expander with 4x 6TB 1
7200RPM NL-SAS Drives

UCSC-C3X60-6TBRR UCS C3X60 6TB 12Gbps NL-SAS 7200RPM 4
HDD w carrier- Rear-load

Table 16 Bill of Materials for Expansion Racks

Part Number Description Quantity

UCSC-C240-M4SX UCS C240 M4 SFF 24 HD w/o CPU, mem, HD, |48
PCle, PS, railkt w/expndr

UCSC-MRAID12G Cisco 12G SAS Modular Raid Controller 48

UCSC-MRAID12G-2GB Cisco 12Gbps SAS 2GB FBWC Cache module |48
(Raid 0/1/5/6)

UCSC-MLOM-CSC-02 Cisco UCS VIC1227 VIC MLOM - Dual Port 48
10Gb SFP+

CAB-9K12A-NA Power Cord 125VAC 13A NEMA 5-15 Plug 96
North America

UCSC-PSU2V2-1200W 1200W V2 AC Power Supply for 2U C-Series 96
Servers

UCSC-RAILB-M4 Ball Bearing Rail Kit for C220 M4 and C240 M4 |48
rack servers

UCSC-HS-C240M4 Heat Sink for UCS C240 M4 Rack Server 48

UCSC-SCCBL240 Supercap cable 250mm 48

UCS-CPU-E52680D 2.50 GHz E5-2680 v3/120W 12C/30MB 96

Cache/DDR4 2133MHz
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Part Number Description Quantity

UCS-MR-1X162RU-A 16GB DDR4-2133-MHz 768
RDIMM/PC4-17000/dual rank/x4/1.2v

UCS-HDI12T10KS2-E 1.2 TB 6G SAS 10K rpm SFF HDD 1152

UCS-SD120G0KSB-EV 120 GB 2.5 inch Enterprise Value 6G SATA SSD |96
(BOOT)

UCSC-PCI-1C-240M4 Right PCI Riser Bd (Riser 1) 2onbd SATA 48
bootdrvs+ 2PCI slts

SFP-H10GB-CU3M= 10GBASE-CU SFP+ Cable 3 Meter 96

CON-SNTP-C240M4SX SMARTNET 24X7X4 UCS C240 M4 SFF 24 HD |48
w/o CPU, mem

RACK-UCS2 Cisco R42610 standard rack w/side panels 3

CON-0S-R42610 ONSITE 8X5XNBD Cisco R42610 expansion 3
rack no side panel

RP208-30-1P-U-2= Cisco RP208-30-U-2 Single Phase PDU 20x C13 |6
4x C19 (Country Specific)

CON-OS-RPDUX ONSITE 8X5XNBD Cisco RP208-30-U-X Single |3
Phase PDU 2x

Table 17 Bill of Materials for C3160 Expansion Rack

Part Number Description Quantity

UCSC-C3160 Cisco UCS C3160 Base Chassis w/ 4x PSU, 3
2x120GB SSD RailKit

CAB-9K12A-NA Replace with Power Cord 125VAC 13A NEMA |12
5-15 Plug North America

UCSC-C3X60-SBLKP UCS C3x60 SIOC blanking plate 3

UCSC-PSU1-1050W UCS C3X60 1050W Power Supply Unit 12

UCSC-C3X60-12SSD Cisco UCS C3X60 2x120GB SATA Enterprise 6
Value SSD

UCSC-C3X60-RAIL UCS C3X60 Rack Rails Kit 3

UCSC-C3X60-SVRN4 Cisco C3X60 Server Node E5-2695 v2 CPU 3
256GB 4GB RAID cache

UCSC-HS-C3X60 Cisco UCS C3X60 Server Node CPU Heatsink

UCS-CPU-E52695B 2.40 GHz E5-2695 v2/115W 12C/30MB
Cache/DDR3 1866MHz

UCS-MR-1X162RZ-A 16GB DDR3-1866-MHz 48
RDIMM/PC3-14900/dual rank/x4/1.5v

UCSC-C3X60-R4GB UCS C3X60 12G SAS RAID Controller with 4GB |3
cache

UCSC-C3160-SI0C Cisco UCS C3160 System IO Controller with 3
mLOM mez adapter

UCSC-C3X60-56HD4 Cisco UCS C3X60 Four rows 56x 4TB Drives 3
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Appendix

Part Number Description Quantity
UCSC-C3X60-HD4TB UCS C3X60 4TB NL-SAS 7.2K HDD including |168

C3X60 HDD carrier Top-load
UCSC-C3X60-EX16T Cisco UCS C3X60 Disk Exp Tray w/ 4x 4TB 3
UCS-HD4T7KS3-E 4TB SAS 7.2K RPM 3.5 inch HDD/hot plug/drive |12

sled mounted
UCSC-MLOM-CSC-02 Cisco UCS VIC1227 VIC MLOM - Dual Port 3

10Gb SFP+
SFP-H10GB-CU3M 10GBASE-CU SFP+ Cable 3 Meter 6
CON-SNTP-C3160VD1 UCS C3160 BD D Server 3

Table 18 Red Hat Enterprise Linux License
Red Hat Enterprise Linux
RHEL-2S-1G-3A Red Hat Enterprise Linux 68
CON-ISV1-RH2S1G3A 3 year Support for Red Hat Enterprise Linux 68
Table 19 Bill of Materials for Hortonworks

>
Note  Choose one of the part numbers.
Part Number Description Quantity
UCS-BD-HDP-ENT= HORTONWORKS ENTERPRISE EDITION 68
UCS-BD-HDP-EPL= HORTONWORKS ENTERPRISE PLUS 68

EDITION

Cisco UCS Director Express for Big Data

Introduction

Hadoop has become a strategic data platform embraced by mainstream enterprises as it offers the fastest path

for businesses to unlock value in big data while maximizing existing investments.

As you consider Hadoop to meet your growing data and business needs, operational challenges often emerge.
Despite its compelling advantages, Hadoop clusters can be difficult, complex, and time consuming to deploy.
Moreover, with so much data increasing so quickly, there is a need to find ways to consistently deploy Hadoop

clusters and manage them efficiently.
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Note  The UCSD Express appliances (UCSD Express VM and Baremetal Agent VM) can also be
installed on an existing VMware ESXi server with proper network connectivity (See Figure 174)
to the UCS domain that manages the Hadoop servers. In such a case, skip the sections until
Downloading the UCS Director Express software components.

UCS Director Express for Big Data

Cisco UCS Director Express for Big Data provides a single-touch solution that automates deployment of
Hadoop on Cisco UCS Common Platform Architecture (CPA) for Big Data infrastructure. It also provides a
single management pane across both Cisco UCS integrated infrastructure and Hadoop software. All elements
of the infrastructure are handled automatically with little need for user input. Through this approach,
configuration of physical computing, internal storage, and networking infrastructure is integrated with the
deployment of operating systems, Java packages, and Hadoop along with the provisioning of Hadoop
services. Cisco UCS Director Express for Big Data is integrated with major Hadoop distributions from
Cloudera, MapR, and Hortonworks, providing single-pane management across the entire infrastructure. It
complements and communicates with Hadoop managers, providing a system wide perspective and enabling
administrators to correlate Hadoop activity with network and computing activity on individual Hadoop nodes.

Key features of UCS Director (UCSD) Express for Big Data

+ Faster and Easier Big Data Infrastructure Deployment: Cisco UCS Director Express for Big
Data extends the Cisco UCS Integrated Infrastructure for Big Data with one-click provisioning,
installation, and configuration, delivering a consistent, repeatable, flexible, and reliable end-to-end
Hadoop deployment.

* Massive Scalability and Performance: Cisco’s unique approach provides appliance-like
capabilities for Hadoop with flexibility that helps ensure that resources are deployed right the first
time and can scale without arbitrary limitations.

» Centralized Visibility: Cisco UCS Director Express for Big Data provides centralized visibility
into the complete infrastructure to identify potential failures and latent threats before they affect
application and business performance.

¢ Open and Powerful: Provides open interfaces that allows further integration into third-party tools
and services while allowing flexibility for your own add-on services.

UCSD Express Management Server Configuration

The basic requirement for deploying and executing the UCSD Express software is a server with VM Ware
ESXi based virtualization environment. Such a physical server machine with ESXi must be connected
to the target Hadoop servers in the UCS domain by means of the management network and a dedicated
PXE network.

The following are the potential network topologies:

1. The UCSD Express Management server is outside of the UCS Domain containing the C-Series
servers that would be used to form the Hadoop cluster. For example, a standalone (CIMC managed)
C220 M4 rack server provisioned with UCSD Express VMs is connected to the UCS Domain
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Figure 184

UCSD Express Management Server that lives outside the UCS Domain
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The UCSD Express Management server is hosted on a C220 M4 rack server that is connected to and
managed by the same UCS Domain. This is the method used in this document.
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Figure 185 UCSD Express Management Server that is being managed as part of the same UCS Domain
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UCSD Management Server Cabling

For this deployment a C220 M4 rack server equipped with Intel Xeon E5-2620 v3 processors, 128 GB
of memory, Cisco UCS Virtual Interface Card 1227, Cisco 12-Gbps SAS Modular Raid Controller with
512-MB FBWC, 4 X 600 GB 10K SFF SAS drives is used (any other Cisco UCS server can also be used
for this purpose).

The C220 M4 server shall be connected to the UCS Fabric Interconnects as shown in Figure 188. The
ports on the on the Fabric Interconnects must be configured as server ports.
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Figure 186 Fabric Topology for C220 M4

Cisco UCS 6296 UP Fabric Interconnect (Fl A}

@

Cisco UCS C220 M4 Rack Server

Software Versions

The UCSD management server is a C220 M4 server that is managed by the UCS Manager. Refer to the
software information section in the main part of this Cisco UCS Integrated Infrastructure for Big Data
with Hortonworks. See Software Distributions and Versions. In addition, the following software
distributions are necessary.

UCS Director Express for Big Data (1.1)

For more information visit
http://www.cisco.com/c/en/us/support/servers-unified-computing/ucs-director-express-big-data-1-1/mo
del.html

VMware vSphere 5.5

UCS Director express requires the VMware vSphere 5.5 hypervisor. For more information see
http://www.vmware.com

r Cisco UCS Integrated Infrastructure for Big Data with Hortonworks Data Platform


http://www.cisco.com/c/en/us/support/servers-unified-computing/ucs-director-express-big-data-1-1/model.html
http://www.cisco.com/c/en/us/support/servers-unified-computing/ucs-director-express-big-data-1-1/model.html
http://www.vmware.com

Fabric Configuration ||

Fabric Configuration

The UCSD management server is a C220 M4 server that is managed by the UCS Manager. Refer to the
Fabric Configuration section in the main part of this document for more details.

Configuring VLANSs

UCSD Express management server requires two network interfaces. It’s service profile need to be
e Management Network — default (VLAN 1)
* PXE Network

Table 20 UCSD Express Management Server vNIC configurations
VLAN Fabric NIC Port Function Failover
default(VLAN1) A ethO Management, User Fabric Failover to B
connectivity
vlan85 PXE B ethl PXE Fabric Failover to A

PXE VLAN dedicated for PXE booting purpose. Follow these steps in Configuring VLANSs to create a
dedicated VLAN for PXE. The management network shall continue to be on the default VLAN.

Other UCS configurations

Perform all other UCS configurations such as QOS policy, necessary policies and service profile
template by following the documentation above. See the section Creating Pools for Service Profile

Templates onwards in this Cisco UCS Integrated Infrastructure for Big Data with Hortonworks cisco
validated design.

N

Note  Create the service profile template named as ESXi_Host with two vNICs as shown in the above
table. For vNIC ethO0, select default VLAN as the native VLAN, and for vNIC ethl, select PXE
VLAN (vlan85 PXE) as the native VLAN.

Creating Service Profile from the Template

Select the Servers tab in the left pane of the UCS Manager GUI.
1. Go to Service Profile Templates > root.
2. Right-click Service Profile Templates ESXi_Host.

3. Select Create Service Profiles From Template.
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Figure 187 Creating Service Profiles from Template
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4. The Create Service Profile from Template window appears.

Figure 188 Selecting Name and Total number of Service Profiles

+ Create Service Profiles From Template [ %]

Create Service Profiles From Template L2

Cancel |

Association of the Service Profiles will take place automatically.

Installing VMware vSphere ESXi 5.5

The following section provides detailed procedures for installing VMware vSphere ESXi 5.5.

There are multiple methods to install VMware vSphere ESXi 5.5. The installation procedure described
in this deployment guide uses KVM console and virtual media from Cisco UCS Manager.

1. Log in to the Cisco UCS 6296 Fabric Interconnect and launch the Cisco UCS Manager application.
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2. Select the Servers tab.
3. In the navigation pane expand Service Profiles.

4. Right click on the newly created service profile ESXil and select KVM Console.

Figure 189 Selecting KVM Console
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5. In the KVM window, force a reboot by executing the Ctrl-Alt-Del macro.

Cisco UCS Integrated Infrastructure for Big Data with Hortonworks Data Platform



M Installing VMware vSphere ESXi 5.5

Figure 190 Sending Ctri-Alt-Del to Reset the Server
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6. As the server goes through a reboot, monitor the progress via the KVM window. When the LSI
MegaRAID SAS-MFI BIOS screen appears, press Ctrl-R to Enter the Cisco 12G SAS Modular Raid
Controller BIOS Configuration Utility.
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Figure 191 KVM Window displaying the LSI MegaRAID SAS-MFI BIOS screen
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7. In the MegaRAID configuration utility, under VD Mgmt section, use the arrow keys to select the
Cisco 12G SAS Modular RAID (Bus 0xNN, Dev 0xNN) line item.

8. Press the function key F2.
9. Select the option Clear Configuration, and press ENTER.
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Cisco 126G SAS Modular Raid Controller BIOS Configuration Utility 5.06-0004

UD Mgmt

[-1 Cisco 126G SAS Modular Rai (Bus
[-] Drive Group: ©, RAID 5
[-1 Virtual Drive
L— ID: 8, 271.94 GB
I*] orive
[+]1 Available
[-1 Drive Group: 1, RAID ©
[-1 Virtual I

L— Ip: 1, 110.82 GB
[+] Drives
[+] Avali

Dev Ox00§

Clear Configuration

Drive Security
Disable Data Protection

Advanced Software Options

10. To the question Are you sure you want to clear the configuration? click YES and press ENTER key.
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Cisco 126 5A5 Modular Raid Controller BIOS Configuration Utility 5.06-0004

UD Mgmt

[-]1 Cisco 12G SAS Modular Rai (Bus 0x09, Dev 0x00)

[-] Drive Group: ©, RAID 5
£=]

L

[+]1 Selecting this option will delete all virtual

[+1 | drives.
(-1 Dr  Are you sure you want to clear the configuration?
k=1

L
[+]
[+]

11. In the VD Mgmt section, use the arrow keys to select the Cisco 12G SAS Modular RAID (Bus

0xNN, Dev 0xNN) line item.
12. Press the function key F2, select Create Virtual Drive and press ENTER.
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Cisco 126G SAS Modular Raid Controller BIOS Configuration Utility 5.06-0004
UD Mgmt ym :

[-]1 Cisco 12G SAS Modular Rai (Bus 0x09, Dev 0x00
t:ﬁ No Conf iguration Present ! Create Virtual Drive
[-1 Unconf igured Drives
- Ready: 135.97 GB Clear Configuration
Ready: 135.97 GB
Ready: Z278.46 GB
Ready: 110.82 GB

Drive Security
Disable Data Protection

Advanced Software Dptions

13. In the RAID Level: press ENTER and choose RAID-5.

14. In the Drives section, press SPACE on the desired number of drives to select them to be part of the
RAID group. Use the Up and Down arrow keys to navigate.

SAS Modular Raid Controller BIOS Configuration Utility 5.06-0004

Create New UD

EX1—:—:82 135.97 GB
[X]—:—:93 135.97 GB
L =—r——1f4 278 .46 GB

——{——:006 110.82 GB

15. Select the Advanced button, and Check the Initialize checkbox.

16. Press OK to continue with initialization.
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12G SAS Modular Raid Controller BIOS Configuration Utility 5.06-0004

Create New UD
Create Virtual Drive-Advanced

I 64KB “ [X] Initialize

Initialization will destroy data on
the virtual drive.
Are you sure you want to continue?

17. After the initialization is complete, the following message appears. Press OK to continue.

Cisco 12G SAS Modular Raid Controller BIOS Configuration Utility 5.06-0004
UD Mgmt by '

[-]1 Cisco 126G SAS Modular Rai (Bus 0x09, Dev 0x00)

[-]1 Drive Group: O, RAID 5

[-1 Virt I 1 Ve State: Optimal

L ID: 0, 271.94 GB RAID Level: 5
[+] Drive
[+]1 A

Hot s Initialization complete on UD © Drives: 1
[-1 Unconf igur 3
L.—.-.—.:H—.:@B: p.t 0.00 KB

as: @

18. Press Ctrl-N twice to navigate to the Ctrl Mgmt screen.
19. Select Boot device field and press ENTER.
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S Modular Raid Controller BIOS Configuration Utility 5.06-0004
Ctrl Mgmt i L ie:

lgnore - : J|

[ 1 Maintain PD Fail History
Enable controller BIOS
Enable Stop CC on Error
Auto Enhanced Import

Enable JBOD

Set Factory Defaults - CANCEL < Next >

Ctrl-—-N

20. Select the VD 0, and press ENTER again.
21. Press Ctrl+S to save the configuration.

22. Press ESC to exit the MegaRAID configuration utility.

Cisco 126 SAS Modular Raid Controller BIOS Configuration Utility 5.06-0004
JD | [ Ctrl Mgmt

| Enable | UD © 271.94 GB

Are you sure you want to exit?
D Fail History

troller BIOS

p CC on Error

ced Import

D

Set Factory Defaults APE CANCEL < Next >

Ctrl-N

23. In the KVM window, select the Virtual Media menu.

24. Click the Activate Virtual Devices found in the right hand corner of the Virtual Media selection
menu.
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[File View Macros Tools Virtual Media Help

-5 Boot Server

L ShutsEEwr S8 Create Image

Activate Virtual Devices

& Connected to 1P 10,29, 160,89

25. In the KVM window, select the Virtual Media menu and Select Map CD/DVD.
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Figure 192 Mapping the CD/DVD Virtual Media

ESXil {Rack -31) - K¥™ Console{Launched By: admin}

File  Wiew Macros Tools  Virkual Media Help

¥ shutdown Create Image
KNM Console I Fropetties ‘/ Activate Virtual Devices
Map CO/DVD
Map Remowvable Disk
Map Floppy

»x Press Control+Alt+Delete to reboot =

10.29,160.60 || admin || 0.6 fps || 0.001 KB/s || Sy =

26. Browse to the VMware vSphere ESXi 5.5 installer ISO image file.

N

Note The VMware vSphere ESXi 5.5 installable ISO is assumed to be on the client machine.

27. Click Open to add the image to the list of virtual media.
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Figure 193 Browse to VMWare ESXi Hypervisor ISO Image

Lookin: | Images - * s -
! ) kickstart
N . RHEL-Adrin
, Splunk,
| UCSD-1_0
! ucsde-1_1
|| RHELA.4-201301:30,0-5erver-x86_64-D¥Dniso

|| RHELS.5-20131111 . 0-5erver-x86_64-D¥D1.iso
|| thel-server-7.0-x86_64-dvd.isa
b M- staller-201410001-;

Files of bype:  pisk iso file (*.iso) - Cancel

=13
@ File: name: ‘Mware-YMvisor-Installer-201410001-2143827 . 86_64.is0

28. In the KVM window, select the KVM tab to monitor during boot.

29. In the KVM window, select the Macros > Static Macros > Ctrl-Alt-Del button in the upper left
corner.

30. Click OK to reboot the system.
31. On reboot, the machine detects the presence of the VMWare ESXi install media.

Figure 194 ESXi Standard Boot Menu

ESXi-5.5.0-20141004001-standard Boot Menu

ESXi-5.5.0-20141004001-standard Installer

Boot from local disk

Automatic boot in £ seconds. ..
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32. Select the ESXi-5.5.0-yyyymmddnnnn-standard Installer. The installer begins automatically.

Figure 195 Loading the ESXi Installer

Loading ESKi installer

Loading #
Loading /v

Figure 196 VMWare ESXi Installation screen

VAware ESHI 5.5.0 Installer

Helcome to the WHware ESKi 5.5.8 Installation

VHuare ESKi 5.5.0 installs on most systems but only
systems on YHMuore s Compot ibility Guide are swpported.

Consult the VMuare Compatibility Guide at:

http:/ fuwe . vmuare . condresosrces/conpat ibi 1ty

Select the operation to perforn.

33. Press ENTER to continue.
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34. Press F11 to accept End user License Agreement (EULA) and continue.

Figure 197 Accept End User License Agreement (EULA)

[E5CY Do mot Accept (F11) Accept and Continue

35. Select the storage device. Press ENTER to proceed with the installation.

Figure 198 Selecting the Storage Device for installing the ESXi operating system.

UCEC-HRA LD 120G (naa.bfbdabe 7 15b L0allcSbe . . .0 27195 Gilk

(Esc) Canmcel (F1) Details {F5) Refresh (Enter) Continue

36. Select the Keyboard US Default. Press ENTER to continue.
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Figure 199 Choose the Keyboard layout

S Default

(Fsc) Cancel (F91 Back (Enter) Cont inue

37. Choose the root password and confirm it. Press ENTER to continue.

Figure 200 Choose the root password

Passuords natch .

(Esc) Cancel (F3) Back (Enter) Cont inue

38. Press F11 to confirm and begin installation.
39. Once the installation completes, the following message is displayed in the KVM.

40. Remove the VMWare vSphere Hypervisor’s ISO from the Virtual Media menu, by selecting it as
shown.
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Figure 201 ESXi installation complete — Unmount the Virtual Media

o+ UCS40 / ESXil {Rack -31) - K¥M Console{Launched By: admin}
File View Macros Tools  Virtual Media Help
¥ shutdown Create Image
K Console | Properties ‘/ Activate Virtual Devices
/ WMware-VMvisor-Installer-201410001-2143827. x86_64.iso Mapped to CD/DVD
Map Removable Disk

Map Floppy

Installation Conplete
ESXi 5.5.8 has been installed.

ESXi 5.5.8 will operate in evaluation node for 60 days. To
use ESHI 5.5.8 after the evaluation period, you nust
reglster for a YMuare product Ticense. To adninister your
server, use the wSphere Client or the Direct Control User
Interface.

the installation dise before rebooting.

Reboot the server to start using ESKi 5.5.8.

|[10.23.160.60 | [admin |[0.2Fps |[0.001 Kefs

41. Click Yes to proceed with un-mapping of the ISO.
42. Press ENTER to reboot the server.
The VMWare vSphere ESXi installation is complete.

Configuring the Management Network

1. Once the server reboots, press F2 to log on.

2. Enter username as root, and the password chosen above.
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Figure 202 VMWare ESXi initial screen as seen via the KVM Console

VHuare ESXi 5.5.0 (VMKernel Release Build 2143827)

Cisco Systems Inc UCSC-C220-M4S

2 x Intel(R) Xeon(R) CPU E5-2623 v3 @ 3.00GHz
256 GiB Memory

Dounload tools to manage this host from:
http://0.8.0.0/
http://[feBB: :225:b5fF :Feae 971/ (STATIC)

<F2> Customize System/View Logs <F12> Shut Doun/Restart

3. Press F2 to continue
4. Select Configure Management Network, and press ENTER.
5. Select IP Configuration option.
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Conf igure Management Metwork

Network Adapters
VLAN (optional)

IP Cont igurat ion
IPvb Conf igurat ion
DHS Conf iguration
Custom DNS Suff ixes

<Up/Doun> Select
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Enter the IP configuration option of the Management Network

IP Conf iguration

Automat ic

IP Address: 169.254.63.159
Subnet Mask: 255.255.0.0
Default Gateway: Not set

Thi t can obtain an IP add
auvtonatically if your netuor - a DHCP
If not, a your network administrator for the
priate settings.

<{Enter> Change <Esc> Exit

6. Press ENTER to continue.

7. Use the Up/Down arrow keys to highlight the Set Static IP address and network configuration
option, and press SPACE key to select it.

8. Enter the static IP address, Subnet Mask and Default Gateway.
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Figure 204 Enter the IP Address configuration details

IP Conf iguration

can obtain netuwork settings avtomatically if youwr
. If it doe wt,. the 1 q setti

( ) Use dynamic IP address and netuwork configuration
(o) Set static IP address and network configuration:

IP Address [ 18.29.160.251 |
Subnet Mask [ 255.255.255.0 ]
Dofault Gateway [ [CEZNCOM |

<Up/Doun> Select <Space> Mark Selected {Enter> OK <Esc> Cancel

9. Press OK to submit the changes.

10. Press ESC key exit the Management Network Screen.

11. In the Configure Management Network: Confirm dialog box, Press Y to restart the Management

Network.

12. Verify the IP address settings in the System Customization screen.

Figure 205 Verify the IP address details in the System Customization screen

System Custonmization Conf igure Management Network

Configure Passuord Hostname:

Conf igure Lockdoun Mode localhost

“onf igure Management Network IP Address:

Restart Management Network 18.29.160.251

Test Management Metuwork

Network Restore Options IPvE Addresses:
tedd::225:b5ff :feae:9f /64

Conf igure Keyboard

Troubleshoot ing Options To view or modify s managenent network settings i
detail, press <{Ente

View Systen Logs

View Support Information

Reset System Configuration

{Enter> More

{Esc» Log Out
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Installing the VM Ware ESXi client software

1. Using a web browser, visit the url: https://10.29.160.251/
2. Click on Download vSphere Client.

Figure 206 Accessing the ESXi web interface

€ & C | BbHps//10.29.160.251

2% Apps el Cisco UCS Manager

b
]

VMware ESXi

Welcome

Getting Started For Administrators

If you need to access this host remotely, use the following
program to install vSphere Client software, after running the
installer, start the client and log in to this host.

vSphere Remote Command Line

The Remote Cormmand Line allows you to
use command line tools ta manage

Please note that the traditional vSphere Client does not support wSphere from a client machine, These
features added to vSphere in the 5.1 and 5.5 releases, The tools can be used in shell scripts to
traditional vSphere Client is intended for use if you need to automate day-ta-day operatians,
connect directly to an ESXi host, are performing certain vSphere « Download the Virtual Appliance
lUpdate Manager operations, or are running wCentar Plug-ins that * Download the Windows Installer (exe)
support anly the vSphere Client such as vCenter Site Recavery » Download the Linux Installer (tar.gz)
Manager or vCenter Multi-Hypervisor Manager., e EYCeH Datsste beia e
‘fou can take advantage of the fullest range of functionality Use your web browser to find and
introduced or updated in this release by using the vSphere Web download files (for example, virtual
Client. rmachine and virtual disk files).

» Browse datastores in this host's
I s« Download vSphere Client l inventary

To streamline your IT operations with vSphere, use the following

! : : For Developers
program to install vCenter, vCenter will help you consolidate and

optimize workload distribution across ESX hosts, reduce new vSphere Web Services SDK
system deployment time from weeks to seconds, monitar your Learn about our |atest SDKs, Toalkits, and
virtual computing environment around the clock, avoid service APILs for managing YMware ESx, ES®i, and
disruptions due to planned hardware maintenance or unexpected WMware vCenter, Get sample code,
failure, centralize access control, and automate system reference documentation, participats in
adiiimisbratinn tasks: our Forum Discussions, and view our latest
Sessions and Webinars,
« Download WMware vCenter o Learn more about the Web Services SDK

If you need mare help, please refer to our documentation library: ¢ Browse objects managed by this host

« wSphere Docurmentation

Figure 207 Download the VMWare vSphere ESXI client software

Whweare-viclient-all-5.5.0-1993072 exe
hitped fesphereclientmare.comfesphereclient/ 10993047 /2 AMbware-viclient-all-5,5.0-199..,
showrin folder  Rernove from list

3. Proceed to install the downloaded VMWare client software.

Cisco UCS Integrated Infrastructure for Big Data with Hortonworks Data Platform g


https://10.29.160.251/

M Installing VMware vSphere ESXi 5.5

Figure 208 Installing the vSphere Client software

| ii-.‘!rl' ¥Mware vSphere Client 5.5 | ] I

Welcome to the installation wizard for
Wrlware vSphere Client 5.5

The installation wizard will allow wou ko remove Yiware
waphere Client 5.5, To conkinue, dlick Mext,

VMware vSphere-
Client

Mexk = I Cancel |

Configuring the vSphere ESXi hypervisor

1. After the installation is complete, launch the VM Ware vSphere client.
2. Enter the chosen IP address, the username as root, and the chosen password.

3. Click on Login to continue.
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Figure 209 Logging into the ESXi using vSphere Client

¥Mware vsphere Client

vmwa

VMware vSphere

Client

In waphere 5.5, all new vaphere features are available only
through the wSphere Wehb Client, The traditional wSphere Clisnt
will continue ko operate, supporting the same feature set as
wSphere 5.0, buk nok exposing any of the new Features in
waphere 5.5,

The wSphere Client is still used for the vSphere Lpdate
Manager (YIUMY and Host Client, along with a few solutions
(e.q. Site Recovery Manager),

To directly manage a single host, enter the IP address or host name.
To manage mulkiple hosts, enter the IP address or name of a
wiCenker Server,

IF address | Mame: I1D.29.160.251 j
User narne: Iroot

Password: I*******ﬂ

[ Use Windows session credentials

Login I Close Help

4. In the vSphere Client, click on the Configuration tab on the right, and within the Hardware section,
click on Networking.

5. Click on Add Networking link on the upper right hand side.
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Figure 210 vSphere Client Networking screen

10.29.160.251 - vSphere Client

File Edit Wiew Inventory Administration Plug-ins Help

K_,‘d t.,_d |'Eb Home b gf] Inventory [ [Ef Inventory
i)

10.29.160.251

localhost.localdomain ¥Mware ESXi, 5.5.0, 2143827 | Evaluation {60 days remaining)

Configuration e

| v

Hardware Yiew: | vSphere Standard Swikch

Health Status Networking

Processars

Properties. ..

Memary Standard Switch; vSwitchd Remove.., Properties...

Storage Wirtual Machine Port Group Physical Adapters

v Metworking £ WM Metwiork 2 @ vrnicd 10000 Full B3
Storage Adapters Whkemel Port

Metwork Adapters 3 Management Mebwork, g
Advanced Settings wnkd : 10,29,160,251
Power Managemeant fed0::225:bsff feas: 9f

Software

Licensed Features

Time Configuration

DMS and Routing

Authentication Services

Wirkual Machine Skartup)Shutdown
Wirbual Machine Swapfile Location
Security Profile

Haost Cache Configuration

Syskem Resource Allocation
Agent VM Settings L
Advanced Settings LI

Recent Tasks Mame, Target or Statuz containg: - I Clear x

Marne | Target | Status | Details | Tritisted by | Requested Stark Ti... =— | Skart Time | Completed Time |
@ Reset system health se... E 1029160251 @ Completed roak F18/201512:17:46 ... 3[18/2015 12:17:46 ... 3[18/2015 12:17:47 ..,

|@ Tasks |

|EvaluaLi0n Mode: B0 days remaining |r00t o

6. In the Add Networking dialog box, click the Virtual Machine radio button and click Next.
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Figure 211 Adding a new Virtual Machine Network

|J_Jj Add Network Wizard [ [O0]

Connection Type
Metwarking hardware can be partitioned bo accommodate each service that requires connectivity,

Connection Type
hetwork Access —ionnection Types
Caonnection Settings
Summary

" virtual Machine

Add a labeled network to handle virtual machine network traffic,

" yMkernel

The WMkernel TCP{IP skack handles traffic For the Following ESxi services: wSphere wiation, 3C3T, MF3,
and host management.

Help | < Back | Mext = I Canicel

4

7. Click the Create a vSphere standard switch radio button and make sure that the checkbox next to
vmnicl is checked.

8. Click Next.
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Add Network Wizard

Figure 212 Creating a new vSphere Standard Switch

M=l E3

¥irtual Machines - Metwork Access
Virtual machines reach netwaorks through uplink adapters attached ko wSphere standard switches,

Conneckion Type
Metwork Access
Zonneckion Setkings
Surnrmary

Select which w3phere standard switch will handle the netwark traffic For this connection. You may also create a new
wSphere standard switch using the unclaimed network adapters listed belaw,

{* Create a ySphere standard switch Spesd Mebworks
Cisco Systems Inc Cisco ¥IC Ethernet NIC
¥ B vmnict 10000 FUl  Mone
" Use vSwitcho Speed Metwarks
Cisco Systems Inc Cisco ¥IC Ethernet NIC
= E@ vmnico 10000 Full 10,29,160,1-10,29.160,254
Presvigm:
Wirtual Machine Part Group Physical Adapters
WM Metwork 2 g D @ B wmnicl

Help |

< Back, | Mext = I Cancel

A

9. In the Port Group Properties, change the Network Label field to PXE VLANSS.
10. Leave the VLAN ID(Optional) field as None(0).
11. Click Next.
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Figure 213 Creating the Port Group for the PXE VLAN

Add Network Wizard =]

¥irtual Machines - Connection Settings
Use netwark labels ko identify migration compatible connections commeon ko bwo of more hiosts,

Connection Type —Park Group Propetties
Metwork, Access
Connection Settings Metwork Label: IPXE_VL.C\NSS
Summary YLAN ID {Cptional): [rvore o =]
Prewview:
Virtual Machine Port Graup Physical Adapters
PHE_WLAMNES e D o EF v

Help |

Cancel |

A

12. Click Finish to complete adding the Network.
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Figure 214 Verify the Created vSphere Standard Switches

|J--_-T,J Add Metwork Wizard =] E3

Ready to Complete
Werify that all new and modified vSphere standard switches are configured appropriately.

fonnection Type Hast netwarking will include the Fallawing new and modified standard swikches:
Mekwork Access B
Connection Setkings
Summar virtual Machine Port Group Physical Adapters
Y PHE_VLANES e D o B vrnicl

Help | < Back | Finish I Cancel

A

13. Click on the Time Configuration under the Software section.

14. Click on Properties at the upper right hand corner.
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Figure 215 Enabling the NTP Client on the ESXi

0.29.160.251 - vSphere Client

Eile Edit Wiew Imventory Administration Plug-ins Help

! L.j Ej |E} Home [ g8 Inventory b [El Inventory
a &

Q 10.29.160.251 localhost.localdomain ¥Mware ESXi, 5.5.0, 2143827 | Evaluation {60 days remaining)

;“.I:Srée!:ting- =d :.ul"ﬂ'rnar_"-,-:- Virtual Machines - ujm‘u;ia}'-\_llu:u':atiqﬁ' "M Configuration

Hardware Time Configuration Refresh ! Properties... i

Health Status General

Processors Date & Time 12:37 3{18/2015

NTP Client Stopped
MNTP Servers 43

Mermary

Storage
Metworking
Storage Adapters
Metwork Adapters
Advanced Settings
Poweer Management

Software

Licensed Features

+ | Time Configuration
DMS and Routing
Authertication Services
Wirkual Machine Startup/Shutdown
Wirtual Machine Swapfile Location
Security Profile
Host Cache Configuration
System Resource Allocation
Aagent VM Setbings 1
Advanced Settings ﬂ

Recent Tasks Mame, Target or Status containg - | Clzar *

Marne | Target | Status Details | Tritiated by | Requested Start Ti... = | Start Time | Completed Time |
@ Update network config. .. g 10.29.160,251 & Completed rook 3/18/2015 12:31:28 ... 3/18/2015 12:31:28 .., 3/18/2015 12:31:25 ..,

Mote: The date and time walues of the hosk have been translated into the local time of this wSphere Client,

|@ Tasks | |Evaluation Mode: B0 days remaining  |ront %I

15. In the NTP Daemon (ntpd) Options dialog box, click Options.
16. Click on the General options.
17. Click to select the start and stop with host radio button.
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Figure 216 NTP Daemon

|J--_-T,J NTP Daemon {ntpd) Options

General
—skat
MTF Settings At

Stopped

—akartup Policy
£~ Start aukomatically if any ports are open, and stop when all parts are dosed

{* Start and stop with hosk

" Start and stop manually

—Service Commands

Skark Shop | Restark |

Ok I Cancel Help

18. Click on NTP Settings option.
19. Click on Add button to add the NTP server’s IP address.

20. Press OK to continue.

Figure 217 Adding a new NTP Server to the ESXi NTP Settings

|J--_-T,J NTP Daemon {ntpd) Dptions E3

General _ T
NTF Settings NTP Servers — N R e [x]

MNTP Server
(nddress: f10.29.160.100]

Ok, I Cancel | Help |

Add... Edit.. . | Remave |

[ Restart MTP service ta apply changes

o] 4 | Cancel I Help |

21. In the next screen, verify the IP-address in the NTP Servers list.
22. Click on the checkbox Restart NTP service to apply changes.

23. Press the button OK twice to complete the time configurations.
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Figure 218 Restart NTP Service

|J--_-T,J NTP Daemon {ntpd} Options |

General
MNTP Setkings

—MTP Servers

10,29, 160,100

add... | Edit. .. | Remove |

IV Restart MTP service ko apply changes

ol I Cancel | Help |

24. Time configuration option would now show that the NTP client is running, along with the IP address
of the NTP client.
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Figure 219 Verifying the NTP Client

10.29.160.251 - vSphere

File Edit View Inventory Administration Plug-ins Help

! Q E |Q Home b g Inventory Dﬁ Irvventory

& @

[ | 10.29.160.251)

Hardware

Health Status
Processors

Mermory

Storage

Metworking

Storage Adapters
Metwork Adapters
Advanced Settings
Power Managermenk

Software

Licensed Features

v Time Configuration
DS and Routing
Authentication Services
Wirtual Machine StartupfShubdown
Wirtual Machine Swapfile Location
Security Prafile
Host Cache Configuration
Syskem Resource Allacation
Agent ¥M Settings

2143827 | Evaluation {60 days remaining)

Configuration
-
Time Configuration Refresh Properties... = |
General
Date & Time 12141 3f18/2015
MTF Client Running
NTP Servers 10.29.160.100

Moke: The date and time values of the host have been translated into the local time of this »Sphere Client,

Advanced Settings ]
Recent Tasks Marne, Target or Status containg: = I Clear S
Mame | Target | Status | Details | Tritiasted by~ | Requested Start Ti... = | Start Time | Completed Time |
#Y Update date or time B 1022160250 @ cCompleted root 3/16/2015 12:52:48 ..,  3/18/2015 12:52:48 ...  3/16/2015 12:40:07 ..,
|@ Tasks | |Evaluation Made; B0 days remaining |rqot v

Downloading the UCS Director Express Software

Components

The software components of UCS Director Express for Big Data need to be downloaded from three

different locations.
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Downloading the UCS Director Express Software Components

Cisco UCS Director Express Big Data 1.1 Software Components

Software component

File Names

Link to Download

Cisco UCS Director Express 1.0
OVF

1p

https://software.cisco.c
om/download/release.ht
ml?mdfid=286281255
&flowid=71403 &softw
areid=285018084&rele
ase=1&relind=AVAILA
BLE&rellifecycle=&rel
type=Ilatest

Cisco UCS Director 5.2.0.1 patch

cucsd patch 5 2 0 1.zIP

Cisco UCS Director Baremetal
Agent 5.2 OVF

RE GA.zip

https://software.cisco.c
om/download/release.ht
ml?mdfid=286283454
&flowid=72903 &softw
areid=285018084 &rele
ase=5&relind=AVAILA
BLE&rellifecycle=&rel
type=Ilatest

Cisco UCS Director Express for
Big Data 1.1 Upgrade Package

UCSDExpress Big Data 1.1 Up
grade Package.zip

25. Cisco UCS Director Express
for Big Data BMA Update
Package

UCSDExpress BMA Big Data
1.1 _Upgrade Package.zip

https://software.cisco.c
om/download/release.ht
ml?mdfid=286284995
&flowid=73724&softw
areid=285018084&rele
ase=1&relind=AVAILA
BLE&rellifecycle=&rel
type=Ilatest

Download the Software Components

1. Using the links provided Table 15 above, download the Cisco UCS Director Express for Big Data
1.1 OVF Appliance zip file.
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Figure 220 Cisco UCS Director Express for Big Data 1.0 Download Page

&= C | & https:/fsoftware.cisco.com /download/release Html ?mdfid=286281 2558 flowid=7 1403&s0ftwareid=2850180848rel @) 92| S

change] Logln

i) . s
I I Products & Senices Support How to Buy Training & Events Partners
Cisco
Down |0ad Soﬁ:ware ¥ Download Cart (Oitems) [+ Feedback  Help
Downloads Home > Products > Servers - Unified Computing > UGS Director > UGS Director Express for Big Data 1.0 > UCS Director Virtual Appliance Software-1
UCS Director Express for Big Data 1.0
i_ y | [_ B Add Devices
e e e g' Release 1 u
Expand All| Collapse All & Add Notfication
v Latest Cizco UCSD Express Patch as well as BMA Patch for Cisco UCSD Express for Big Data 1.0
File: Information Release Date  « Size
v All Releases
+0 Cisco UCS Director Bare Metal Agent Patch for Cisco UCS Director Express F 19-NOY-2014 1037 MB | Diovvnload |
or Big Data (Patch need to be applied on top Cigco UCS Director BMA 5.0, MD5 -
Checksum - 5b2abic11950f07837e29bdech2dealil) [g | Add to cart |
cuczde_bma_patch_5_0_0_1 zip
Cisco UCSD Express For Big Data Patch (Patch needs to be applied on 1.0, MD  19-MOY-2014 1.76 MB | Diovvnload |
§ Checksum - cad4a9a25057af507 2acafafTfc7d933) 3
cucsde_patch_1_0_0_1.zip | Add to cart |
Cisco UCSD Express Hotfix for Bash Code Injection Yulnerability {Bash ShellS 05-0CT-2014 1.82MB | Diovvriload |
hock - CVE-2014-6271, CVE-2014-7169) Hote: Patch has README that explains h -
ow to apply this patch [g | Add to cart |
cucsd_bash_hotfix zip
Cisco UCS Director Express for Big Data 1.0 (OVF Appliance) MD5 Checksum  05-5EP-2014 2E63.09 MB | Diovvniload |
fdbch7de36107casc1ra3alar6ddd9c ) g
CUCSD _Express_1.0.0.0 GA zip | Add to cart |
Cisco UCS Director Express for Big Data BMA Update Package MD5 Checksu  05-3EP-2014 34385 MB | Diovwvnload |
m - 517faZaif1b8cabbdfflcIadi Talcedb g E—
UCSDExpress_BMA&_50_Biy_Data_Package tuz | Addtocart |
Related Information (=]
Dashbeard Information Sources
Select different information sources for access to relevant troubleshooting information.
Information Sources £

2. Using the links provided Table 15 above; download the Cisco UCS Director 5.2.0.1 Patch zip file,
and Cisco UCS Director Baremetal Agent 5.2 VMware vSphere OVF Appliance zip file.
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Downloads Home » Products > Servers - Unified Computing > UCS Director > UCS Director 5.2 > UCS Director Virtual Appliance Software-5

UCS Director5.2

Expand Al Collapse Al

v Latest

* Al Releases
3

Downloading the UCS Director Express Software Components ||

Figure 221 Cisco UCS Director 5.2 Download Page

B Add Devices
Release 5

g A0 Hobficaton
CUCED 5.210.1 Patch
File Informatian Release Date - Size
Cisco UCS Director 5.2.0.1 Patch (Patch need to be applied on top of 5.2 MD&  03-FEB-2015 1141 51 MB | Diovyrload | *
Checksum - 1eff45cdibbd43adbaal 398247 dbfelc ) [g
cuesd_patch 52,012 | Addtocart |
Cisco UCS Director 5.2.0.08 HOTFIZ Patch {PSIRT FIX FOR HTP - Patch needto  15-JAN-2015 1.45MB | Diovvrload |
be applied on top of 5.2.0.0 MD3 Checksum - 24f9a3c0c2cbaalab83fcdaiicibe —
e7) g | Addtocatt |
cuczd_pateh 5 2 0 04 zip ——
Cigco UCS Director 5.2 (HyperV Appliance) MD5 Checksum - fi4047cb3e5c142  20-DEC-2014 Q344 73 MB | Diowenload |
2fa9fesToalidids (g T
CUCSD_5_2. 0.0 HYPERY_GA zin | Addtocart |
Cigeo UCS Director 5.2 (VMWare vSphere OVF Appliance. MDS Checksum - 06 20-DEC-2014 286915 MB | Dowerload |
bfbbfedsaabefdc69555b535946363 ) (g —————
CUCSD_5_2 0.0 WMAMARE_GA zip | Addtocatt |
Cigco UCS Director Baremetal Agent 5.2 (HyperV Appliance MD5 Checksum - 20-DEC-2014 219532 MB | Dioverloiad |
Ofd§72b4819f 3021 6b676%a247chbee ) [ E—
CUCSD BA 5 2 0 0_HYPERY GA zip | Add to cart |
Cigco UCS Director Baremetal Agent 5.2 (VMWare vSphere OVF Appliance MD 20-DEC-2014 1857 43 MB | Diaverload |
§ Checksum - alc3de4c924720dc9d2f9b099c5bIbse) (g E—
CUUCSD_BMA_5 2 0.0 WMWARE G4 zip [ sagtoean || 7

3. Using the links provided Table 21 above; download the Cisco UCS Director 5.2.0.1 Patch zip file,
and the Cisco UCS Director Baremetal Agent 5.2 VMWare vSphere OVF Appliance zip file.
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Figure 222 Cisco UCS Director Express for Big Data 1.1 Download Page

Downloads Home > Products > Servers - Unified Computing > UCE Director > UCS Director Express for Big Data 1.1 > UCS Director Virtual Appliance Software-1

UCS Director Express for Big Data 1.1

@ B s
& Release 1
Expand All| Collapse All Add Notification
v Latest Cizco UCSD Express 1.1 (Upgrade Package and BMA Patch)
File: Information Release Date Size
v All Releases

»0 Cisco UCS Director Express for Big Data 1.1 BMA Update Package {MD5 Check 10-MAR-2015 35313MB | Dovenloadd |

sum 25e434dadb06365cade902e0esbdd ) (g
UCSDExpress BMA_ 52 Big_Data_1.1_Upgrade_Package zip | Add to cart |

Cisco UCS Director Express for Big Data 1.1 Upgrade_Package (MD5 Checksu 10-MAR-2015 205 MB | Diovwrload |
m 8748164497 a2bA2eedbali098a0ateld) g -
UCEDExpress Rig_Data_1.1_Updgrade_Package zip | Addto cart |

4. Please all the files in a directory in the client windows workstation.

Installing Cisco UCS Director Express for Big Data

The Cisco UCS Director Express for Big Data shall be installed on the VM Ware vSphere hypervisor
using the vSphere Client software.

Deploying the Cisco UCS Director Baremetal Agent OVF

1. Launch the VMWare vSphere client software
Enter the chosen IP address, the username as root, and the chosen password.

Click on Login to continue.

Eal ol

From the File menu, Select Deploy OVF Template.

r Cisco UCS Integrated Infrastructure for Big Data with Hortonworks Data Platform



Installing Cisco UCS Director Express for Big Data ||

Figure 223 Deploy OVF in the vSphere Client

110.29.160.251 - vSphere Client

: File [ Edit Wiew Inwentory Administration Plug-ins Help
Mew ] =
; lentory bR Inventory
| peploy ovF Templats.., |
Export 3
Repork LBl localhost.localdomain ¥Mware ES:
Browse VA Marketplace.., Getting Started
= -
Print Maps 1] ciose tab |X| o=
= What is a Host?
Exit
A host is a computer that uses virtualization software, such Virtual Machines A
as ESX or ESX,, to run virtual machines. Hosts provide the L
CPU and memory resources that virtual machines use and
give virtual machines access to storage and network
connectivity.
You can add a virtual machine to a host by creating a new
one or by deploying a virtual appliance.
The easiest way to add a virtual machine is to deploy a
virtual appliance. A virtual appliance is a pre-built virtual
machine with an operating system and software already
installed. A new virtual machine will need an operating
system installed on it, such as Windows or Linux
Basic Tasks
& Deploy from VA Marketplace e
= = Explore Further
Gt Create a new virtual machine P
=/ Learn about vSphere
Manage muitiple hosts, eliminate downtime, load ﬂ
Recent Tasks Marme, Target or Status containg: = | Clear %
Marne Target Status | Details | Tnitiated by | Requested Stark Ti.,, — | Start Time | Completed Time |
@ Tasks | [Evaluation Mode: B0 days remaining ootz

5. Choose the Cisco UCS Director Baremetal Agent 5.2.0.0 OVF template. Click Open.

6. Click Next to continue.
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Figure 224 Select the Cisco UCS Director Baremetal Agent OVF file

1 |ij Deploy O¥F Template =]
Source
Select the source location,

Source

OYF Template Details
Marme and Locakion
Disk Format

Ready to Complete

Dreplaw From a File or LURL

Erowse. .. I

Enter a URL to download and install the OWF package From the Internet, ar
specify a location accessible From wour computer, such as a local hard drive, a
nebwork share, or a COYDYD drive.

Help I = Back I Mlext = I Cancel

7. Review the details of the OVF template, Click Next.
8. Accept the End User License Agreement. Click Next to continue.

9. In the Name and Location option, Enter the name of the VM. Click Next to continue.
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Figure 225 Enter Cisco UCS Director Baremetal Agent VM Name

- |'E Deploy O¥F Template =] B3

Mame and Location
Specify a name and location For the deployed template

Source Mame:
OWF Template Details |CLICSD-BM-5 z.0.0_36)|

End User License Agresment
Mame and Location

Disk Formak
Netwark Mapping
Ready to Zomplete

The name can contain up ko S0 characters and it must be unigue within the inventory Folder,

Help | = Back | Mext = I Cancel

A

10. In the Disk Format option, click the Thick Provision Lazy Zeroed radio button. Click Next to
continue.
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Figure 226 Select the Disk Format for the VM
(% peploy O¥F Template . M=

Disk Format
In which Format do you want ko store the wirtual disks?

Source
OWE Template Dretails
End User License Agrecement

. Available space (GE): I 263.5
Marne and Locakion

Disk Format
Metwork, Mapping
Ready ko Complete

Datastare: |Hatastoret

{*  Thick Provision Lazy Zeraed
= Thick Provision Eager Zeroed
" Thin Provision

Help | = Back Mext = | Cancel I

A

11. In the Network Mapping option,

e Choose VM Network as the destination network for source Network 1.

e Choose PXE_VLANSS5 as the destination network for source Network 2.
12. Click Next to continue.
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Figure 227 Network Mapping for Deployed Template
i =% Deploy Ean'lpa =]

Metwork Mapping
what networks should the deployved template use?

Source
O%F Template Details Map the networks used in this OMF template to networks in your inventory
End User License Agreement
Mame and Location Source Metworks | Destination Metworks |
Disk Format ) MNebwork 1 Wi Metwork |
Network Mapping Mebwark 2 PHE_WLAMNSS
Ready to Complete
Descripkion:
The Metworl 1 network: ;I
-

Help | = Back | Mext = I Cancel

A

13. Review the details of the VM, click the check box Power on after deployment and click Finish to
proceed with the VM deployment.
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Figure 228 Deploy the Cisco UCS Director Baremetal Agent VM

Deploy O¥F Template =] E3
Ready to Complete
Are these the options you wank to use?

gﬁmmate Diekails When wou click Finish, the deployment task will be started.

End User License Agreement Deployrent settings:

Mame and Location OYF File: CZyYDhImagesiucsde-1_1%WCUCSD_EBMA_S_Z 0 0_WRMW...

Disk Format . Download size: 1.5 GE

pafen - Manoing Size: on disk: 40,0 GB

Ready to Complete
Marme: CILZE0-EM-5.2.0,0_36
HostlCluster: lacalhost,
Dakastore: datastorel
Disk, provisioning: Thick. Provision Lazy Zeroed
Metwork Mapping: "Mebwork 1" to "wr Metwork!”
Metwork Mapping: "Metwork 2" to "PRE_WLAMES"

[+ Pawer an after deployment

Help | = Back | Finish I Cancel

A

Figure 229 Cisco UCS Director Baremetal Agent VM Deployment in Progress

11% Deploying CUCSD-BM-5.2.0.0_36

Deploying CUCSD-BM-5.2.0,0_36

Deploving disk 1 of 1 from t

.k,

(]} <

5 minutes remaining

I Close this dialog when completed L
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Configuring the Cisco UCS Director Baremetal Agent VM (BMA-VM)

The Cisco UCS Director Baremetal Agent VM named as CUCSD-BM-5.2.0.0 36 shall be known as

BMA-VM here onwards.

Right click on the BMA-VM, and select Edit Settings.

In the Virtual Machine Properties dialog box, click on the Options Tab.

Click on the VMWare Tools, Click on the Synchronize guest time with host option in the

Click on OK button to accept the changes.

1.
2.
3.
Advanced section.
4.
Figure 230

[=3) CUCSD-BM-5.2.0.0_36 - ¥irtual Machine Properties

"Hardware Cptions IResources I

Edit VM Settings to Synchronize the Guest Time with the ESXi Host

Wirbual Machine Yersion: 7

— Powser Conkrols

Installing Cisco UCS Director Express for Big Data

Sektings | Sumrmary |
General Opltions CUCSD-EM-5.2.0.0,.. IShut B Euesk LI
Yiware Tools Shut Dronn |
Power Managerment Standbey oo ISuspend LI
Advanced |> Power on [ Resume wirbual machine
General Mormal
CPUID Mask. Expose Mx Flagko ... @ IRestart Guest LI
Memory”PL Hokplug Disabled/Disabled
Eoot Options Maormal Book — Rum YMware Tools Scripks
Fibre Channel MPTY Mone (B iy mawiing &5
CPUMML Yirkualization Autamaktic
Swapfile Locakion Use default setkings ¥ after resuming
I¥ | Before suspending
¥ | BEcfore shiukkbing dowm Guest
— Adwvanced
I~ check and upgrade Tools during power cyeling
¥ Swnchronize guest kime with host
Help | (n] Cancel

5. Right click on the BMA-VM, and select Open Console.
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Figure 231 Access the VM Console of the BMA-VM

= D 10.29.160,251

@ CLICSD-BM-5.2,0.0 36

Groups [ Events:, " Pemissions

Pawer
Glest ¥ close tab [£] =
Snapshat »

|E_§- Open Constle |uses virtualization software, such Virtual Machines A

ual machines. Hosts provide the
es that virtual machines use and
Add Permission... Cu4P s to storage and network

G5 Edit Settings...

Repott Performance. .

hine fo a host by creating a new
al appliance.

Renarme

Openin bew Windaow,,, CerHHAEH ; p—
virtual machine is fo deploy a

appliance is a pre-built virtual
Delet from Disk system and software already
installed. A new virtual machine will need an operating
system installed on if, such as Windows or Linux

Remove fram Invenkary

Basic Tasks

it Deploy from VA Marketplace i

& Create a new virtual machine i

=| Learn about v Sphere
Manage multiple hosts, eliminate downtime, load j

6. In the console accept the End User License Agreement by typing yes and press ENTER.

Figure 232 Accept the EULA

Do you agree with the terms of the End User License fAgreement?

jes/no [nol: yes_

7. Login as root user using the default password pxeboot.

8. Configure the network interfaces by editing the ifcfg-ethO and ifcfg-ethl files located at
/etc/sysconfig/network-scripts/ directory, as follows:

Table 22 BMA-VM network configurations
Network Interface Configuration
eth0 IP Address: 10.29.160.36, Subnet Mask: 255.255.255.0
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ethl

IP Address: 192.168.85.36, Subnet Mask: 255.255.255.0

Figure 233 Editing the BMA-VM NIC eth0

[# CUCSD-BM-5.2.0.0_36 on localhost.localdomain

File Wigw WM

e BGRR PR

DEVICE=ethf@
BOOTPROTO=static
ONBOOT=yes
YPE=Ethernet
IPADDR=18.29.168.36
ETHMASK=255.255.255.0

"setc/sysconf igsnetwork-scriptssifcfg-eth@” 7L, 97C written

T T
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Figure 234 Editing the BMA-VM NIC ethl

[#J CUCSD-BM-5.2.0.0_36 on localhost.localdomain

File ‘Yiew 4¥M
m 0 (ET Eﬁ|§ﬁ i ﬂﬁ‘ﬁf P @
EVICE=ethl
BO0OTPROTO=static
ONBOOT=yes
YPE=Ethernet

IPADDR=19Z.168.85.36
ETHASK=255.255.255.8

"setcssysconf igsnetwork-scriptssifcfg-ethl” 7L, 98C written

9. Restart the network service by using the service command.

service network restart

Figure 235 Restart the network

[root@localhost “1# service network restart
phutting down interface ethB:
Shutting down interface ethl:

Shutting down loopback interface:
Bringing up loopback interface:
Bringing up interface ethd:
Bringing up interface ethl:
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Installing the Cisco UCS Director Express Big Data Upgrade Package

1. Copy over the UCSDExpress_ BMA_5.2 Big Data_1.1_Upgrade_Package.zip that was
downloaded from cisco.com to this VM, by using a secure shell FTP session.

2. Unzip the contents in a temporary staging directory.
3. Change directory into the scripts/bin directory.
4. Change the permissions to add execute permissions to the copyfiles.sh script file and execute it.

chmod +x copyfiles.sh

Figure 236 Install the Cisco UCS Director Express Big Data Upgrade Package

[rootl localhost :
feature-higdata—-intel. jar

run.sh.template

[rootl lozalhost

5. Execute the copyfiles.sh script.
./copyfiles.sh

This script copies the number of software modules such as CentOSLive image into the BMA-VM and
creates a new repository directory by name bd-sw-rep under the /opt/cnsaroot directory. This new
directory acts as the repository of all the Big Data specific 3rd party hadoop distribution directories.

Configuring the Big Data software repositories

Copy the Contents of RHEL6.5 ISO into the BMA-VM

1. Copy over the contents of the RHEL6.5 ISO into the directory /opt/cnsaroot/images/RHELG6.5 on
the BMA-VM.

2. Copy the contents of the directory /opt/cnsaroot/images/RHELG6.5/isolinux into the directory
/opt/cnsaroot/RHELG.5.

Figure 237 Copy the Contents of RHELG6.5 ISO into the BMA-VM

vmlinu=
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Download and Place the Common Utility files in BMA-VM

3. From a host connected to the Internet, download the Parallel-SSH and Cluster-Shell utility tools and
copy them over to the /opt/cnsaroot/bd-sw-rep directory.

» Download Parallel SSH archive from
https://pypi.python.org/packages/source/p/pssh/pssh-2.3.1.tar.gz

e Download Cluster-Shell RPM package from
http://dl.fedoraproject.org/pub/epel/6/x86 _64/clustershell-1.6-1.el6.noarch.rpm

Figure 238 Copy the Cluster-Shell and Passwordless-SSH Utilities

400 Fekb 185
: Feh

rootld 1 lhost bd-sw—rep

4. By following the instructions on this page of the BMA-Install guide, download and copy over the
Hadoop Distro RPMs into their respective directories under /opt/cnsaroot/bd-sw-rep.
http://www.cisco.com/c/en/us/td/docs/unified_computing/ucs/ucs-director-express/bma-install-con
fig/1-1/b_ucsd _express bma install config guide 1-1/b ucsd express bma install config guid
e chapter 0101.html#reference F3FE769E6A114DADSCDS5E3296556B70E

5. Upload the appropriate License files to the Hadoop distribution directories

» Place the Cloudera License in a file called ClouderaEnterpriseLicense.lic and place it under the
/opt/cnsaroot/bd-sw-rep/cloudera05.x.y.

* Place the MapR license in a file called license.txt MapR License and place it under the directory
/opt/cnsaroot/bd-sw-rep/MapR-X.Y.Z.

~

Note  Hortonworks distribution does not require any license file.

Figure 239 Copy the RPM Packages for the Hadoop Distributions

userrpmlisc.tx
[rootld localhost hd-sw-rep]# 1ls Ho

userrpmlist.txt

[rootld localhost hd-su-ren] §
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Setup a UCSD Patch Directory in the BMA-VM

Cisco UCS Director Express for Big Data VM which will be installed in the next section, requires the
patches to be kept in a web server. The BMA-VM comes pre-configured with a web-server used during

PXE booting process. This section walks through the steps to create a directory to hold these patches in
the BMA-VM.

1. In BMA-VM, create a directory by name patches under /var/www/html.

mkdir /var/www/html/patches

2. Copy over the Cisco UCS Director Express for Big Data 1.1 specific patch files (See Table 3) to this
patch directory.

Figure 240 Setup a UCSD Patch Directory in the HTTP Root Path

3. Start the HTTPD server in the BMA-VM.

service httpd start

Figure 241 Start the HTTPD

[tootllocalhost hd-sw-repl # service httpd st

SJtarting httpd:

4. Verify if these files are accessible by visiting the URL http://<BMA-VM’s >IP address/patches/.

Figure 242 Verify the Accessibility of the Cisco UCS Director Express Patches

C— — ]

s ¢ [410.29.160.36/patches/ iy

2% Apps | sl Cisco UCS Manager

Index of /patches

Name Last modified Size Description
3 Parent Directory -
ﬂ TCEDEzpress_Big Data 1.1 Upgrade Package zip 18-Feb-2015 04:52 200
ﬂ cucsd patch 5 2 0 1 #p 03-Fek-2015 1516 1.13

Apachel2.2.5 (CentQE) Server af 10.20.160.56 Fori 80
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BMA-VM configurations are complete.

Deploying the Cisco UCS Director Express OVF

1. Launch the VMWare vSphere client software

2. Enter the chosen IP address, the username as root, and the chosen password.

3. Click Login to continue.

4. From the File menu, Select Deploy OVF Template.

5. Choose the Cisco UCS Director Express for Big Data 1.0 OVF template. Click Open.
Figure 243 Deploy the Cisco UCSD Express 1.0 OVF

1 @ Deploy O¥F Template =]
Source
Select the source location,

Source

OWF Template Details
Mame and Location
Disk Faormat

Feady to Complete

Deploy From a File or LRL

e55 1 0 0 0 GAlcucsd express 10 0 0.cflid Browse. .. I

Enter & URL to download and install the OWF package From the Internet, or
specify a location accessible from wour computer, such as a local hard drive, a
nebwork, share, or a COPDYD drive.

Help | = Back I Mext = I Cancel

A

6. Review the details of the OVF, and Click Next to continue.
7. Accept the EULA, Click Next to continue.
8. Name the VM, Click Next to continue.
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Figure 244 Name the Cisco UCS Director Express VM

Deploy O¥F Template _ O]

Mame and Location
Specify a name and location For the deployed termplate

Source Mare:
OYF Template Details ICLICSDE-I 15|

End User License Agresment
Mame and Location

Disk. Format

Metwork Mapping

Ready to Compleke

The name can contain up ko 80 charackers and ik musk be unigue within the inventory Folder,

Help | = Back | Mext = I Cancel

A

9. Choose the destination network VM Network for the source network Network 1. Click Next to
continue.
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Figure 245 Cisco UCS Director Express VM Network Configuration

Metwork Mapping

what nebworks should the deploved template use?

=] B3

Source
ONF Template Details
End User License Agreement

Map the networks used in this OMF template to networks in wour inventory

Marne and Location

Source Mebwoarks

| Destination Metworks

Disk Format

Mebwork 1

WM Metwork.

Metwork Mapping
Ready to Compleke

Descripkion:

The "Mebwork 1" network.

Help |

= Back | MNext = I

Cancel

A

10. In the Disk Format option, click the Thick Provision Lazy Zeroed radio button. Click Next to

continue.

11. Review the details of the VM, Check the checkbox Power On after deployment.

12. Click Finish to proceed with deployment.
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Figure 246 Deploy the Cisco UCS Director Express VM

il i) Deploy D¥F Template _ O]
Ready to Complete
Are these the options wou want ko use?

Source

OVF Template Details when you click Finish, the deployment task will be started.,

End User License Agreement Deplovment setkings:

w COVF File: VDN ImagesiUCSD-1_0CUCSD_Express_1_0_0_0_GA...

W _ Dovnload size: 2.6 GB

Mebwaork Mapping . .

SRiork ©ennin Size on disk: 100.0 GB

Ready to Complete
Marne: CUCSDE-1 135
Host/Cluster: localhost,
Dakastore: datastorel
Disk provisioning: Thick. Provision Lazy Zeroed
Metwork, Mapping: "Metwork 1" to "W Metwork”

v Power on after deployment

Help | < Back | Finish I Zancel

Configuring the Cisco UCS Director Express VM (UCSD-VM)

The Cisco UCS Director Express VM named as CUCSDE-1_1 35 shall be known as UCSD-VM here
onwards.

1. Right click on the UCSD-VM, and select Edit Settings.
2. In the Virtual Machine Properties dialog box, click on the Options tab.

3. Click on the VMware Tools, Click on the Synchronize guest time with host option in the
Advanced section.

4. Click on OK button to accept the changes.
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Figure 247 Edit VM Settings to Synchronize the Guest Time with the ESXi Host

i (=) CUCSDE-1_1_35 - ¥irtual Machine Properties

Swapfile Location

"Hardware ©ptions | Resources I wirkual Machine Version: 7
1 Settings | Sumrmary — Power Contraols
General Opkions CUZsSDE-1_1_35 IShut B GUEEE ;I
Whhware Tools Shuk Davn
Power Management Standbey oo ISuspend LI
Advanced [> Power on § Resume virtual machine
General Mormal
CPUID Mask, Expose Mx flagto .., & IRestart Guest LI
Book Options Mormal Book
Fibre Channel WPETY Mone —Run YMware Tools Scripts
CPLUMMU Virtualization Aukomatic

¥ | After poweting on
Use default settings

¥ &fter resuming
¥ Before suspending

¥ | Eefore shutting dawn Guest

— Advanced

[T Check and upgrade Toals during power cwcling

[v  sSwnchronize guest time with host

Help | K Cancel

5. Right-click on the UCSD-VM and select Open Console.
6. Accept the End User License Agreement by typing yes and press the ENTER.

7. In the prompt to configure the static [P for the network interface, enter the IP address, Netmask and
Gateway information.

8. Entery to continue with the network configuration.

Figure 248 Assigning the Static IP Address to the UCSD-VM eth0

his =cript iz executed on first boot only.
onfiguring static IP configuration

Do you want to Configure static IP [y-m17 : y
Do you want to configure IPv4-IPuwe [wd-ruel 7 @ ud

onfiguring static IP for appliance. Prowvide the necessary access credentials
IF Addres=s: 18.29.168.35
Hetmask: 255.255.255.8
Gateway: 18.Z29.168.1

onfiguring Network with : IP(18.29.168.35), Netmask(255.255.255.8), Gateway(l8.

Do you want to continue [y nl17?
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9. Configure the UCSD Express as the personality by entering the number 2.

10. At the prompt Switching personality to UCSD Express, Are you sure to continue [y/n]? Type y
and hit ENTER.

Figure 249 Choose the UCSD Express Personality

onf iguring Personality
Select the personality

1) Default - UCSD
21 UC3SD Express
3) Cirrus

[1,-2-317 2
[Switching persomnality to UCSD Express. Are you sure to continue [ysml17? y_

11. The UCSD-VM goes through a personality change configuration as shown below.

Figure 250 UCSD-VM First-Boot Initializations

ompleted db privileges

opying my.cnf .template

ompleted copying my.cnf .template
orcing it to a login prompt

ompleted forcing it to a login prompt
Etarting database

Etarted database

RE Copy Start

RE Copy End

Installing native files

nzip of native files completed
Installing native (rusrr-1lib) files
Installed native (susrrslib) files
Installing native (fusrsinclude) files
Installed native (rusrsinclude) files
Installing native (susr-/bin) files
Installed native (susr-sbin) files
Installing native (retc) files
Installed native (retc) files

Initializing CUIC Database schema

Note  This step takes about 10-15 minutes to complete.

Applying the Upgrade Patches

1. Open a SSH/Putty session to the UCSD-VM.

2. Login as the user shelladmin with password changeme.
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Figure 251 Logging onto the UCSD-VM Shell Administration Tool

login a=s: shelladmin

shelladmin@l0.29.160.35's password: I

3. In the Shell Admin Menu, enter 3 to stop the services.
4. At the prompt, Do you want to stop services [y/n]? Type y to confirm and hit ENTER to continue.

Figure 252 Issuing the Command to Stop all the Services Via Shell Administration Tool.

ndalone MNode

a number from the menu kbelow

1 Deployment)

Do ywou wan

5. In the Shell Admin menu, type 2 to view the status of the services. They all should be
NOT-RUNNING as shown below.
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Figure 253 Verifying the Status of the UCSD-VM Services

T—RULNIT
T— R IT
T—FRUMI IT
T—RIULI IT

T—RUMNIIT
T—FRILI IT
T— R IT
T —R.ITE T

ao: 0 a5

O

. In the Shell Admin menu, type 19 and ENTER to start the patching process.
Type n to the prompt Do you want to take database backup before applying patch[y/n]?.

At the prompt, Patch URL: enter http://<BMA_IP>/patches/cucsd_patch_5 2 0_1.zip
. Hit ENTER to continue.

© ® 9 &

Figure 254 Cisco UCS Director 5.2.0.1 Patch Application Process

a nurber from the menu below

ced Deplovyment)

10 pa hiv/n n
ding with applying
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This 5.2.0.1 patch that is being applied to the UCSD-VM'’s, upgrades all the core application software
to the latest Cisco UCS Director’s code base. After this step completes, the Big Data Upgrade package
for release 1.1 needs to be applied.

10.
11.
12.

13.

In the Shell Admin menu, type 19 and ENTER to start the patching process.
Type n to the prompt Do you want to take database backup before applying patch[y/n]?.

At the prompt, Patch URL:, enter http://<BMA_IP>/patches/
UCSDExpress_Big Data_1.1_Upgrade_Package.zip

Hit ENTER to continue.

Figure 255 Cisco UCS Director Express for Big Data 1.1 Upgrade Package Installation Process

File
File for VNC

bLgent

ced Deployment)
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Figure 256 Cisco UCS Director Express for Big Data 1.1 Upgrade Package Application Complete

[le2d Jan 21

for upg

(FileUtil. ] ) 150121 110:45 [FileUtil] BRu mpleted
Thread[ Thr 5, ,main]

14. After the successful application of the patch, type 4 and ENTER to start the services.

~

Note It takes about a few minutes for all the services to get started.

15. Type 2 to check on the services status. All the services should now be in RUNNING state.
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Figure 257 Verify the Status of the Services in the UCSD-VM

SELECT=

FEUMNMING
REUMNIMING
BEUNL I
REUMNMIMNG
EUMNMING

RUNM ING
RO I
RUMI ING

Note  Even after all the services are in a RUNNING state, it would take an additional 3 to 5 minutes
for the UCSD-VM client services to become available.

Configuring the Cisco UCS Director Express for Big Data (UCSD Express)

The Cisco UCS Director Express for Big Data, henceforth known as UCSD-Express, needs to be
configured with the IP address to the UCS domain (i.e. UCS Manager’s) physical account. This allows
the UCSD-Express to query the UCS Manager and perform inventory collection.

The UCSD-Express will also need to be configured with the BMA’s physical account and configure it’s
services such as DHCP.

Add the licenses to UCSD-Express

1. Using a web browser, visit the URL http://<UCSD-VM’s [P>/.

2. Login as user admin with the default password admin.
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Figure 258 Logging onto the Cisco UCS Director Express for Big Data

UCSD Express for Big Data

Username |admin |

| Lagin

® 2014, Cizco Systems, Inc. Al rights reserved. Cizeo the Cisco logo, and Cisco Systems il I sl I I
are registered trademar ks or trademarks of Clsco Systems, Inc. andfor itz =ffilistes inthe cisco
United States and certain other countries.

3. Navigate to Administration > License screen.
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Figure 259 Accessing the License Administration Page

Iﬁlzlllsl::lc;' UCSD EXPTESS for Big Data admin @ | LogOut | Cisco | About | Help | ObjectSearch
Converged  Physical ¥ Organizations ¥ Policies v Administration ® = Favorites
Big Data Containers License
|[ ucs SP Templotes for Big Date || Hadoop Cluster Profl - EDeploy Templates | Deplo{#] =
Big Data IP Pools emplates for Big Da adoop Cluster Pro T —— eploy Templates || Deplo
& Refresh | Favorite s Add Virtual Accounts
Physical Accounts =
Big Data IP Pools Integration K l
Name I Description Assignment Orde]  Mobile Access I Assigned

User Interface Settings

Open Automation

Support Information

R ——

Click on License Keys tab.
Click on Update License.

In the Update License dialog box, click Browse to select the license file.
Click Upload.
After the license file gets uploaded, Click Submit to apply the license.

® N2 om A
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Figure 260 Applying the Base Cisco UCS Director License.

'::Ills"l:lcl" uUcsD Expl’e.SS for Big Data admin @ | |sgout | Cimco | About | help | Object Search
Solutions w Converged Physical v Organizatians v Faolicies w Favorites

License

License Keys || License Utilhization || Ligense Utilization History ” Resource Usage Data | F

&5 pefresh LB Favorite @) Updats License & Apply Upgrade License & Update Big Data Licenss

License keys I el (651 [

License Select a file for upload:

[ccuiczo1501181941456050.1c |[ Browse... |[ upload |

[ Enter License Text

] Submit Close |

9. The license keys are displayed as shown below.
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Figure 261 Cisco UCS Director Base Licenses got Applied Successfully

et CSD Express for Big Data

cisco

Solutions » Converged Physical + Organizations w Folicies w Administration * Favorites
License
License Keys ” License Utilization || License Utilization History ” Resource Usage Data | F

% Refresh m Fawvorite @ Update License

ﬁ' Apply Upgrade License

@ Update Big Data License

License Keys

5] | (=l |5 [ |

License E

License Value/Status

b [ PAK: <Internal> (#20150118194145605 - 1)

Total 3 items

10. Click on Update Big Data License.

11. In the Update Big Data Subscription dialog box, click Browse to select the Big Data specific

license file.

12. Click Upload.

13. After the license file gets uploaded, Click Submit.
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Figure 262 Applying the Cisco UCS Director Express Big Data Subscription License

],_','ség UCSD Express for Big Data admin @ | logOut | Cisco | About | Help | Object Search
Solutions w Converged Physical w Crganizations w Folicies v Favorites

License
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% Refresh Lﬂl Favorite ﬁ Update License @' Apply Upgrade: License ﬁ Update Big Data License

Licenss Ksys =L = I = ]

Update Big Data Subscription

» (1 PAK; <Internal License Select a file for upload:
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D Enter License Text

| J Submit E l Close L"
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Figure 263 Completion of the License Application.

Ilclllf:élll;l UCSD Expl'ess for Big Data admin # | logOut | Cisco | About Help Object Search
Solutions Converged Physical v Organizations v Folicies w Favaorites

License

License Keys || License Utilization || License Utilization History || Resource Usage Data | |T

@ Refresh | Favorite &% Update License &} Apply Upgrade License ) Update Big Data License

License Keys @ @| @ E| |@ |

License Entry | License Value/Status

¥ EFPAK: <Internal= (£20150118194332219 - 2)

13 Expiration Date March 18, 2015

] License ID PAK: <Internal= (#20150118194332219 - 2)
L4 CUIC-EBDS 1

[ CUIC-EBDS 1

¥ ErPAK: <Internal= (#£20150118194145605 - 1)

] Expiration Date March 19, 2015

] License ID PAK: =<Internal= (#£20150118194145605 - 1)
] CUIC-BASE-KS i

Total 7 items

Add the UCS Manager physical account to the UCSD-Express

1. Inthe UCSD-Express web console, navigate to Administration >Physical Accounts.
2. Click + ADD button

a. Input the UCS Manager Account details as follows.

b. In the Account Name field, enter a name to this UCS Manager account.

c. Inthe Server Address field, enter the IP address of the UCS Manager.

d. In the User ID field, enter admin.

e. In the Password field, enter the password to the UCS Manager’s admin user.

f. In the Transport Type field, choose https.
3. Click Add.
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Figure 264 Adding the UCS Manager as a Physical Account in the UCSD-VM

il UCSD Express for Big D: s o @[ Lg0u | Coeo | Mot | el

Pod |£-.':"E-_1:i55-5 v|*
v e sy |
- — 1 "
Category |Z:'-':=_.r.r.; %
Physical Actounts Account Type |'.1."-'-:' |v|# L I
§ e B

Authentication Type ’ Locally Authenticatzd | v]*

el A ok
| Server Management | All Servers # L AL R e

Account Name  [UCSM4D |#

Server Address |10.28.160.40 E

[ use Credential Policy

User 1D [admin |

Password wekerrr E |

TransportType [ htps [+]¢

Part |443 |#

Description | | v
=

Note  After adding a physical account, the UCSD-Express will query the UCS Manager to perform the
inventory collection. This process of inventory collection happens at scheduled intervals.Optionally, you
may kick start the inventory collection process manually. These optional steps are described in the steps

4 to 8 below.

4. Goto Administration > System.

5. Click on System Tasks tab.

6. Open the folder Cisco UCS Tasks.

7. Click on UCS Inventory Collector Task.

8. Click Run Now button to execute the task.
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Figure 265 Start the UCS Inventory Collection System Task
Run Now
Are you sure you want to run task 'UcsInventoryCollector:UCSM40" now?
Submit Clase

Add the Bare Metal Agent physical account to the UCSD-Express

1. In the UCSD-Express web console, navigate to Administration > Physical Accounts.

2. Click on Bare Metal Agents tab; Click + Add.

3. Enter the BMA physical account information details as follows:

4. In BMA Name field, enter a name to this BMA physical account.

5. In the BMA Management Address field, enter the BMA-VM’s IP address assigned to NIC eth0.

6. In the Login ID field, enter root.

7. In the Password field, enter the password. Default password is pxeboot.

8. Check the checkbox BMA Uses Different Interfaces for Management and PXE Traffic.

9. Inthe BMA PXE Interface Address field, enter PXE IP address i.e. BMA-VM’s IP address assigned
to NIC ethl.

10. Click Submit.
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Figure 266 Adding the Bare Metal Agent Appliance Information

Add Bare Metal Agent Appliance

BMA Name |Emazs E:
BMA Management Address | 10.29.160.36 %

NOTE: This address must be reachable from the Cisco UCS Director appliance !
Login 1D |rnnt |#

Password

[¥] BMA Uses Different Interfaces for Management and PXE Traffic

BMA PXE Interface Address

192.168.85.36 |aee

Description | |

Location | |

UCSD Database Address 10.29.160.35 | |#

Submit I| Cloze

Configure the Bare Metal Agent’s DHCP services

1. Navigate to Administration > Physical Accounts >Bare Metal Agents.
Select the BMA entry.
On the menu items row, click on the downward facing arrow located at the far right.

Select Configure DHCP.

Cal o
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]l
cisco

Figure 267

UCSD Express for Big Data

Configuring the DHCP

admin & Log Out Cisca About Help Object Search
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Delete
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<] [ 2
Total 1 items
5. In the Configure DHCP dialog box, enter the following
6. In the DHCP Subnet ficld, enter the subnet that’s associated with the BMA-VM’s eth1 NIC.
7. In the DHCP Netmask, enter the appropriate subnet mask value for this network.
8. In the DHCP Start IP, enter a starting IP address in the same subnet.
9. In the DHCP End IP, enter a starting IP address in the same subnet.

In the Router IP Address, enter the IP address of the gateway router in the network if available, if
not may be left as blank or input the IP address of the BMA-VM’s eth1 NIC.

11. Click Submit.
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Figure 268 Configuring the DHCP services on the BMA.
Configure DHCP

| DHCP Subnet | 192.168.85.0 |#
DHCP Netmask | 255.255.255.0 | #
DHCP Start IP | 192.168.85.160 |#
DHCP End IP | 192.168.85.254 |#

Router IP Address |192.168.85.36 |

Submit | I Close |

Start the BMA services

Cal o

Navigate to Administration >Physical Accounts >Bare Metal Agents.
Select the BMA entry.

Click Start Services.

In the Start Bare Metal Agent Appliance dialog box, click Start to start the services.
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Figure 269 Starting the BMA Services
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5. Click on Service Status, to check the status of the services.
6. The Bare Metal Agent Service Status message box should display both the Network Services
status and Database connectivity status as UP.
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Figure 270 Verifying the Bare Metal Agent Services Status
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It may take a little while for the service status and on the BMA entry to get updated. The UCSD-Express
and the associated BMA parts are now ready.

Note

7. Double click on the BMA entry to verify the RHEL operating system repository.
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Figure 271 Verifying the RHEL Operating System Software

I::Illsl::lt;l ucsD Express for Big Data admin @ | LogOut | Cisco | About | Help | ObjectSearch
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Win2k12R2x64 03/21/2015 02:05:13 GMT-0700
Win2k12x64 03/21/2015 02:05:13 GMT-0700
Winzk8R2x64 03/21/2015 02:05:13 GMT-0700

Total 7 items

~

Note BMA-VM software periodically scan the /opt/cnsaroot directory to update the available list of operating
system software repositories.

Creating the Hadoop Cluster using UCSD-Express

For creating a Hadoop cluster of a desired distribution, the UCS Manager that’s managing the target
servers must be pre-configured to meet the following requirements. For performing these configurations,
refer to any Cisco UCS Integrated Infrastructure for Big Data Cisco Validated Designs found at
http://www.cisco.com/go/bigdata_design

a. The uplink ports fabric Interconnects must be reachable to that the UCSD-Express appliances
management network (i.e. eth0).

b. The UCS-Manager must be configured with a host firmware policy containing C-series rack
mount server firmware packages.

c¢. UCS Manager must be configured to discover the Rack Servers in its domain, and the respective
ports are configured as server ports.

d. The server pool must be configured with appropriate set of physical servers that are part of the
UCS domain.

e. The QOS System Classes Platinum and Best Effort must be configured and enabled.
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Note  C240/C220 M4 Rack Servers are supported from UCS firmware 2.2(3d) onwards.

Create the IP Address pools

Using a web browser, visit the URL http://<UCSD-VM’s IP>/.

Login as user admin with the default password admin.

Click on the Big Data IP Pools Tab.

1
2
3. Navigate to Solutions > Big Data Containers.
4
5. Click on + Add.

Figure 272 Creating the IP Address Pools

'LIIISICIL;I UcsD EXprESS for Blg Data admin "'4-| logOut | Cisco | About | Help | Obyect Search
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@ Refresh | Favorite
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Total 0 item

6. In the Create an IP Pool dialog box.
7. Enter the name MGMT. Click Next to continue.
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Figure 273 Creating the IP Address pool for MGMT VLAN
Create an IP Pool
IP Pool IP Pool Management
IPv4 Addresses
IP Poal Name  [MGMT |+
Description | |

Assignment Order | Default -

Next | | Close

8. In the IPv4 Blocks table, click on +.
9. In the Add Entry to IPv4 Blocks dialog box, enter the following.

In the Static IP Pool field, enter the Static I[P Address pool range in the format A.B.C.X —
AB.CY.

In the Subnet Mask field, enter the appropriate subnet mask.

In the Default Gateway field, enter the IP address of the Gateway if present.
— In the Primary DNS field, enter the IP address of the DNS server.
10. Click Submit.
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Figure 274 Adding a Block of IP Address to the MGMT IP Address Pool

Create an IP Pool

Add Entry to IPv4 Blocks

Static IP Pool |lD‘29.lSD.lD]. - 10.29.160.200 |*

Static 1P Pool, Example (IPV4): 192.168.0.1 - 192,168.0.50,192.168.0.100,192.168.1.20-192.168.1.70

Subnet Mask

255.255.255.0

E
Subnet Mask, ex (IPV4): 255.255.255.0

Default Gateway [ 10.29.160.1 |

Primary DNS' | 0.0.0.0 |

Secondary DNS |D.D,D.U |

Submit |[ Closs

~

Note  The Default Gateway, Primary and Secondary DNS fields are optional.

11. Click Submit again to create the Big Data IP Pool.
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Figure 275 IP Address Pool Added Successfully

Submit Result

Added successfully

Ok

Repeat this process for two more interfaces, by creating an IP address pool by name HDFS for Hadoop
configurations to be associated with vNIC eth1, and an IP address pool by name DATA to be associated
with vNIC eth2 in the service profiles. Please refer to “Configuring VLAN Section” above in Cisco UCS
Integrated Infrastructure for Big Data CVDs.

The following figure shows the UCSD-Express that is fully provisioned all the necessary Big Data IP
address Pools.
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Figure 276 All the IP Address Pools have been Configured Successfully
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Total 3 items

Creating a Hadoop Cluster

Using a web browser, visit the URL http://<UCSD-VM’s IP>/.

Login as user admin with the default password admin.

Navigate to Solutions >Big Data Containers.

Click on the Hadoop Cluster Deploy Templates Tab.

Click on Create Instant Hadoop Cluster.

In the Instant Hadoop Cluster Creation dialog box, enter the following.
In Big Data Account Name field, enter a preferred name.

In the UCS Manager Policy Name Prefix field, enter a prefix that is less than equal to 5 letters long.

2 ® 2 a0 kW N

In the Hadoop Cluster Name field, enter a preferred name of the cluster — this will be the name
assigned to the Hadoop cluster within the context of selected Hadoop Manager.

10. In the Hadoop Node Count filed, enter the desired number of nodes.

The minimum number of nodes allowed for Cloudera and Hortonworks Hadoop cluster is 4 and for
MapR cluster it is 3.
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Note

Note

There should be sufficient number of servers available in the server pool.

11. In the password fields, enter the preferred passwords and confirm them.

12. Choose the OS Version from the drop-down box. For C220 M4/C240 M4 rack servers, only OS

supported is RHEL 6.5.

At the time of this writing, RHEL®6.5 is the only OS that is supported on C220 M4/C240 M4 rack servers.

13. In the Hadoop Distribution field, select Hortonworks from the drop-down list.

14. In the Hadoop Distribution Version field, select Hortonworks-2.2 from the drop-down list.

Figure 277 Selecting the Hadoop Distribution Version

Cloudera Hadoop Distribution cloudera v |#

Hadoop Distribution Version cloudera-5.2.0 l"_ *

cloudera-5.2.0
cloudera-5.3.0
UCS Manager Account cloudera-5.0.1
cloudera-5.2.1

Hortonworks Hadoop Distribution v|e

Hadoop Distribution Version Hortonworks-2.1 | » |+

Hortonworks-2.1

Hortonworks-2.2

MapR Hadoop Distribution | MapR | v | *

Hadoop Distribution Version MapR-4.0.1 I' »
MapR-4.0.1

MapR-3.1.1

MapR-4.0.2

UCS Manager Account

15.
16.
17.
18.

In the UCS Manager Account, select the appropriate UCS-Manager account.
Select the organization.

vNIC Template Entry

Double-click on row eth0O and select appropriate Mgmt IP-pool, MAC Address Pool and enter the
MGMT VLAN id. Click Submit.
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Figure 278 Editing the vNIC Template to Provide the MGMT Network Configurations
Edit Entry
| vNIC Name ethC - | %
IP Poal [ MGMT(10.29.160.101 - 10.29.160.200) [~ ]+

MAC Address Pool I mac_pooll {1978) |v | #

VLAN 1D [1 |
[4048-4093],[1-3967]

{ MGMT VLAN)

I Submit |[ Close |

19. Double-click on ethl1 and select appropriate IP-pool, MAC Address Pool and enter the DATA1
VLAN ID. Click Submit.
Figure 279 Editing the vNIC Template to Provide the DATA1 Network Configurations
Edit Entry
vNIC Name ethl - | %
IP Pool [ HDFs(192.168.11.101 - 192.168.11.200) |+ |#
MAC Address Pool I mac_pooll (1378) |'|*
VLAN ID [11 E
[4048-4093],[1-3967]
{ DATAL VLAN)
[ Submit | [ Close |
20. Double-click on eth2 and select appropriate IP-pool, MAC Address Pool and enter the DATA VLAN

ID. Click Submit.

Cisco UCS Integrated Infrastructure for Big Data with Hortonworks Data Platform g



W Creating the Hadoop Cluster using UCSD-Express

Figure 280

Editing the vNIC Template to Provide the DATA2 Network Configurations

Edit Entry

vNIC Name

1P Pool

| ==

[ DATA(192,168.12.101 - 192.168.12.200) |~ E

MAC Address Pool | mac_pooll (1978) |v | *

VLAN 1D [12 E

[4048-4093],[1-3967]

{ DATAZ VLAN)

[ Submit [l Close |

>
Note  The following figure show the expanded version of the Instant Hadoop Cluster Creation dialog box with

all the fields filed in.
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Figure 281 Creating an Instant Hortonworks Hadoop Cluster
Instant Hadoop Cluster Creation
-

Big Data Account Name [eczoz | =

Account name can have atmost 10 alphanumeric characters
UC SM Policy Mames Prefisx [ec1io1 | =

UCsM Policy Mame Prefix can have atmost S characters
Hadoop Cluster Name [BE101 | =
Hadoop Node Count [= | =
SSEH (root) Password [FHrerrr== | = —1
Confirm SSH Password |;h"‘ﬂ;***'“'“ |*
Hadoop Manager Password [=*=== | =
Confirm Hadoop Manager Password [ F==++ | =
Host Mode Prefis [nod= -

oS version RHELG.S |~ |=

Choose RHEL 6.5 for M4 Servers

Hadoop Distribution

Hadoop Distribution Wersion =]«

cloudera

UC S Manager Account ucsmag [~ ]=
SR i =

s
Server UUID pool [uuid_poolz ( 20293 [~]|= —]
PRE WLAN ID ES B
[+038-2093],[1 3967]
Server Pool AR =
1D Server Pool Server Pocl§ | Assigned Size
] UCSMan;org-roc M4 _servers 8 13
Total 1 items
Host Firmware Package 5% =
[Account nam Organization Name | o Mode
[ ucsmao root default org-root/fw-host staged
B ucsmao root C_series_Fw org-roct/fw-host staged
1 ucsmMao root ESxi_FW_Packa: org-root/fw-host staged -
-
=] I =
Total 4 item s
wNIC Template = || ][#] == |
WINIC MName IP Pool First mMmac address ViAarn 1D
etho MGMT:10.29.160.1 00:25:'85:00:00:00 X
ethi HDFS:0.0.0.0 00:25:85:00:00:00 1z
eth2 CATA:0.0.0.0 00:25:B85:00:00: 00 12
Total = items
[ submit | [ close
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21. Click Submit.

Monitoring the Hadoop Cluster Creation

1. In the UCSD-Express web console, navigate to Organization ? Service Requests.
2. Browse through the workflows. There are 3 types of workflows executed.

e There would be one Master Workflows i.e. UCS CPA Multi-UCS Manager Hadoop cluster WF, per
the Hadoop cluster creation request. Master workflow kick starts one or more UCS
Manager-specific workflows. Besides that, this master workflow is responsible for Hadoop cluster
provisioning.

» UCS Manager specific workflows i.e. Single UCS Manager Server Configuration WF, would in turn
kick start one or more UCS CPA Node Baremetal workflows.

» UCS CPA Baremetal workflows provision the UCS service profiles and perform OS installation and
custom configuration per node.

Figure 282 List of Workflows Recently Complete

) <|; Ills' ‘l: |<I,| UCSD Express for Big Data admin ® | Log Out | Cisco | About | Help

Baihbonde Bl e Conpeped Bl policies ¥ -Administration ¥ Favorites

Objef

Service Requests for All User Groups

EJ | Service Requests H Archived Service Requests || Service Reguest Statistics || CloudSense || More Reports
b4 al Aﬂ.ﬂieFGronps' @ Refresh m Favorite q} Create Request @ Search and Replace (& View Details @ Cancel Request ﬁ- Resubmit Request [g.] Archive * Add Notes
4} Default Group
Service Requests @ |
Service Request 1 | Request Type ‘ Inibating User | Catalog/Workflow Name |Imbakor a ‘ Request Time ‘Request Stal |
348 Advanced ‘admin -UCS CPA Node BareMetal 03/17/2015 23:38:05 GMT-07) Complete:
=t 347 | Advanced admin UCS CPA Node BareMetal 03/17/2015 23:38:05 GMT-07i Complete
M 346 Advanced admin UCS CPA& Node BareMetal 03/17/2015 23:38:05 GMT-071 Complete
Child Ba etal 345 | Advanced admin UCS CPA Node BarsMetal 03/17/2015 23:38:04 GMT-07! Complete
WOI’kﬂ OWS 3 344 | Advanced admin Single UCSM Server Configuration WF 03/17/2015 23:36:19 GMT-071 Complete
e [343 | Advanced admin UCS CPA Multi-UCSM Hadoop Cluster WF 03/17/2015 23:35:24 GMT-07 Complete
- “ _‘//" 342 | Advanced admin UCS CPA Mode BareMetal 03/17/2015 14:31:27 GMT-071 Complete
Advanced admin UCS CPA Node BareMetal 03/17/2015 14:31:27 GMT-07i Complete
Advanced admin UCS CPA Node BareMetal 03/17/2015 14:31:27 GMT-07 Complete
Advanced admin Single UCSM Server Configuration WF 03/17/2015 14:29:38 GMT-071 Complete
Advanced admin UCS CPA Multi-UCSM Hadoop Cluster WF 03/17/2015 14:28:54 GMT-071 Complete
Advanced admin UCS CPA Node BareMetal 03/17/2015 11:24:20 GMT-07i Complete
Advanced admin UCS CPA Node BareMetal 03/17/2015 11:24:20 GMT-071 Complete
S 335  Advanced admin UCES CPA Mode BareMetal 03/17/2015 11:24:20 GMT-071 Complete
Master workflowes - 334 | Advanced admin UCS CPA Node BareMetal 03{17/2015 11:24:18 GMT-07! Complete
-.‘1‘-\_\‘ 333 | Advanced admin Single UCSM Server Configuration WF 03/17/2015 11:22:37 GMT-07 Complete
“=-[332 | Advanced admin UCS CPA Multi-UCSM Hadoop Cluster WF 03/17/2015 11:21:44 GMT-071 Complete |
Total 348 jtems, showm 27 (paginated) @ 10f13 65 27

3. Double-click on one of the master workflows i.e. UCS CPA Multi-UCS Manager Hadoop Cluster to
view the various steps undertaken to provision a Hadoop cluster.
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Figure 283 Viewing a Completed Master Workflow

workflow Status | Log | Objects Created and Modified | Input/Output | x

Service Request

Status
'@ Refresh
¥ Overvicw Current status for the service request.
iti i imin Ji7f2 23:35:30
Request 1D 343 @ Initiated by admir 03/17/2015 23:35:30
REGUEStTYE P @ Multi-UCSM Hadoop Cluster Profile D3/17/2015 23:35:53
Workflow Name UCS CPA Multi-UCSM Hadoop Cluster WF
Workflow Version Label 0 @ Setup Hadoop Cluster Env 03/17/2015 23:36:13
Reguest Time 03/17/2015 23:35:24 GMT-0700 ; ;
Multi UCSM Configuration WF 03/17/2015 23:36:20
Reguest Status Complete
Comments @ Multi BareMetal WF Monitor 03/18/2015 00:25:04
¥ Cwnership ] '
— ) Synchronized Command Execution 03/18/2015 00:25:27
Initiating User admin
@ Custom SSH Command 03,/18/2015 00:26:02
Provision Hadoop Cluster D3/18/2015 00:41:06
Completed action

Complete 03/18/2015 00:41:09
Completed successfully.

Close

~
Note  If necessary click on the Log tab to view the logs generated during the provisioning of the Hadoop
Cluster.

4. Double-click on one of the child workflows: i.e. UCS CPA Node Baremetal.
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A Completed UCS CPA Node Baremetal workflow.

] Workflow Status

Service Regquest

Status

¥ Overview
Request ID
Request Type
Workflow Nams
Workflow Version Label
Regquest Time
Request Status
Comments

v Ownership

345

Advanced

UCSs CPA Node BareMetal

o

03/17/2015 23:38:04 GMT-0700

Complete

Current status for the service request.

@ Initiated by admin

@ Modify Workflow Priority (High)

@ Assign BareMetal SR ID

@ Create UCS Service Profile from template

@ Service Profile unbind/rebind Action

'@- Refresh

03/17/2015 232:38:05 Z
03/17/2015 23:38:08
03/17/2015 23:38:11
03/17/2015 23:38:17
03/17/2015 23:39:21

03/17/2015 23:40:23

s i Modify UCS Service Profile Boot Policy
Initiating User admin
@ Associate UCS Service Profile 03/17/2015 23:45:59
Assign Serverldentity 03/17/2015 23:46:00
@ Bind/Unbind vNIC Template 03/17/2015 23:46:09
Bind/Unbind vNIC Template 03/17/2015 23:46:13
@ Setup PXE Boot (0SS Type: CentOSLive) 03/17/2015 23:46:38
12 Setup RAID Commands 03/17/2015 23:46:50 7
w Owverview Current status for the service reguest.
Request ID 345 @ UCs Blade Power ON Action 03/17/2015 23:47:34 - |
Refiinatiiybe Advanced Monitor PXE Boot 03/17/2015 23153116
workflow Name UCS CPA Node BareMetal
Waorkflow Wersion Label o @ Monitor RAID Configuration 03/17/2015 23:53:17
Reguest Time 03/17/2015 23:38:04 GMT-0700 -
@ UCS Blade Power OFF Action 02/17/2015 23:53:31
Request Status Complete
Cormments @ Setup PXE Boot (0OS Type: RHELG.5) 03/17/2015 23:53:54
w Ownership i
== % x Setup RAID Commands 03/17/2015 23:53:57
Initiating User admin
UCS Blade Power ON Action 03/17/2015 23:57:17
Monitor PXE Boot 032/18/2015 00:04:19
Modify UCS Service Profile Boot Policy 03/18/2015 00:04:20
Server has Local Disks -
@ Service Profile unbind/rebind Action p3/18/2015 DO:05:23
@ UCs Blade Power ON Action 03/18/2015 00:11:108
T4 As=sign IP Status 03/18/2015 00:11:08 E
o
Reguest Status Complete i
Assign IP Status 03/1B/2015 00:11:08
Comments
¥ Ownership @ Custom SSH Command 02/18/2015 00:16:37
Initiating User admin
Custom SSH Command 03/18/2015 00:17:10
@ Synchronized Command Execution 03/18/2015 00:18:14
UCS Blade Power OFF Action D3/18/2015 0D:18:27
UCS Blade Power ON Action 03/18/2015 00:15:40
Synchronized Command Execution 03/18/2015 0D:24:29
Completed action
Complete 03/16/2015 D0:24:32
Completed successfully. 7

Close
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Host and Cluster Performance Monitoring

1. Inthe UCSD-Express web console, navigate to Solutions > Big Data Accounts for viewing the
Hadoop cluster accounts.
Figure 285 Big Data Accounts Summary Screen

cisco.  UCSD Express for Big Data

admin @ | Log Out Cisco About Help Object Search

Dashboard Converged Physical. w Organizations ¥

Big Data Accounts

Policies v Administration ¥  Favorites

Big Data Accounts |

& Refresh | Favorite o Add

]

Big Data Accounts

19 |2 ) |
Account Name Account Type Data Center Management Console IP | Login
C5AL Cloudera Derived Account Default Pod 10.29.160.124 root
MapR1 MapR Derived Account Default Pod
hw2

10.29.160.128
10.29.160.131

root
Hortonworks Derived Account

Default Pod root

Total 3 items

2. Double-click on one of the accounts to view the cluster-wide performance charts.
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Figure 286

Hadoop Cluster Statistics

'él,'s'élc_!,' UCSD Express for Big Data

admin #® | |og Out

Dashboard Converged Physical ¥  Organizations ¥  Policies ¥  Administration ¥ Favorites

Cisco | About | Help | ObjectSearc

Big Data Accounts > Big Data Accounts (C5A1)

Back

c

¥y || Hosts || Hadoop Clusters || Hadoop Services H Hadoop Service Raoles ” More Reports

% Refresh

Duration for Trending | Last Day n B —O——F

Average CPU 10 Wait (%) (Last Day) [®]|| Aversge CPU Idle (%) (Last Day) [¥l|| Average CPU Mice (%) (Last Day) (v
0.0001 100 100
0.00008 g0 &0
0.00006 60 60
0.00004 40 40
0.00002 20 20
o o o]
2:00 7:00  12:00 17:00 22:00 2:00 T:00 12:00 22:00 2:00 7:00 12:00 17:00 22:00
Date/Time Date/Time Date/Time
l Host - nodel I Host - nodeZ I Host - nodel I Host - node2 l Host - nodel I Host - nodeZ
. Host-rnode? | Host- noded | Host-rnode? | Host- noded | Host-node? | Host-noded
Average CPU System (%) (Last Day) [¥]|| Aversge CPU User (%) (Last Day) [¥]|| cPU Percentage Across Host (Last Day) (vl
0.16 1.2 0.7
B s 1 0.8
0.12
0.8 ol
0.4
0.08 0.6
0.3
0.4
0.04 bz
0.2 0.1
o 0 o
2:00 7:00 12:00 17:00 22:00 2:00 7:00 12:00 17:00 22:00 2:00 J:00 12:00 £7:00 22:00
Date/Time Date/Time Date/Time
. Host - nodel l Host - node2 l Host - nodel l Host - node2 l CS5A1: cpu_percent_across_hosts(percent)
 Host - node3 | Host - noded Host - noded | Host - noded
| Cluster Disk IO (Last Day) [ﬂ| | Cluster Netwark 10 (Last Day) E‘ | HDFS 10 (Last Day) &

Cluster Management

1. In the UCSD-Express web console, navigate to Solutions > Big Data Accounts for viewing the
Hadoop cluster accounts.

2. Double-Click on one of the accounts to drill into the cluster.

3. Click on the Hosts tab.
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Figure 287 Big Data Accounts — Viewing the List of Hosts of a Particular Hadoop Cluster

Ivl:lllsl L Iol. UCSD Express for Big Data admin ® | logOut | Cisco | About | Help

Dashboard Converged Physical w Organizations ¥ Policies w Administration v Favorites

Big Data Accounts > Big Data Accounts (C5A1)

Summary H Hosts H Hadoop Clusters “ Hadoop Services || Hadoop Service Roles H More Reports |

@ Refresh [ Favorite  #) Add Managed Node 8} Add Live Node & Add BareMetal Nodes [ View Details 3§ Delete Node b Assign Rack &} Recommission Node/Decommission Node

Hosts '@‘ @ |E| &l
Host IP |Kerne| Mame | Host Name | Rack Name | Health ‘ Server Identity ‘BaraMetaI WE | Commission State
10.29.160.124 | Linux nodel /Default Good UCSM40;sys/rack-unit-5 334 Commissioned
10.29.160.125 | Linux node2 /Default Good UCSM40;sys/rack-unit-16 335 Commissioned
10.29.160.126 | Linux node3 /Default Good UCSM40;sys/rack-unit-10 336 Commissioned
'10.29.160.127  Linux. noded J/Default Good UCSM40;sys/rack-unit-11 337 Commissioned
4] [

Total 4 items

In this screen, the user can perform various management operations such as,
* Add one/more Baremetal nodes to the cluster.
* Delete a node back to Baremetal
¢ Decommision/Recommission

4. Click on the Services tab, where one could Start/Stop the Hadoop services.
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C15C0

Dashboard W Converged  Physical ¥ Oraaniztions ¥ Polices ¥ Adminisiration ¥ Favorites

Figure 288

il 1S Express fo Big Data

Viewing the Services Provisioned in Specific Hadoop Cluster

Big Data Accounts > Big Data Accounts (C5A1)

Summary H Hoats H Kadoop Clusters H Hadoop Services H Hadoap Service Roles H Mare Reports ‘

@ refresh () Fovorte @ StartAll Services 89 Stop Al Sevices

Hadoop Services @ @ @ ‘EE;J ‘
Status ‘ Health Service Type Service Name

STARTED 00D FLUME flume

STIRTED  GOOD 50007 sq00p

STARTED (00D KS_INDEXER ks _indexer

STARTED 600D HUE hue

STARTED (00D SENTRY Sentry

STARTED GOOD ZOOKEEPER  zookeeper

STARTED 00D 00ZIE o0zie

STARTED 600D [MPALA impala

STARTED (00D HDFS hafs

STARTED 600D S0LR salr

STARTED 00D SPARK spark

STARTED 600D HEASE hbzze

STARTED 00D YARN yam

STARTED 600D HIVE hive

Total 14 items

Host level Monitoring
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Figure 289 Summary Statistics Screen of a Specific Host in a Hadoop Cluster
IICI[ISIéIOII UCSD Express for Big Data admin #® | logOut | Cisco | About | Help | ObjectSearch
E— e e
Big Data Accounts > Big Data Accounts (C5A1) > Hosts (C5A1)
Summary || Host Fault [| Host cPU || Host Disks || Host Disk 1o Stats || Host specific roles || Mare Reports [+
& Refresh 4G} w | Duration for Trending | Last Day ~| B8 —Cc—HA
Average CPU 10 Wait (%) (Last Day) [xl|| Avermas CPU Idle (%) (Last Day) [¥]|| Aversas CPU Nice (%) (Last Day) [¥l|| Avermas CPU System (%) (Last Day) (¥l Z
0.00008 100 100 0.1
0.00006 &e &0 0.12
€0 &0
0.00004 0.08
40 40
0.00002 20 20 0.04
(4] ] ] ]
14:00 19:00 0:00 5:00 10:00 14:00 19:00 0:00 5:00 10:00 14:00 19:00 0:00 5:00 10:00 14:00 19:00 0:00 5:00 10:00
Date/Time Date/Time Date/Time Date/Time
B Host - nodet W Host - node1 B Host - nodet B Host - nodet
Average CPU User (%) (Last Day) [¥]|| Load Average(®) (Last Day) [¥l|| Host CPU Usage (%) (Last Day) [¥l|| Host Memory Usage (%) (Last Day) [l
1.2 -
1.6 - 240000000000
: 160000000000
0.8 1.2
& Date/Time 80000000000
0.6 9 1B B c5a1: cpu_steal_rate(s) o A—
ta00  20:00 00 i =
el a4 I! ! B CsaL:cpu soft ira rate(%) atafTims Bt

Reference

The user may monitor various resource utilization metrics of the particular host by clicking on the other
tabs in this screen.

For details on managing the Hadoop clusters deployed on the Cisco UCS Integrated Infrastructure for
Big Data, see the Cisco UCS Director Express for Big Data Management Guide at:

http://www.cisco.com/c/en/us/td/docs/unified _computing/ucs/ucs-director-express/management-guide/
1-1/b_Management Guide for Cisco UCS Director Express 1 1.html

Bill of Materials

Table 23 provides the BOM for Cisco UCSD Big Data subscription licenses for up to 64 servers and
Table 24 provides the BOM for the various Hadoop platforms.

Table 23 Bill of Material for UCSD for Big Data Subscription Licenses for up to 64 Servers

CUIC-SVR-OFFERS= Cisco UCS Director Server Offerings 1

CON-SAU-SVROFFERS Cisco UCS Director Server Offerings Software 1
Application Sup

CUIC-BASE-K9 Cisco UCS Director Software License 1

CON-SAU-CUICBASE SW APP SUPP + UPGR Cisco UCS Director 1
Base Software

CUIC-TERM Acceptance of Cisco UCS Director License Terms |1
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W Bill of Materials

Table 23 Bill of Material for UCSD for Big Data Subscription Licenses for up to 64 Servers
CUIC-EBDS-LIC= UCSD Express for Big Data - Standard Edition |1
(SE)
CUIC-EBDS-LIC UCSD Express for Big Data - Standard Edition |64
(SE)
CUIC-EBDS-S1-3YR UCSD Express for Big Data - SE 3 year 64
CUIC-TERM Acceptance of Cisco UCS Director License Terms |1
Table 24 Bill of Material for Various Hadoop Platforms
Part Number Description
UCS-BD-CEBN= CLOUDERA ENTERPRISE BASIC EDITION
UCS-BD-CEFN= CLOUDERA ENTERPRISE FLEX EDITION
UCS-BD-CEDN= CLOUDERA ENTERPRISE DATA HUB
EDITION
UCS-BD-HDP-ENT= HORTONWORKS ENTERPRISE EDITION
UCS-BD-HDP-EPL= HORTONWORKS ENTERPRISE PLUS
EDITION
UCS-BD-M5-SL= MapR M5 EDITION
UCS-BD-M7-SL= MapR M7 EDITION
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